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UNDERSTANDING OF COMPUTER AND WORD PROCESSING

Knowing computer: What is Computer, Basic Applications of Computer; Components of Computer System,
Central Processing Unit (CPU). VDU, Keyboard and Mouse, Other input/output Devices, Computer Memory,
Concepts of Hardware and Software; Concept of Computing, Data and Information; Applications of IECT; Connecting
keyboard, mouse, monitor and printer to CPU and checking power supply.

Operating Computer using GUI Based Operating System: What is an Operating System; Basics of Popular
Operating Systems; The User Interface, Using Mouse; Using right Button of the Mouse and Moving Icons on the
screen. Use of Common Icons, Status Bar, Using Menu and Menu-selcction, Running an Application, Viewing of File,
Folders and Directories, Creating and Renaming of files and folders, Opening and closing of different Windows; Using
help; Creating Short cuts. Basics 0fO.S Setup; Common utilities.

Undcrstanding Word Processing: Word Processing Basics; Opening and Closing of documents; Text creation and
Manipulation; Formatting of text; Table handling; Spell check, language setting and thesaurus; Printing of word
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I 1.1 UNDERSTANDING OF COMPUTER I C - Common
O - Operating
1.1.1 Knowing Computer M - Machine
Q1. Define computer. P - Particularly
What (or)r) U - Used For
at is computer ?
A P T -~ Trade
ns : /
S q E - Education
Introduction
R - Research.

The word compute is derived from the
Latin word ‘computare’, was meaning “arithmetic,
accounting”.

The Computer meaning is the digital device
that stores information 'in memory using input
devices and manipulate information to produce
output according to given instructions.

The actual machinery, the physical parts of a
computer system refer to as Computer hardware;
the instruction (a program) that tells the computer
what to do or how to do, that is called Computer

1.1.2 Basic applications of computer System.

Q2. Explain some basic applications of a
computer.

AnS :

Computer is a device through which you can
perform a variety of jobs. You can use your
computer system for different applications by
changing the software packages. Here are the list of
uses or applications of computer:

software (often called just software). 1. Business
Definition A computer has high speed of calculation,

According to Professor Charles diligence, accuracy, reliability, or versatility
Babbage’s analytical engine considered as which has made it an integrated part in all
“fundamental framework of computer” is a business organizations.
mechanical general-purpose programmable Computer is used in business organizations
computing engine. It was a successor to the for:
Difference Engine. _ > Payroll calculations

Computer that we use today is absolutely >  Budgeti
different from the first generation computer. udgeting _
Evolution in technology from 19" century to present >  Sales analysis
day modified computer totally. >  Financial forecasting

COMPUTER  stands for Common »  Managing employee database
Operating Machine Particularly Used For Trade .
Education And Research. »  Maintenance of stocks, etc.

{ 1)
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Banking

Today, banking is almost totally dependent
on computers.

Banks provide the following facilities-

» Online accounting facility, which
includes checking current balance,
making deposits and overdrafts,
checking interest charges, shares, and
trustee records.

»  ATM machines which are completely
automated are making it even easier for
customers to deal with banks.

Insurance

Insurance companies are keeping all records
up-to-date with the help of computers.
Insurance companies, finance houses, and
stock broking firms are widely using
computers for their concerns.

Insurance companies are maintaining a
database of all clients with information
showing:

Procedure to continue with policies
Starting date of the policies

Next due installment of a policy
Maturity date

Interests due

Survival benefits

V V'V V V V V

Bonus
Education

The computer helps in providing a lot of
facilities in the education system.

» The computer provides a tool in the
education system known as CBE
(Computer Based Education).

» CBE involves control, delivery, and
evaluation of learning.

»  Computer education is rapidly increasing
the graph of number of computer
students.

»  There are a number of methods in which
educational institutions can use a
computer to educate the students.

Rahul Publications

» Itis used to prepare a database about
performance of a student and analysis
is carried out on this basis.

Marketing

In marketing, uses of the computer are
following:

»  Advertising: With computers, adverti-
sing professionals create art and graphics,
write and revise copy, and print and
disseminate ads with the goal of selling
more products.

» Home Shopping: Home shopping has
been made possible through the use of
computerized catalogues_ that provide
access to product information and
permit direct entry of orders-to be filled
by the customers.

Healthcare

Computers have become an important part
in hospitals, labs, and dispensaries. They are
being used in hospitals to keep the record of
patients and medicines. It is also used in
scanning and diagnosing different diseases.
ECG, EEG, ultrasounds and CT scans, etc.
are also done by computerized machines.

Following are some major fields of health care
in which computers are used.

» Diagnostic System: Computers are
used to collect data and identify the
cause of illness.

» Lab-diagnostic System: All tests can
be done and the reports are prepared
by computer.

» Patient Monitoring System: These
are used to check the patient’s signs for
abnormality such as in Cardiac Arrest,
ECG, etc.

» Pharma Information System:
Computer is used to check drug labels,
expiry dates, harmful side effects, etc.

» Surgery: Nowadays, computers are
also used in performing surgery.

[ 2}
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10.

Engineering Design
Computers are widely used for Engineering purpose.

One of the major areas is CAD (Computer Aided Design) that provides creation and modification
of images. Some of the fields are:

»  Structural Engineering: Requires stress and strain analysis for design of ships, buildings,
budgets, airplanes, etc.

» Industrial Engineering: Computers deal with design, implementation, and improve-ment
of integrated systems of people, materials, and equipment.

» Architectural Engineering: Compu-ters help in planning towns, designing buildings,
determining a range of buildings on a site using both 2D and 3D drawings.

Military

Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military also employs
computerized control systems. Some military areas where a computer has been used are:

»  Missile Control

»  Military Communication

»  Military Operation and Planning
»  Smart Weapons
Communication

Communication is a way to convey a message, an idea, a picture, or speech that is received and
understood clearly and correctly by the person for whom it is meant. Some main areas in this
category are “

E-mail
Chatting
Usenet
FTP

Telnet

YV V V V V V

Video-conferencing

Government

Computers play an important role in government services. Some major fields in this category are
Budgets

Sales tax department

Income tax department

Computation of male/female ratio

Computerization of voters lists

Computerization of PAN card

V V V V V V VY

Weather forecasting

g
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1.1.3 Components of computer system

Q3. Explain Basic components of a computer.

Ans :

All types of computers follow the same basic logical structure and perform the following five basic
operations for converting raw input data into information useful to their users.

S.No. | Operation Description

1 Take Input The process of entering data and instructions into the computer
system.

2 Store Data Saving data and instructions so that they are available for
processing as and when required.

3 Processing Data Performing arithmetic, and logical operations on data in order
to convert them into useful information.

4 Output Information The process of producing useful information or results.for the
user, such as a printed report or visual display.

5 Control the workflow | Directs the manner and sequence-in which all of the above
operations are performed.

Input Unit

CPU

Memory Unit

Control Unit

Arithmetic
& Logic Unit

This unit contains devices with the help of which we enter data into the computer. This unit creates
a link between the user and the computer. The input devices translate the information into a form
understandable by the computer.

Rahul Publications
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CPU (Central Processing Unit)

CPU is considered as the brain of the
computer. CPU performs all types of data processing
operations. It stores data, intermediate results, and
instructions (program). It controls the operation of
all parts of the computer.

CPU itself has the following three components:
»  ALU (Arithmetic Logic Unit)
»  Memory Unit
»  Control Unit
Output Unit

The output unit consists of devices with the
help of which we get the information from the
computer. This unit is a link between the computer
and the users. Output devices translate the
computer’s output into a form understandable by
the users.

1.1.4 Central processing unit (CPU)

Q4. Draw and explain the architecture of
CPU.

AnS :

Central Processing Unit (CPU) consists of the
following features:

> CPU is considered as the brain of the

computer.

> CPU performs all types of data processing
operations.

> It stores data, intermediate results, and

instructions (program).

> It controls the operation of all parts of the
computer.

Memory Unit

Control Unit

Arithmetic
& Logic Unit

CPU itself has following three components.
1. Memory or Storage Unit
2. Control Unit
3. ALU(Arithmetic Logic Unit)
1. Memory or Storage Unit

This unit can store instructions, data, and
intermediate results. This unit supplies information
to other units of the computer when needed. It is
also known as internal storage unit or the main
memory or the primary storage or Random Access
Memory (RAM).

Its size affects speed, power, and capability.
Primary memory and secondary memory are two
types of memories in the computer.-Functions of
the memory unit are:

> It stores all the data and the instructions
required for processing.

> It stores intermediate results of processing.

> It stores the final results of processing before
these results are released to an output device.

> All inputs and outputs are transmitted through
the main memory.

2. Control Unit

This unit controls the operations of all parts
of the computer but does not carry out any actual
data processing operations.

Functions of this unit are:

> It is responsible for controlling the transfer of
data and instructions among other units of a
computer.

> It manages and coordinates all the units of
the computer.

> It obtains the instructions from the memory,
interprets them, and directs the operation of
the computer.

> It communicates with Input/Output devices
for transfer of data or results from storage.

> It does not process or store data.

3.  ALU (Arithmetic Logic Unit)
This unit consists of two subsections namely,
»  Arithmetic Section
»  Logic Section

g
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Arithmetic Section

Function of arithmetic section is to perform
arithmetic operations like addition, subtraction,
multiplication, and division. All complex operations
are done by making repetitive use of the above
operations.

Logic Section

Function of logic section is to perform logic
operations such as comparing, selecting, matching,
and merging of data.

1.1.5Video display unit (VDU)
Q5. Explain about VDU?

AnS :

A video display unit (VDU) is a computer
peripheral device, like a TV set, that the computer
sends information to. The VDU displays this
information in the form of text or graphics (pictures)
on a cathode ray tube.

A VDU operates like a normal TV set except
the information is sent directly through a cable from
the computer. There are many different kinds of
VDUs and the choice of a VDU is determined by
selecting:

> whether it’s monochrome or colour

> the resolution

> the type of drive signal from the computer
Note

The high voltage inside a colour monitor can
cause X-rays. Sit away from the screen if you're
using the VDU for long periods of time.

Types of VDUs

The main consideration when selecting a VDU
(or monitor) for a computer is whether the display
is monochrome or colour. Monochrome monitors
are cheaper than colour monitors and are suited
mainly to showing text and high-resolution CAD
and desktop publishing applications where a single
colour is adequate. Colour monitors are the most
common these days, and can display colour
drawings, multi-layer CAD drawings and graphics-
based software.

Rahul Publications
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Another consideration is the resolution, which
tells you how many pixels the monitor can display
across and down the screen. The higher the
resolution, the better the definition and the more
expensive the monitor! As well, a monitor must
match the video driver card inside the computer.

There are four common colour formats:
Colour Graphics Adapter (CGA)
Enhanced Graphics Adapter (EGA)
Video Graphics Array (VGA)

> Super VGA (SVGA).

YV V V

1.1.6 Input devices

Q6. List and explain the input devices of a
computer system ?

AnS :

Following are some of the important input
devices which are used in a computer:

i) Keyboard

i) Mouse

iii)  Joy Stick

iv)  Light pen
v)  TrackBall
vi)  Scanner

vii)  Digitizes

viii)  Microphone

ix)  Magnetic Ink Card Reader(MICR)
Xx)  Optical Character Reader(OCR)
xi)  Bar Code Reader

xii)  Optical Mark Reader(OMR)

i) Keyboard

Keyboard is the most common and very
popular input device which helps to input data to
the computer. The layout of the keyboard is like
that of traditional typewriter, although there are
some additional keys provided for performing
additional functions.

Keyboards are of two sizes 84 keys or 101/
102 keys, but now keyboards with 104 keys or 108
keys are also available for Windows and Internet.
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Fig.: Keyboard

The keys on the keyboard are as follows:

S.No Keys & Description

1. Typing KeysThese keys include the letter keys (A-Z) and digit keys (09) which generally
give the same layout as that of typewriters.

2. Numeric Keypadlt is used to enter the numeric data or cursor movement. Generally,
it consists of a set of 17 keys that are laid out in the same configuration used by most
adding machines and calculators.

3. Function KeysThe twelve function keys are present on the keyboard which are arranged
in a row at the top of the keyboard. Each function key has a unique meaning and is
used for some specific purpose.

4. Control keysThese keys provide cursor and screen control. It includes four directional
arrow keys. Control keys also include Home, End, Insert, Delete, Page Up, Page Down,
Control(Ctrl), Alternate(Alt), Escape(Esc).

5. Special Purpose KeysKeyboard also contains some special purpose keys such as
Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, and Print Screen.

ii) Mouse
Mouse is the most popular pointing device. It is a very famous cursor-control device having a small

palm size box with a round ball at its base, which senses the movement of the mouse and sends corresponding
signals to the CPU when the mouse buttons are pressed.

Generally, it has two buttons called the left and the right button and a wheel is present between the
buttons. A mouse can be used to control the position of the cursor on the screen, but it cannot be used to
enter text into the computer.

Fig.: Mouse

f_\7
J Rahul Publications



B.Com.

| YEAR Il SEMESTER

Advantages
> Easy to use
> Not very expensive

> Moves the cursor faster than the arrow keys
of the keyboard.

iili) Joystick

Joystick is also a pointing device, which is used
to move the cursor position on a monitor screen. It
is a stick having a spherical ball at its both lower and
upper ends. The lower spherical ball moves in a

socket. The joystick can be moved in all four
directions.

Fig.: Jyostick

The function of the joystick is similar to that
of a mouse. It is'-mainly used in Computer Aided
Designing (CAD) and playing computer games.

iv) LightPen

Light pen is a pointing device similar to a pen.
It is used to select a displayed menu item or draw
pictures on the monitor screen. It consists of a
photocell and an optical system placed in a small
tube.

\_\\! 7

Fig.: Light Pen

Rahul Publications
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When the tip of a light pen is moved over the
monitor screen and the pen button is pressed, its
photocell sensing element detects the screen location
and sends the corresponding signal to the CPU.

v)  Track Ball

Track ball is an input device that is mostly used
in notebook or laptop computer, instead of a
mouse. This is a ball which is half inserted and by
moving fingers on the ball, the pointer can be
moved.

Fig.: Track Ball

Since the whole device is not moved, a track
ball requires less space than a mouse. A track ball
comes in various shapes like a ball, a button, or a
square.

vi)  Scanner

Scanner is an input device, which works more
like a photocopy machine. It is used when some
information is available on paper and it is to be
transferred to the hard disk of the computer for
further manipulation.

Fig.: Scanner
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Scanner captures images from the source
which are then converted into a digital form that
can be stored on the disk. These images can be
edited before they are printed.

vii) Digitizer

Digitizer is an input device which converts
analog information into digital form. Digitizer can
convert a signal from the television or camera into
a series of numbers that could be stored in a
computer. They can be used by the computer to

create a picture of whatever the camera had been
pointed at.

Fig.: Digitizer
Digitizer is also known as Tablet or Graphics
Tablet as it converts graphics and pictorial data into
binary inputs. A graphic tablet as digitizer is used
for fine works of drawing and image manipulation
applications.

viii) Microphone

Microphone is an input device to input sound
that is then stored in a digital form.

Fig.: Microphone

The microphone is used for various
applications such as adding sound to a multimedia
presentation or for mixing music.

ixX) Magnetic Ink Card Reader (MICR)

MICR input device is generally used in banks
as there are large number of cheques to be
processed every day. The bank’s code number and
cheque number are printed on the cheques with a
special type of ink that contains particles of magnetic
material that are machine readable.

Fig.: Magnetic Ink Card Reader (MICR)

This reading process is called Magnetic Ink
Character Recognition (MICR). The main
advantages of MICR is that it is fast and less error
prone.

X)  Optical Character Reader (OCR)

OCRisan input device used to read a printed
text.

Fig.: Optical Character Reader (OCR)

2 J
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OCR scans the text optically, character by
character, converts them into a machine readable
code, and stores the text on the system memory.

xi) Bar Code Readers

Bar Code Reader is a device used for reading
bar coded data (data in the form of light and dark
lines). Bar coded data is generally used in labelling
goods, numbering the books, etc. It may be a
handheld scanner or may be embedded in a
stationary scanner.

Fig.: Bar Code Readers

Bar Code Reader scans a bar code image,
converts it into an alphanumeric value, which is then
fed to the computer that the bar code reader is
connected to.

xii) Optical Mark Reader (OMR)

OMRis a special type of optical scanner used
to recognize the type of mark made by pen or
pencil. Itis used where one out of a few alternatives
is to be selected and marked.

\ A

OMR-LT40S

Fig.: Optical Mark Reader (OMR)

It is specially used for checking the answer
sheets of examinations having multiple choice
questions.
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1.1.6.1 Keyboard and Mouse

Q7. What is key board ? Explain the various
keys are used in key board.

Ans :

> Keyboard is the most common input device
used for entering text data directly into a
computer.

> A computer keyboard is similar to that of a
typewriter, but it has additional keys as well.

> The most commonly available computer
keyboard has 104 keys. Data is entered into
a computer by pressing a set of keys available
with the keyboard.
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Fig.: Key board

Keyboard is the oldest input device, which is
still being used with the modern computers.
When user presses a key, the corresponding
character appears on screen.

Keyboard Keys
The keys of the keyboard are divided as :

a)  Numeric keys

b)  Character keys/Alphanumeric keys
c)  Punctuation keys

d) Function keys

e)  Special purpose keys

f)  Cursor movement keys
Numeric keys

Numeric keypad is usually located on right
side of the keyboard with its 10 digits (O - 9)
and mathematical operators (+, -, *, /). These
keys are used to input numeric information.

b) Character keys / Alphanumeric keys

These keys are mainly used to enter
characters. These keys include keys for
characters like a-z, A - Z, 0-9, Enter key and
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d)

f)

Shift key. These keys are arranged in the same
way on almost every keyboard and look like
a typewriter keys.

Punctuation keys

To type the special punctuation characters,
punctuation keys, such as the colon (:), the
semicolon (;), the question mark (?), single
quotes (‘) and double quotes (*) are used.

Function keys

These keys are arranged at the topmost row
of the keyboard and each one of them has a
special function associated with it. The
function associated with a function key differs
from software to software. Normally, a
standard keyboard has 12 function keys. (Fl,
F2, F3 FI2)

Special purpose keys

These keys are used to perform special
functions like- deletions or moving a page up
or down. (Del, Page Up, Page Down). Some
others keys in this category are: Home, End,
Insert, Ctrl and Alt etc.

Cursor movement keys

These keys allow us to move around the
screen. Most keyboards have the keys such
as - Arrow.keys to move the cursor up/down
(single row) or Left/ Right (one character
space).

Qs.

What is Multimedia Keyboard ?

AnS :

>

A multimedia keyboard is designed to make
it one-touch simple for the user to access
often-used programs.

Multimedia keyboard contains various
additional keys to perform functions like -
volume control, launching Internet explorer,
changing song and video tracks, launching
e-mail software etc.

A typical multimedia keyboard contains
buttons that control various computer
processes, such as turning on the computer’s
power, putting the CPU to sleep, and waking
it up again.

The web browser keys on a multimedia
keyboard should be familiar to most Internet
users. Back, Forward, Stop, and Refresh
buttons are usually present on such
keyboards.

A specific type of multimedia keyboard called
a Gaming keyboard, meant for use with high-
tech video games, can be even more
expensive.

Multimedia keyboards come in various
connection formats, including PS/2, USB, and
wireless.

o @ cQuGEh = © © o
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Qo9.

What is wireless keyboard ?

AnS :

Wireless keyboards are also available today,
but at a higher price than wired keyboard.

These keyboards do not have any wire
attached to them.

Wireless keyboard interacts with the
computer through Bluetooth or Infrared
technology.

Wireless keyboards transfer typing data to the
computer via infrared beams. A beam of
information is sent from the keyboard, as you
type, to a receiver, which is plugged into the
computer.

Wireless keyboard operates on battery power
rather than using electricity from the user’s
computer.

The main advantage of using a wireless
keyboard rather than a regular keyboard is
that it offers much more mobility. A wireless
keyboard can be used on a lap, in a bed, or
just used while on-the-go for laptop users.

|' 11 |I
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> It can maintain required distance between the
screen and the seating and also do not need
to keep it placed on the working table always
saving a lot of space when not using the
system.

> One of the disadvantages of using a wireless
keyboard is that it has to be installed and
configured before it can be used. Regular
keyboards, on the other hand, run on Plug
and Play software and work immediately after
they are plugged in.

Q10. Explain the various pointing devices ?

AnS :

Interaction with computers was initially
restricted mainly to text mode. However, it was soon
realized that interacting with computers in text-mode
is cumbersome and time-consuming. Hence, a new
type of user interface, called graphical user interface
(GUI), was devised for interacting with computers.
A GUI provides a screen with graphic icons (small
images on the screen) or menus and allows a user
to make rapid selections from them to give
instructions to a computer. For efficient utilization,
GUI requires an input device that can be used to
rapidly point to and select a graphic icon or menu
item from the multiple options displayed on the
screen.

The keyboard, though usable, was found to
be inconvenient and unsuitable for this requirement.
Hence, research efforts to find a suitable input device
to meet this requirement gave birth to several input
devices like mouse, track ball, joystick, light pen,
and touch screen. Later it was realized that many of
these devices, like mouse and light pen, could also
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be used very effectively to create graphic elements
on the screen such as lines, curves, and freehand
shapes. With this new ability, these devices came to
be known as point-and-draw’ devices.’

1. Mouse

» Mouse is another popular input device
used with modern computer.

» ltis basically a pointing device, which is
used to provide input in graphic-user
interface operating systems.

> It is a small palm size box, which appears a
bit like a mouse.

> It has a round ball at its base which senses
the movement of mouse and sends the
corresponding signals to CPU on pressing the
buttons.

> The mouse is represented on the screen in
the form an arrow. This arrow is called a
Cursor. Moving the mouse on your desk will
move the arrow on the screen.

> A mouse allows us to create graphic elements
on the screen, such as lines, curves and free
hand shapes etc.

> It makes using menus and message boxes
easier.

> The mouse contains one to three buttons to
perform different functions.

> The mouse is attached to the computer
system by using a wire.

> Wireless mouse are also available that don't
have any wire attached to them.
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Functions of Mouse

The main goal of any mouse is to translate

the motion of your hand into signals that the
computer can use.

b)

d)

There are five simple techniques to use the
mouse:

a) Click

b) Double Click
c) Drag

d) Right Click
e) Scroll

Click

To click on something with a mouse means
to move the pointer or cursor to the item on
the screen and to press and release the mouse
button once (usually left button).

Double Click

Press and release the mouse button twice in
rapid succession.

Drag

After positioning the mouse pointer over the
item, then press the button and hold it down
as you move the mouse.

Right Click

Right click- means to press the right button of
mouse once without moving it. It helps to
display a shortcut menu.

Scroll

Scrolling is the property of mouse by which
it can scroll the window vertically. A third
button, called the scrolling button, does it.,

Optical Mouse

» An optical mouse is an advanced
computer-pointing device that uses a
light-emitting diode (LED), an optical
sensor, and digital signal processing
(DSP) in place of the traditional mouse
ball.

» It uses light to detect movement rather
than by interpreting the motion of a
rolling sphere.

» Inside each optical mouse, there is a
small camera that takes more than a
thousand snapshot pictures every
second.

»  Optical mouse is more reliable and easy
to use than simple ball mouse.

»  Early optical mouse required a special
mouse pad, but modern devices can be
rolled over traditional pads, as well as
over almost any surface other than glass
or mirror.

»  Optical mice typically don’t require a
mouse pad and can be used on many
surfaces, including those that are not
entirely flat.

» There are typically no_special PC
requirements for optical mice and
installation is usually as simply plugging
the device in to the computer.

» A variety of optical mice can be found
for Windows, Macintosh and Linux
platforms and are available with either
PS/2 or USB plugs.

Wireless Mouse/Cordless Mouse

» A wireless mouse is a computer mouse
that needs no wires to send signals from
the mouse to a computer.

»  The wireless mouse uses radio frequency
(RF) technology to communicate
information to your computer.

» Itcontains a transmitter that sends radio
signals that encodes the information
about the mouse movements and the
buttons you click to the receiver. The
receiver accepts the signal, decodes it and
passes it onto the mouse driver software
and the computer’s operating system.

'| 13 j
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» The major advantage of wireless mouse
is that they can work for large range
wireless communication. They don’t
need a clear line of sight between the
transmitter and the receiver.}

» Wireless mice are well-suited for
presentation settings. With a wireless
mouse, a presenter can operate a
Microsoft PowerPoint presentation from
any point in a room.

»  Wireless mice can also come equipped
with laser pointers, for directing an
audience’s attention.

» Some wireless mice are also equipped
with multiple buttons, such as play and
stop controls, to run video and
programs on a computer.

» Wireless mice are also convenient for
laptop use because of their mobility and
flexibility.

4. Trackball

»  Atrackball is a computer cursor control
device that is mostly used in notebook
or laptop computers.

» lItis a specific style of computer mouse
that allows the user to keep their hand
and arm in one place, while
manipulating a ball that moves the on-
screen pointer.

» It is a pointing device similar to the
mouse except one difference that in
trackball, the ball is fixed in a container
that is placed on the desk. Fingers are
used to rotate the ball and thus the
cursor.

(14 J

Track balls also have buttons like mouse.
It is used to position the cursor at a
specific locations and the input is
supplied by pressing buttons attached
with trackball.

A trackball requires less space than a
mouse because there is no need to move
the whole device i.e. the trackball is
stationary so it does not require much
space to use it.

The trackball mouse does not need a
mouse pad or smooth surface
underneath it to operate efficiently.

A track ball comes in various shapes like
a ball, a button and a square.

Joystick

Joystick is another pointing device that
has been designed to play games on the
computer.

It is used to move cursor position on a
monitor screen.

It consists of a small vertical lever (called
a stick) mounted on the base that is used
to steer the screen cursor around. Lever
moves in all directions and controls the
movement of a pointer.

A joystick contains various buttons for
various functions. The functioning of
these buttons differs in different games.
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»  With a joystick, the pointer continues
moving in the direction the joystick is
pointing. To stop the pointer, you must
return the joystick to its upright position.

»  Joysticks are also used in the industry to
control the operations of computer
driven machines like huge cranes.

6:  Light Pen

» Light Pen is another pointing device,
which is similar to a pen.

» Itis mainly used to draw pictures or lines
on the monitor screen.

» The light pen contains a photocell and
an optical system that is placed in the
pen shaped small tube. Whenever this
cell is brought closer to the screen, it
senses the light coming from the screen
and it generates the electrical pulses.
These pulses are transmitted to a signal
processor that identifies the particular
pixel of the monitor, where the pen is
touching.

» The light pen is used for correction in
architecture design, data collection,
digital signature and computer-aided-
design (CAD) applications.

» In cricket matches, the commentators
mark a portion of screen while
explaining a particular area or the field
set or a particular shot of a batsman in a
cricket match. This is done with light
pen.

1.1.7 Output Devices

Q11. List and explain the output devices of a
computer system ?

AnS :

Following are some of the important output
devices used in a computer.

1. Monitors
2. Printer
1. Monitors

Monitors, commonly called as Visual
Display Unit (VDU), are the main output device
of a computer. It forms images from tiny dots, called
pixels that are arranged in a rectangular form. The
sharpness of the image depends upon the number
of pixels.

There are two kinds of viewing screen used
for monitors.

> Cathode-Ray Tube (CRT)
> Flat-Panel Display
Cathode-Ray Tube (CRT) Monitor

The CRT display is made up of small picture
elements called pixels. The smaller the pixels, the
better the image clarity or resolution. It takes more
than one illuminated pixel to form a whole character,
such as the letter ‘e’ in the word help.

Fig.: Cathode-Ray Tube (CRT) Monitor

A finite number of characters can be displayed
on a screen at once. The screen can be divided into
a series of character boxes - fixed location on the
screen where a standard character can be placed.
Most screens are capable of displaying 80 characters
of data horizontally and 25 lines vertically.

'| 15 ]
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There are some disadvantages of CRT:

» Largein Size

»  High power consumption
Flat-Panel Display Monitor

The flat-panel display refers to a class of video
devices that have reduced volume, weight and
power requirement in comparison to the CRT. You
can hang them on walls or wear them on your wrists.
Current uses of flat-panel displays include
calculators, video games, monitors, laptop
computer, and graphics display.

Fig.: Flat-Panel Display Monitor

The flat-panel display is divided into two

categories:

> Emissive Displays: Emissive displays are
devices that convert electrical energy into
light. For example, plasma panel and LED
(Light-Emitting Diodes).

> Non-Emissive Displays: Non-emissive
displays use optical effects to convert sunlight
or light from some other source into graphics
patterns. For example, LCD (Liquid-Crystal
Device).

2. Printers

Printer is an output device, which is used to
print information on paper.

There are two types of printers:
1. Impact Printers
2. Non-Impact Printers
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1. Impact Printers

Impact printers print the characters by striking
them on the ribbon, which is then pressed on the

paper.

Characteristics of Impact Printers are the
following:

»  Very low consumable costs

»  Very noisy

»  Useful for bulk printing due to low cost
>

There is physical contact with the paper
to produce an image

These printers are of two types:
»  Character printers
»  Line printers

(i) Character Printers

Character printers are the printers which print
one character at a time.

These are further divided into two types:
(a) Dot Matrix Printer(DMP)
(b) Daisy Wheel

(@) Dot Matrix Printer

In the market, one of the most popular
printers is Dot Matrix Printer. These printers are
popular because of their ease of printing and
economical price. Each character printed is in the
form of pattern of dots and head consists of a Matrix
of Pins of size (5*7, 7*9, 9*7 or 9*9) which come
out to form a character which is why it is called Dot
Matrix Printer.

Fig.: Dot Matrix Printer
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Advantages

> Inexpensive

> Widely Used

> Other language characters can be printed
Disadvantages

> Slow Speed

> Poor Quality

(b) Daisy Wheel

Head is lying on a wheel and pins correspon-
ding to characters are like petals of Daisy (flower)
which is why it is called Daisy Wheel Printer. These
printers are generally used for word-processing in
offices that require a few letters to be sent here and
there with very nice quality.

Fig.: Daisy Wheel

Advantages

> More reliable than DMP

> Better quality

> Fonts of character can be easily changed
Disadvantages

> Slower than DMP

> Noisy

> More expensive than DMP

(i) Line Printers

Line printers are the printers which print one
line at a time.

Fig.: Line Printers

These are of two types:
(a) Drum Printer
(b) Chain Printer

(@8 Drum Printer

This printeris like a drum in shape hence it is
called drum printer. The surface of the drum is
divided iinto a number of tracks. Total tracks are
equal to the size of the paper, i.e. for a paper width
of 132 characters, drum will have 132 tracks. A
character set is embossed on the track. Different
character sets available in the market are 48
character set, 64 and 96 characters set. One rotation
of drum prints one line. Drum printers are fast in
speed and can print 300 to 2000 lines per minute.

Advantages

»  Very high speed

Disadvantages

»  Very expensive

> Characters fonts cannot be changed
(b) Chain Printer

In this printer, a chain of character sets is used,
hence it is called Chain Printer. A standard character
set may have 48, 64, or 96 characters.

Advantages
> Character fonts can easily be changed.

> Different languages can be used with the same
printer.

Disadvantages

> Noisy

(17 )
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2. Non-impact Printers

Non-impact printers print the characters
without using the ribbon. These printers print a
complete page at a time, thus they are also called
as Page Printers.

These printers are of two types:
(a) Laser Printers
(b) Inkjet Printers
Characteristics of Non-impact Printers
> Faster than impact printers
> They are not noisy
> High quality
> Supports many fonts and different character
size
(&) Laser Printers
These are non-impact page printers. They use

laser lights to produce the dots needed to form the
characters to be printed on a page.

Fig.: Laser Printers

Advantages

»  Very high speed

> Very high quality output
> Good graphics quality
>

Supports many fonts and different character
size

Disadvantages
> Expensive

> Cannot be used to produce multiple copies
of a document in a single printing.
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(b) Inkjet Printers

Inkjet printers are non-impact character
printers based on a relatively new technology. They
print characters by spraying small drops of ink onto
paper. Inkjet printers produce high quality output
with presentable features.

Fig.: Inkjet Printers

They make less noise because no hammering
is done and these have many styles of printing
modes available. Color printing is also possible.
Some models of Inkjet printers can produce multiple
copies of printing also.

Advantages

> High quality printing

> More reliable

Disadvantages

> Expensive as the cost per page is high

> Slow as compared to laser printer

1.1.8 Computer Memory

Q12. Define Memory and explain the types of
memory.

AnS :

A memory is just like a human brain. Itis used
to store data and instructions. Computer memory
is the storage space in the computer, where data is
to be processed and instructions required for
processing are stored. The memory is divided into
large number of small parts called cells. Each
location or cell has a unique address, which varies
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from zero to memory size minus one. For example,
if the computer has 64k words, then this memory
unit has 64 * 1024 = 65536 memory locations.
The address of these locations varies from O to
65535.

Memory is primarily of three types:
1. Cache Memory
2. Primary Memory/Main Memory
3. Secondary Memory

1. Cache Memory

Cache memory is a very high speed
semiconductor memory which can speed up the
CPU. It acts as a buffer between the CPU and the
main memory. It is used to hold those parts of data
and program which are most frequently used by
the CPU. The parts of data and programs are
transferred from the disk to cache memory by the
operating system, from where the CPU can access
them.

Fig.: Cache Memory

Advantages

The advantages of cache memory are as
follows:

> Cache memory is faster than main memory.

> It consumes less access time as compared to
main memory.

> It stores the program that can be executed
within a short period of time.

> It stores data for temporary use.

Disadvantages

The disadvantages of cache memory are as
follows:

»  Cache memory has limited capacity.
»  ltisvery expensive.
2.  Primary Memory (Main Memory)

Primary memory holds only those data and
instructions on which the computer is currently
working. It has a limited capacity and data is lost
when power is switched off. It is generally made up
of semiconductor device. These memories are not
as fast as registers. The data and instruction required
to be processed resides in the main memory. It is
divided into two subcategories RAM-and ROM.

Characteristics of Main Memory

These are semiconductor memories.

It is known as the main memory.

Usually volatile memory.

Data is lost in case power is switched off.

It is the working memory of the computer.
Faster than secondary memories.

YV V V V V V VY

A computer cannot run without the primary
memory.

3. Secondary Memory

This type of memory is also known as external
memory or non-volatile. It is slower than the main
memory. These are used for storing data/

|' 19 j
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information permanently. CPU directly does not
access these memories, instead they are accessed
via input-output routines. The contents of secondary
memories are first transferred to the main memory,
and then the CPU can access it. For example, disk,
CD-ROM, DVD, etc.

Characteristics of Secondary Memory

> These are magnetic and optical memories.

> It is known as the backup memory.

> It is a non-volatile memory.

> Data is permanently stored even if power is
switched off.

> It is used for storage of data in-a computer.

> Computer may run without the secondary
memory.

> Slower than primary memories.

Q13. What islRAM ? explain the types of RAM.
Ans :

RAM (Random Access Memory) is the internal
memory of the CPU for storing data, program, and
program result. It is a read/write memory which
stores data until the machine is working. As soon as
the machine is switched off, data is erased.
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Access time in RAM is independent of the
address, that is, each storage location inside the
memory is as easy to reach as other locations and
takes the same amount of time. Data in the RAM
can be accessed randomly but it is very expensive.

RAM is volatile, i.e. data stored in it is lost
when we switch off the computer or if there is a
power failure. Hence, a backup Uninterruptible
Power System (UPS) is often used with computers.
RAM is small, both in terms of its physical size and
in the amount of data it can hold.

RAM is of two types:

i)  Static RAM (SRAM)

ii)  Dynamic RAM (DRAM)
i) Static RAM (SRAM)

The word static indicates thatthe memory
retains its contents as long as power is being supplied.
However, data is lost when the power gets down
due to volatile nature. SRAM chips use a matrix of
6-transistors and no capacitors. Transistors do not
require power to prevent leakage, so SRAM need
not be refreshed on a regular basis.

There is extra space in the matrix, hence
SRAM uses more chips than DRAM for the same
amount of storage space, making the manufacturing
costs higher. SRAM is thus used as cache memory
and has very fast access.

Characteristic of Static RAM
Long life

No need to refresh

Faster

Used as cache memory
Large size

Expensive

YV V V V V V VY

High power consumption
Dynamic RAM (DRAM)

DRAM, unlike SRAM, must be continually
refreshed in order to maintain the data. This is
done by placing the memory on a refresh circuit
that rewrites the data several hundred times per
second. DRAM is used for most system memory as
it is cheap and small. All DRAMs are made up of
memory cells, which are composed of one capacitor
and one transistor.

ii)
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Characteristics of Dynamic RAM
Short data lifetime

Needs to be refreshed continuously
Slower as compared to SRAM
Used as RAM

Smaller in size

Less expensive

VvV V V V V VYV V

Less power consumption

Q14. What is ROM ? Explain the types of
ROM.

AnS :

ROM stands for Read Only Memory. The
memory from which we can only read but cannot
write on it. This type of memory is non-volatile. The
information is stored permanently in such memories
during manufacture. A ROM stores such instructions
that are required to start a computer. This operation
is referred to as bootstrap. ROM chips are not only
used in the computer but also in other electronic
items like washing machine and microwave oven.

ii) PROM (Programmable Read Only
Memory)

PROM is read-only memory that can be
modified only once by a user. The user buys a blank
PROM and enters the desired contents using a
PROM program. Inside the PROM chip, there are
small fuses which are burnt open during
programming. It can be programmed only once and
is not erasable.

ili) EPROM (Erasable and Programmable
Read Only Memory)

EPROM can be erased by exposing it to ultra-
violet light for a duration of up to 40 minutes.
Usually, an EPROM eraser achieves this function.
During programming, an electrical charge is trapped
in an insulated gate region. The charge is retained
for more than 10 years because the charge has no
leakage path. For erasing this charge, ultra-violet
light is passed through a quartz crystal window (lid).
This exposure to ultra-violet light dissipates the
charge. During normal use, the quartz lid is sealed
with a sticker.

iv) EEPROM (Electrically Erasable and
Program-mable Read Only Memory)

EEPROM is programmed and erased
electrically. It can be erased and reprogrammed
about ten thousand times. Both erasing and
programming take about 4 to 10 ms (millisecond).
In EEPROM, any location can be selectively erased
and programmed. EEPROMs can be erased one
byte at a time, rather than erasing the entire chip.
Hence, the process of reprogramming is flexible but
slow.

Advantages of ROM

The advantages of ROM are as follows:

> Non-volatile in nature
> Cannot be accidentally changed
Let us now discuss the various types of ROMs | . Cheaper than RAMs
and their characteristics.
) > Easy to test
i) MROM (Masked ROM) _
_ _ _ > More reliable than RAMs
The very first ROMs were hard-wired devices . . _
that contained a pre-programmed set of data or | »  Static and do not require refreshing
instructions. These kind of ROMs are known as > Contents are always known and can be
masked ROMs, which are inexpensive. verified
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1.1.9 Concept of Hardware and software.

Q15. Define software and explain the types of software.

AnS :

Software is a set of programs, which is designed to perform a well-defined function. A program is a
sequence of instructions written to solve a particular problem.

There are two types of software:
i)  System Software
i)  Application Software

i) Software

The system software is a collection of programs designed to operate, control, and extend the
processing capabilities of the computer itself. System software is generally prepared by the computer
manufacturers. These software products comprise of programs written in low-level languages, which interact
with the hardware at a very basic level. System software serves as the interface between the hardware and
the end users.

Some examples of system software are Operating System, Compilers, Interpreter, Assemblers, etc.
/N

Linux
Mucrosgft' d -‘___,/ ) ) ,

Here is a list of some of the most prominent features of a system software:

Close to the system
Fast in speed

Difficult to design
Difficult to understand
Less interactive
Smaller in size

Difficult to manipulate

YV V V V V V V V¥V

Generally written in low-level language
ii)  Application Software

Application software products are designed to satisfy a particular need of a particular environment.
All software applications prepared in the computer lab can come under the category of Application software.

Application software may consist of a single program, such as Microsoft’s notepad for writing and
editing a simple text. It may also consist of a collection of programs, often called a software package, which
work together to accomplish a task, such as a spreadsheet package.

' 22 |
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Examples of Application software are the

following:

>

Payroll Software

Student Record Software

> Inventory Management Software
> Income Tax Software

> Railways Reservation Software

> Microsoft Office Suite Software
> Microsoft Word

> Microsoft Excel

> Microsoft PowerPoint

Features of application software are as follows: ] ]

Relationship between Hardware and
>  Close to the user Software
> Easy to design > Hardware and software are mutually
> More interactive dependent on each other. Both of them must
. rk her to make a computer produce
> Slow in speed work together to make a p p
a useful output.
»  Generally written in high-level language o )
> Software cannot be utilized without
> Easy to understand supporting hardware.
> Easy to markgefie Rnd jse > Hardware without a set of programs to
> Bigger in size and requires large storage space operate upon cannot be utilized and is
Q16. Define hardware and what is the useless.

relationship between hardware and | »  To geta particular job done on the computer,

software. relevant software should be loaded into the
ANS - hardware.

Hardware represents the physical and tangible | > Hardware is a one-time expense.
c;)mponebnts of a C(;mpUtﬁr’d"e' the components > Software development is very expensive and
that can be seen and touched. is a continuing expense.

Examples of Hardware are the following: ) L

> Different software applications can be loaded
> Input devices: keyboard, mouse, etc. on a hardware to run different jobs.
> Output devices: printer, monitor, etc. > A software acts as an interface between the
>  Secondary storage devices: Hard disk, user and the hardware.

CD, DVD, etc. > If the hardware is the ‘heart’ of a computer
> Internal components: CPU, motherboard, system, then the software is its ‘soul’. Both

RAM, etc. are complementary to each other.
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1.1.10 Concept of computing
Q17. Define computing.

AnS :

Computing is defined as the science that
studies the treatment of information by automated
methods and techniques. It was in 1957 when Karl
Steinbuch cited first computing word under the
concept described above.

From the earliest times, humans has invented
and developed techniques to convey information
such as language, writing, sound or light signals and
whistles, drums, telephone, television... can move
from generation to generation all thought and
knowledge acquired throughout history, thanks to
this transfer and processing of information humans
have evolved toward technology currently available.

The main purpose of computing is automated
using electronic equipment all kinds of information,
such as to avoid the repetition of arduous tasks
which may mislead while reducing the execution
time thereof, can you imagine account manually
without the help of any calculator or computer
program all economic transactions of a large
shopping center?.

To automate the information computing is
based on the realization of three basic tasks:

> Admission_Information
> Processing information
> Output Information

The computer system must be provided with
some means by which we bring information, turn
the computer system must be able to interpret and
store this information, so that once we request you
show us by any output medium.

1.1.11 Data and Information

Q18. What is data? How it is differ from
information ?

AnS :

Data can be defined as a representation of
facts, concepts, or instructions in a formalized
manner, which should be suitable for communi-
cation, interpretation, or processing by human or
electronic machine.
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Data is represented with the help of characters
such as alphabets (A-Z, a-z), digits (0-9) or special
characters (+,-,/,*,<,>,= etc.)

Information is organized or classified data,
which has some meaningful values for the receiver.
Information is the processed data on which decisions
and actions are based.

For the decision to be meaningful, the
processed data must qualify for the following
characteristics:

> Timely: Information should be available
when required.

»  Accuracy: Information should be accurate.

> Completeness: Information should be
complete.

Data Processing Cycle

Data processing is the re-structuring or re-
ordering of data by people or machine to increase
their usefulness and add values for a particular
purpose. Data processing consists of the following
basic steps - input, processing, and output. These
three steps constitute the data processing cycle.

Data Processing Cycle

Input Processing Output

> Input: In this step, the input data is prepared
in some convenient form for processing. The
form will depend on the processing machine.
For example, when electronic computers are
used, the input data can be recorded on any
one of the several types of input medium,
such as magnetic disks, tapes, and so on.

> Processing: In this step, the input data is
changed to produce data in a more useful
form. For example, pay-checks can be
calculated from the time cards, or a summary
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of sales for the month can be calculated from
the sales orders.

> Output: At this stage, the result of the
proceeding processing step is collected. The
particular form of the output data depends
on the use of the data. For example, output
data may be pay-checks for employees.

1.1.12 Applications of IECT
Q19. Discuss the major applications of IECT.
Ans :

IECT stands for Information Electronics and
Communication Technology. The applications of
IECT are as follows:

»  E-governance
»  Multimedia and Entertainment
1. E-governance

Electronic governance is application of
Information Electronics and Communication
Technology in running an effective governance
system for people. Communication refers to sharing
of information between parties like .commaon
people, government, business; etc. Almost every
government sector has changed to IECT like rail
reservation system, gas subsidy disbursal, etc.

The primary delivery modals of e-
Government can be divided into:

(@) Government-to-Business/ Consumer

(G20)

G2C model applies the strategy of customer
Relationship Management (CRM) with business
concept. By managing their relationship with citizen,
government can provide the needed products and
services fulfill the needs from customer/citizen.

(b) Government-to-Business

(G2B) is the online non-commercial
interaction between Government and people to
provide business information and also advice about
e-business.

(c) Government-to-Government

(G2G) is the online non-commercial
interaction between Government Departments /
Authorities and other Government / Departments.

(d) Government-to-Employees (G2E)

This is the best and effective way of online
interactions between government and employees.

2. Multimedia and Entertainment

Multimedia refers to combination of text,
audio, video, graphics, animation, etc. It is one of
applications of IECT. Multimedia is used to improve
quality of presentation by incorporating information
sharing, usage of graphics and animation, motion
capture, etc.

1.1.13Connecting keyboard, mouse, Moni-
tor, Printers to CPU. And checking
power supply.

Q20. Explain the procedure to connect
different components to CPU.

AnS :

First, take the. monitor, computer, and all
of the other parts out of their boxes. Make sure
you-set aside-any manuals or documentation
included in the boxes. You may need to refer to
this documentation later. After unpacking the
computer, you should have at, the minimum power
cords, monitor or display device, mouse,
and keyboard.

Position the computer

Set the computer monitor on the desk and
put the computer on or next to the desk. Most often,
the computer sits on the floor or on a shelf next to
the desk or table. However, some computer desks
offer a small cabinet for the computer. Place the
mouse and keyboard that came with the computer
on the desk or table, in front of the monitor.

Connect all cables

Back of computer case and each connection

MIDI / Game port

http//www.computerhope.com
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Monitor

VGA Connector and Port

The monitor data cable will plug into the
computer in only one place. Most monitors will use
either a DVI, VGA, or HDMI connector and
plug into the corresponding port on the back of the
computer. If your monitor only has a VGA plug
and your computer only has a DVI connection, or
visa versa, you need a video converter to connect
your monitor.

After the data cable has been connected to
the computer, connect the power plug from the
monitor to the surge protector.

Keyboard and Mouse

USB cable and port

The keyboard and mouse usually connect to
the computer with the same type of connector,
being either a PS/2 or USB connector. These
connectors are usually found closer to the top of
where all the connectors are located on the back of
the computer.

Connect the USB keyboard to the USB ports
on the back or front of your computer. If you are
usinga USB hub, it can also be connected to the
hub. However, we recommend a direct connection
to the back of the computer if possible.
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If you have a laptop computer, an external
keyboard can also be connected to one of the USB
ports. If no USB ports are available, a USB hub
would be needed.

After the keyboard has been connected, it
should automatically be detected and installed. If
the keyboard has any special features, you need
to install the keyboard software and drivers.

Computer power cord

For the computer, find the power cord and
plug one end into the back of the computer itself
(only one end will fit), usually at the top or the
bottom. Plug the other end of the power cord into
a power outlet or surge protector. We highly
recommend that both the computer and monitor
be powered through a surge protector. If your house
experiences frequent brown outs or black outs,
consider using a UPS to help protect your
computer.

A surge protector can help protect the
computer from getting damaged by power
fluctuations and surges, which can save you money
in the long run by minimizing needed repairs.

Speakers

If you have computer speakers, they can
also be plugged into the back of the computer. The
speakers connect to the line out or sound out
port (usually green) on the back of the computer. If
your speakers are powered speakers, the power
cord should also be plugged into the surge
protector.

Printer Connection

A computer printer does not work until you
install the included drivers and software. If you have
lost the CD for your printer, you can download the
drivers for your printer and use the drivers to install
your printer.
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Connecting the printer to the computer

Connect the prin ter to the computer either using a USB cable, parallel port cable, or SCSI
cable and then connect the power plug to a power outlet. Today, most all home computer printers
are using a USB cable similar to the example picture.
Internet

Finally, if you are using a wired Internet connection, connect, the category 5 Ethernet cable to
the back of the computer. If you are planning on using Wi-Fi to connect to the Internet nothing else
needs to be connected to the computer, but a Wi-Fi router needs to be in range of the computer.

1.2 OPERATING CoMPUTER UsING GUI Basep OPERATING SYSTEM

1.2.1 Operating System
Q21. What is Operating System? What are the functions of OS ?

AnS :

Personal computer has advanced a lot in"a short period of time, and much of the advancement is
due to ongoing progresses in operating systems. Evolution of operating systems had made PCs easier to
use and understand, flexible and reliable. This chapter is the study of primary operating systems currently
used in personal computers and network servers, and their basic features.

Operating System
Operating system is a software that controls system’s hardware and interacts with user and application
software.

In short, an operating system is computer’s chief control program.
Functions of Operating System
The operating system performs the following functions:
It offers a user interface.
Loads program into computer’s memory.
Coordinates how program works with hardware and other software.
Manages how information is stored and retrieved from the disk.
Saves contents of file on to disk.
Reads contents of file from disk to memory.
Sends document to the printer and activates the printer.

Provides resources that copy or move data from one document to another, or from one program
to another.

Allocates RAM among the running programs.
Recognizes keystrokes or mouse clicks and displayes characters or graphics on the screen.

VV YV VYV VYV VY

VYV VY

2
Rahul Publications



B.Com.

| YEAR Il SEMESTER

Q22. Explain the concepts of an operating system.

AnS :

Sr.No.

Operating System Concepts & Description

1.

Types of Operating System
There are four types of operating systems.
Basics of Popular Operating Systems

Windows Operating System is developed by Microsoft Corporation, Linux is a
multitasking operating system that supports various users and numerous tasks. It is
open source, i.e., code for Linux is available for free of cost

User Interface

While working with a computer, we use a set of items on screen called “user interface”.
In simple terms, it acts as an interface between user and software application or program

Running an Application

The operating system offers an interface between programs and user, as well as programs
and other computer resources such as memory, printer and other programs.

Operating System Simple Setting

We will learn different settings in' Operating System such as changing system date and
time, changing display properties, etc.

File and Directory Management

File is nothing but a collection of information. The information can be of numbers,
characters, graphs, images, etc. Directory is a place/area/location where a set of file(s)
will be stored.

File Management System

The file management system is a software which is used to create, delete, modify and
control access and save files.

Types of Files

There are five types of files such as Ordinary files, Directory files, Device files, FIFO files

Q23. What are the basic characteristics and objectives of OS?

AnS :

The Operating System is a program with the following features:

>

>

>

An operating system is a program that acts as an interface between the software and the
computer hardware.

Itis an integrated set of specialized programs used to manage overall resources and operations
of the computer.

It is a specialized software that controls and monitors the execution of all other programs that
reside in the computer, including application programs and other system software.

Rahul Publications
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User

Applications

Il

N

Operating
System

Hardware

Objectives of Operating System
The objectives of the operating system are:

> To make the computer system convenient to
use in an efficient manner.

> To hide the details of the hardware resources
from the users.

> To provide users a convenient interface to use
the computer system.

> To act as an intermediary between the
hardware and its users, making it easier for
the users to access and use other resources.

>  To manage the resources of a computer
system.

> To keep track of who is using which resource,
granting resource requests, and mediating
conflicting requests from different programs
and users.

> To provide efficient and fair sharing of
resources among users and programs.

Characteristics of Operating System

Here is a list of some of the most prominent
characteristic features of Operating Systems:

> Memory Management : Keeps track of the
primary memory, i.e. what part of it is in use
by whom, what part is not in use, etc. and
allocates the memory when a process or
program requests it.

> Processor Management : Allocates the
processor (CPU) to a process and deallocates
the processor when it is no longer required.

> Device Management : Keeps track of all
the devices. This is also called 1/O controller
that decides which process gets the device,
when, and for how much time.

> File Management : Allocates and de-
allocates the resources and decides who gets
the resources.

> Security : Prevents.unauthorized access to
programs and data by means of passwords
and other similar techniques.

> Job Accounting : Keeps track of time and
resources used by various jobs and/or users.

> Control Over System Performance :
Records delays between the request for a
service and from the system.

> Interaction with the Operators :
Interaction may take place via the console of
the computer in the form of instructions. The
Operating System acknowledges the same,
does the corresponding action, and informs
the operation by a display screen.

> Error-detecting Aids: Production of
dumps, traces, error messages, and other
debugging and error-detecting methods.

> Coordination Between Other Software
and Users: Coordination and assignment of
compilers, interpreters, assemblers, and other
software to the various users of the computer
systems.

Q24. Discuss about types of operating system.
Ans :
Types of Operating Systems

An Operating System performs all the basic
tasks like managing file,process, and memory. Thus
operating system acts as manager of all the
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resources, i.e. resource manager. Thus operating
system becomes an interface between user and
machine.

Types of Operating Systems: Some of the
widely used operating systems are as follows-

1. Batch Operating System

This type of operating system does not
interact with the computer directly. There is an
operator which takes similar jobs having same
requirement and group them into batches. It is the
responsibility of operator to sort the jobs with similar
needs.

Advantages of Batch Operating System:

> It is very difficult to guess or know the time
required by any job to complete. Processors
of the batch systems know how long the job
would be when it is in queue

> Multiple users can share the batch systems
> The idle time for batch system is very less

> It is easy to manage large work repeatedly in
batch systems

Disadvantages of Batch Operating System:

> The computer.operators should be well
known with batch systems

> Batch systems are hard to debug
> It is sometime costly

> The other jobs will have to wait for an
unknown time if any job fails

Examples of Batch based Operating
System:

Payroll System, Bank Statements etc.
2.  Time-Sharing Operating Systems

Each task is given some time to execute, so
that all the tasks work smoothly. Each user gets time
of CPU as they use single system. These systems are
also known as Multitasking Systems. The task can
be from single user or from different users also. The
time that each task gets to execute is called quantum.
After this time interval is over OS switches over to
next task.
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Advantages of Time-Sharing OS:

> Each task gets an equal opportunity

> Less chances of duplication of software
> CPU idle time can be reduced
Disadvantages of Time-Sharing OS:

> Reliability problem

> One must have to take care of security and
integrity of user programs and data

> Data communication problem

Examples of Time-Sharing OSs are
Multics, Unix etc.

3. Distributed Operating System

These types of operating system is a recent
advancement in the world of computer technology
and are being widely accepted all-over the world
and, that too, with a great pace. Various autono-
mous interconnected computers communicate each
other using a shared communication network.
Independent systems possess their own memory
unit and CPU. These are referred as loosely
coupled systems or distributed systems. These
system’s processors differ in size and function. The
major benefit of working with these types of
operating system is that it is always possible that one
user can access the files or software which are not
actually present on his system but on some other
system connected within this network i.e., remote
access is enabled within the devices connected in
that network.

Advantages of Distributed Operating System:

> Failure of one will not affect the other network
communication, as all systems are
independent from each other

> Electronic mail increases the data exchange
speed

> Since resources are being shared, compu-
tation is highly fast and durable

> Load on host computer reduces

These systems are easily scalable as many
systems can be easily added to the network

> Delay in data processing reduces
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Disadvantages of Distributed Operating
System

> Failure of the main network will stop the
entire communication

> To establish distributed systems the language
which are used are not well defined yet

> These types of systems are not readily
available as they are very expensive. Not only
that the underlying software is highly complex
and not understood well yet

Examples of Distributed Operating
System are: LOCUS etc.

4. Network Operating System

These systems run on a server and provide
the capability to manage data, users, groups,
security, applications, and other networking
functions. These type of operating systems allow
shared access of files, printers, security, applications,
and other networking functions over a small private
network. One more important aspect of Network
Operating Systems is that all the users are well aware
of the underlying configuration, of all other users
within the network, their individual connections etc.
and that’s why these computers are popularly
known as tightly coupled systems.

Advantages of Network Operating System
> Highly stable centralized servers

> Security concerns are handled through
servers

> New technologies and hardware up-gradation
are easily integrated to the system

> Server access are possible remotely from
different locations and types of systems

Disadvantages of Network Operating System:
> Servers are costly

> User has to depend on central location for
most operations

> Maintenance and updates are required
regularly

Examples of Network Operating System
are: Microsoft Windows Server 2003, Microsoft
Windows Server 2008, UNIX, Linux, Mac OS X,
Novell NetWare, and BSD etc.

5. Real-Time Operating System

These types of OSs serves the real-time
systems. The time interval required to process and
respond to inputs is very small. This time interval is
called response time.

Real-time systems are used when there
are time requirements are very strict like missile
systems, air traffic control systems, robots etc.

1.2.2 popular operating systems

Q25. List out various well known operating
Systems.

AnS :

Popular Operating Systems

Initially computers had no operating systems.
Every program needed full hardware specifications
to run correctly as processor, memory and device
management had to be done by the programs
themselves. However, as sophisticated hardware and
more complex application programs developed,
operating systems became essential. As personal
computers.became popular among individuals and
small businesses, demand for standard operating
system grew. Let us look at some of the currently
popular operating systems:
»  Windows: Windows is a GUI operating
system first developed by Microsoft in 1985.
The latest version of Windows is Windows 10.
Windows is used by almost 88% of PCs and
laptops globally.
> Linux: Linux is an open source operating
system mostly used by mainframes an
supercomputers. Being open source means
that its code is available for free and anyone
can develop a new OS based on it.
> BOSS: Bharat Operating System Solutions
is an Indian distribution of Linux based on
Debian, an OS. It is localized to enable use of
local Indian languages. BOSS consists of “

»  Linux kernel

Office application suite BharteeyaOO
Web browser

Email service Thunderbird

Chat application Pidgim

File sharing applications

Multimedia applications

VV YV V VYV
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Mobile OS

An operating system for smartphones, tablets
and other mobile devices is called mobile OS.
Some of the most popular OS for mobile devices
includes”

> Android: This Linux-based OS by Google is
the most popular mobile OS currently. Almost
85% of mobile devices use it.

Windows Phone 7: It is the latest mobile OS
developed by Microsoft.

Apple iOS: This mobile OS is an OS
developed by Apple exclusively for its own
mobile devices like iPhone, iPad, etc.

Blackberry OS: This is the OS used by all
blackberry mobile devices like smartphones
and playbooks.

1.2.3 The User Interface
Q26. What is user interface?

AnS :

A user interface, also called a “Ul” or simply
an “interface,” is the means in which a person
controls a software application -or hardware
device. A good user interface provides-a “user-
friendly” experience, allowing the user to interact
with the software or hardware in a natural and
intuitive way.

Nearly all software programs have a graphical
user interface, or GUI. This means the program
includes graphical controls, which the user can select
using a mouse or keyboard. A typical GUI of a
software program includes a menu bar, toolbar,
windows, buttons, and other controls. The
Macintosh and Windows operating systems have
different user interfaces, but they share many of
the same elements, such as a desktop, windows,
icons, etc. These common elements make it possible
for people to use either operating system without
having to completely relearn the interface. Similarly,
programs like word processors and Web
browsers all have rather similar interfaces,
providing a consistent user experience across
multiple programs.

Most hardware devices also include a user
interface, though it is typically not as complex as
a software interface. A common example of a
hardware device with a user interface is a remote
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control. A typical TV remote has a numeric keypad,
volume and channel buttons, mute and power
buttons, an input selector, and other buttons that
perform various functions. This set of buttons and
the way they are laid out on the controller makes
up the user interface. Other devices, such as digital
cameras, audio mixing consoles, and stereo systems
also have a user interface.

While user interfaces can be designed for
either hardware of software, most are a combination
of both. For example, to control a software
program, you typically need to use a keyboard
and mouse, which each have their own user
interface. Likewise, to control a digital camera, you
may need to navigate through the on-screen menus,
which is a software interface. Regardless of the
application, the goal of a good user interface is to
be user-friendly. After all, we all know how
frustrating it can be to use a device that doesn’t work
the way we want it to.

1.2.4 Mouse( Left Button, Right Button,
Moving icon on the screen)

Q27. Explain the functions of mouse ?
Ans :

The mouse is an external or built-in device
for visual navigation. There are various forms of
mouse devices:

> Classical form which you move around upon
a mouse pad

> Track ball that you roll with your fingers

> Touch pad where you touch around with your

fingers, etc.

Moving the mouse around the pad moves
the arrow (or mouse pointer) on your screen. The
mouse pointer changes its shape according to the
visual element passing over. It can appear as a pen
in an Edit Box, as a brush within a painting
application, etc.

A mouse can have several buttons, but when
using a standard software application, you will only
be using the two standard mouse buttons: left and
right. The buttons on the mouse allow you to start
programs, move objects from one place to another
and change various settings without typing in
complex text commands.
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You can perform the following easy functions
with your mouse:

(@) Single Clicking

You can single click by moving your pointer
on the screen so that it rests on top of an object
such as a folder, icon, file, or other object, and then
pressing the left mouse button. The object will then
be highlighted.

(b) Double Clicking

Double clicking the left mouse button
generally has two functions:

1. To open a file or folder to view the contents
and

2. To start a program.

Because Windows needs to distinguish
whether you actually meant to double click
something or just single click an object twice, you
may need to practice double clicking. The clicks
must be rapid; Windows considers two consecutive,
slow clicks as separate single clicks rather than one
double click.

When double clicking on a folder, the folder
opens and displays its contents.

If you double click @ program icon, the
program will start.

(c) Right Clicking

Right clicking refers to single clicking the right
mouse button. In different applications, the right
button will offer different options and functionality.
Mostly this click activates the so-called Context
Menu. Here is a basic use for the right click.

Right click on the desktop and select New.

From the choices that appear, select the
Folder option by moving the pointer over the word
folder in the menu and clicking the left button.

A new folder that you can rename will appear
on your desktop. You might create a new folder if
you would like to have a location to put all of your
backup files.

(d) Dragging and Dropping

The most common method for sighted
persons of moving objects around is by dragging
and dropping. We explain it here by the example
of moving a file from one location to an other.

To drag an object, select it by clicking your
left mouse button on the picture, or icon, and
holding it down. While still holding the mouse down,
drag the icon to the new location. Release the
button.

1.2.5 Use of Common Icons

Q28. Define Icon ? How to create, arrange,
and remove Windows desktop icons ?

AnS :

An icon is a small graphical representation
of a program or file. When you double-click an
icon, the associated file or program will be opened.
For example, if you were to double-click on the My
Computer icon, it would open Windows
Explorer. Icons are a component of GUI operating
systems, including Apple macOS X and
Microsoft Windows. Icons help users quickly
identify the type of file represented by the icon.

Desktop icons are a great way for users to
quickly access programs, files, folders, and even web
pages. If you're looking to create, arrange, or
remove desktop icons in Windows, make your
selection from the list below and follow the
instructions.

How to create a desktop icon

1. Press Windows key+D or navigate to the
Windows desktop.

2. Right-click any blank space on the
desktop. If you're on a laptop, tap the
trackpad with two fingers at the same time.

3. In the drop-down menu that appears,
move your mouse cursor over New,then
select Shortcut.

4. In the window that appears, select Browse...
then navigate to the program, file, or folder
which you’d like to create a shortcut, and then
click Ok.

5. In the Create Shortcut window, select Next,
then Finish.

How to arrange desktop icons

1. Press Windows key+D or navigate to the
Windows desktop.

2. Right-click any blank space on the
desktop. If you're on a laptop, tap the
trackpad with two fingers at the same time.

'| 33 I|

Rahul Publications



B.Com. | YEAR Il SEMESTER

3. Inthe drop-down menu that appears, select Sort by. You should see another menu appear to
the right.

4, Choose how you’d like the icons arranged, either by Name, Size, Item type or Date modified.
How to remove a desktop icon
To remove a desktop icon, single-click it and press the Delete key.

Q29. Define Desktop?

AnS :

The desktop is the primary user interface of a computer. When you boot up your computer, the
desktop is displayed once the startup process is complete. It includes the desktop background (or wallpaper)
and icons of files and folders you may have saved to the desktop. In Windows, the desktop includes
a task bar, which is located at the bottom of the screen by default. In Mac OS X, the desktop includes
a menu bar at the top of the screen and the Dock at the bottom.

The desktop is visible on both Windows and Macintosh computers as long as
an application or window is not filling up the entire screen. You can drag items to and from the desktop,
just like a folder. Since the desktop is always present, items on the desktop can be accessed quickly, rather
than requiring you to navigate through several directories. Therefore, it may be helpful to store commonly
used files, folders, and application shortcuts on your desktop.

1.2.6 StatusBar
Q30. What is the use of Status Bar? How can view hidden status bar in a browser.

AnS :

A status bar is located at the bottom of Internet browser windows and many application
windows and displays the current state ofthe web page or application being displayed.For example,
in early versions of Internet Explorer, it showed whether the page was secure, its certificate, what was
currently being loaded on the page, and the web address.

Example of a status bar
Below is an example of what the status bar looked like in Microsoft Internet Explorer.

Microsoft Internet Explorer Status Bar
Page loading, or the URL of the link the mouse is on Secure page Type of page

S |@ Internet ™

Status bar in other applications

Today, some applications still feature a status bar, unlike Internet browsers. Application status bars
may show page numbers, number of words in a document, or other information about the application or
file currently open.

For example, in Microsoft Word, the status bar is located at the bottom of the Word application
window. The Word status bar displays the current page number of the document, total pages, number of
words, and if there are any proofing errors. If text is highlighted in the document, the number of words in
that highlighted portion of text is displayed. A zoom slider is also displayed, allowing a user to zoom in or
out of a document.

g

Pagelof2 8of474words [J% E ] - B -—4—+ 100% '
Page number  # of words Proofing errors Zoom slider
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How can we view or hide the status bar in a
browser

Windows Explorer

The status bar in Windows Explorer is
displayed by default, but only shows basic
information about a select file or folder. To see more
details about a file, you can enable the Details pane
using the steps below.

1. Open Windows Explorer.
2.  Click View.

3. Click the Details pane option.
Internet Explorer browser
1. Open Internet Explorer.

2. Click View inthe menu bar at the top.
If you don't see the “File Edit View”
menu options, press the Alt key.

Select the Toolbars option.

Check or uncheck the Status
bar option to view or hide the status
bar.

Opera browser

Newer versions of Opera no longer have a
full status bar. Instead, a pop-up mini status bar is
displayed at the bottom left of the Opera window
when hovering over a web page hyperlink.

In older versions of Opera, the status bar can
be shown or hidden by following the steps below.

1. Open Opera.
2. Click the View menu.

Check or uncheck the Status bar option
to view or hide the status bar.

1.2.7 Menu Bar / Using menu & Menu
selection

Q31. What is the use of Menu Bar ?
Ans :

A menu bar is a thin, horizontal bar
containing the labels of drop-down menus in an
operating system’s GUI. It provides the user with a
standard place in a window to find the majority of
a program’s essential functions. These functions

include opening and closing files, editing text, and
quitting the program. Although menu bars are
usually present in most GUIs, they may differ
depending on the operating system you’re using.

Microsoft Windows menu bars

In Microsoft Windows, the menu bar is
beneath the title bar. The menu bar in Windows
may be accessed via keyboard shortcuts. Pressing
the Alt key and the menu-specific hotkey (which
appears as an underlined letter in the menu)
activates that menu choice. Below is a diagram of a
Windows file menu with a description of each part
of the menu.

Menu name
Menu bar-blﬁle Edit View Insert Form

Selected menu item

Separator —Eb

Ctr+O 44— Menu shortcut

& save Ctr4s
Menu item — Save fs...
@, Preview in Browser...

Page Setupg——————+— Mnemonic
Properties...

Recent Files » Submenu arrow
Chevron ————————p ¥

With Windows 8, Windows 10, and full-
screen programs, the menu bar may be hidden to
improve the appearance of the program. To show
the menu bar move your mouse or finger to the
top of the screen.

Not all programs use a file menu. For
example, in new Office programs instead of a file
menu it uses the Ribbon. Other programs may use
a hamburger menu, kebab menu (e.g.,
Chrome), or meatballs menu (e.g., Edge) to
access the programs features. For these programs,
you’ll need to use the alternative menu system.

Some programs may also hide the file menu
to keep the interface clean. With these programs,
pressthe Altkey or F10 function key any time
you want to open the file menu. Other programs
may only show the menu when the mouse pointer
is moved to the top of the screen or when scrolling

up.
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1.2.8 Running an application

Q32. What is the use of task manager ?
Ans :

Windows Task Manager

The Microsoft Windows Task Manager is a general, quick, and easy method of seeing what is
running on the computer.You can access the Task Manager by pressing Ctrl+Alt+Del on your
keyboard, then select Task Manager. You can also right-click with your mouse on the
Windows Taskbar and select Task Manager.

The Task Manager is an operating system component found in all versions of Microsoft
Windows since Windows NT 4.0 and Windows 2000. It allows you to view each of the tasks (processes)
and the overall performance of the computer. Using the Task Manager, you can view how much memory
a program is using, stop a frozen program, and view available system resources.

As you can see in the picture below, in Windows 8 and Windows 10, the Windows Task Manager
opens with the Processes tab selected. In Windows 7 and earlier, the Task Manager opens with the
Applications tab selected. In both cases, the applications currently open and running on the computer
are displayed. From here, you can end any application that is not responding by selecting it in the list
and clicking the End Task button.

Windows 8 / Windows 10 Windows 7 and earlier
£ Wundows Task Manager = 2101 x|

G Cotors Yew Wndows Hep

Agphcations | processes | Performance |

Frocene Padsemance App Metory Matep Luen Detsk Servce

| ats |

Burvws)

Computer Mopes word of the dey. Lesk - Mo Burrers)

@ Coogle (vome (L b " HeuE oM S YestPod - [Document? *] Purers

@ Mcroion tacel (12 04 o wiws Ll ) Mgs 8 ' Computer Mope word corwerter b2 0 resdlts .. Bunewy)

ol WhcraioM Lapreinen Wet 4 (1] bt M s MLy 3 Mg By aliC - [#2e00 (Jored) « Tope s not set]  Runreng

sk Manage = LA SRS B (wRATsystemIZiCnd exe furees

m- IWENT ytem 1 Cmd exe - perl hoge pl Rurvers)

".'mu.r- 51 - SecureCRT L]

T Apghuatson Frama Mowt "~ Lowme 2 My JT F"?\”“"’ - hotegad Burrey

& - ~ T - Mgt R Lsunchbar - Groove Bureerg

o Prtitied - Notegsd Rurrry)

Se— ” 2 o e - S CuUsTOMER SERVICE - Morosolt Ontiosk Rurvin

B Conara % Hawe I ) Mg !L,,m Petoshop Bureirg
b e - 1.8 LI [
A - Y T L [T
¥ M us LX) (X 5

L Task sachto | pewrtask.. |

Processes: 94 O Usage: 0% Mees Usage: 4146480 [ I20160x

One of the most common things done in Task Manager is using End Task to stop a program
from running. If a program is no longer responding, you can choose to End Task from the Task Manager
to close the program without having to restart the computer.

1.2.9 Viewing of file, Folder and Directories.
Q33. How to Choose a File (or) Folder View in Windows Explorer

AnS :

Windows Explorer is a program you can use to find a file or folder by navigating through an
outline of folders and subfolders. It's a great way to view files on your computer, and you can even
adjust how the files and folders are displayed.
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To choose a file or folder or directory view in Windows Explorer:

1. Right-click the Start menu button and choose Open Windows Explorer, or click the Windows Explorer
button on the taskbar

The Windows Explorer button looks like a set of folders. The Windows Explorer window appears.

T - T nt T
B e 'I
View Tools Help
Organize v New library -3 0
W Favorites ) ?:‘M
& Recently ;AQ; oy
4 Public :
I Desktop Library
b Downloads
B Recent Places Pictures
Ju Playlists - Library
4 Libraries Videos
B ¢ P Library
& Music
= Pictures -
4 items
Libraries let you access and arrange items from one or more folders quickly without moving th...
4items

Double<lick a folder to open it
2. Double-click a folder in the main window or in the list along the left side to open the folder.
The folder’s contents are displayed.

3.  Tosee different perspectives and information about files in Windows Explorer, click the arrow on
the Views button.

The View button looks like a series of columns.
4. Choose the menu option that matches how you would like the files to appear.

Your choices include Extra Large Icons, Large Icons, Medium Icons, or Small Icons for graphical
displays; Details to show details such as Date Modified and Size; Tiles to show the file/folder name,
type, and size; and Content to display the date modified and file size only.

1.2.10Creating and renaming of files and folders
Q34. Explain the steps to create and rename a file or folder?

AnS :

Creating and Renaming Files and Folders

The keys to organizing files and folders effectively within a hierarchy are to store related items
together and to name folders informatively. Creating a new folder can help you organize and keep track
of files and other folders. In order to create a folder, you select the location where you want the new
folder, create the folder, and then lastly, name the folder. You should name each folder meaningfully so
that just by reading the folder’s name you know its contents. After you name a folder or file, you can
rename it at any time.
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Create a Folder

> In the desktop, click or tap the File Explorer button on the taskbar.
> Open the drive or folder where you want to create a folder.

> Click or tap the New Folder button on the Home tab.

> With the New Folder name selected, type a new name.

> Press Enter or tap in a blank area.

Library Tools

e Home Sh) iew Manage ~ 09
% cut ] i x @ [§3 New item ~ G open~  [HH selectan
=) Copy path - -a Easy access B Edit 2o Select none
Copy Paste Move Copy Delete Rename New Properties B n o A
[ PasteTort(ut tov tov v folder v € History 5% Invert selection

Clipboard

@ - 1 »JLibraries » Documents » v & Search Documents P

Organize New Open Select

¢ Favorites . |

(/ Libraries |
Business | il

@ DoCUMENtS
J Music

(&S] Pictures

B videos

Business Home Sense

@ Homegroup
% Computer

€ Network

3items 1itemselected Library includes: 2 locations

Rename a File or Folder

> In the desktop, click or tap the File Explorer button on the taskbar.
> Select the file or folder you want to rename.
> Click or tap the Rename button on the Home tab.
— {38 }
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>

>

Library Tools
File Home Shijre View Manage ~ @
% cut m x @ "‘ 3 New item ~ Gaopen -  HH selectan
=) Copy path - £7) Easy access ~ Edit 55 Select none
Copy Paste Move Copy Delete Rename New Properties x = .
[Z] Paste fhortcut tor to~ - folder - & History 59 Invert selection
Clipboard Organize New Open Select
@ ~ 1 [ »JLibraries » Documents » v & Search Documents y-J
X Favorites \ |
&4 Libraries
Business
il — Business Home Sense

J Music
[&=] Pictures
B videos

«@ Homegroup
™ Computer 5

€ Network

3 items 1 item sel d Library includes: 2 | i g=

With the name selected, type a hew name, or click or tap.to position the insertion point, and then
edit the name.

Press Enter or tap in a blank area.

Library Tools

Home Share Vi Manage A 0

ew
S X an ] x @ m [ New item ~ D G Open~ [HH selectan
[ Copy path - ) Easy access ~ Edit 5o Select none
Copy Paste _ Move Copy Delete Rename New Properties

[2] Paste shortcut = tov  tov - folder -

Clipboard Organize Open Select

@ @ - 4 @ » Libraries » Documents v & Search Documents pr

¢ Favorites ‘ D ‘
(&4 Libraries 3
Business f ) Jm i f

@ Socments Business Home Sense

g History 5= Invert selection

& Music
[&5] Pictures
B videos

& Homegroup
1% Computer

€ Network

3items 1itemselected Library includes: 2 locations

g
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1.2.110pening and closing of different
Windows

Q35. How can we open close move and
windows resizing?

AnNS:

Opening, closing, resizing and moving
windows

To reduce clutter on your screen, inactive
windows are often "closed ” or “minimized 7,
that is, replaced by a smaller ”icon ” thatactsasa
placeholder for the program running in the window.

(@)

To open a closed window

Move the mouse pointer onto the icon for
the window, and either press the Open key (L7) on
the keyboard or double click the left mouse button
(press it twice in rapid succession).

(b)

To close an open window

Move the mouse pointer onto the window,
and either press the Open key (L7), or click the left
mouse button while the pointer is on the square in
the upper right corner of the window that is marked
with a small dot.

(©)

To move a window

Move the mouse pointer to the title bar at
the top of the window. Push the left mouse button
down and hold it down while you move the mouse
to drag the window to a new position. Release the
button when the window is at the desired position.

(d)

To bring a window forward

Soitis not obscured by overlapping windows,
move the mouse pointer onto the desired window
and press Front (L5). If you press Front when the
mouse pointer is already on the front window, that
window is pushed behind all other windows.
Alternatively, move the pointer to any part of the
frame surrounding the window and click the left
button to bring the window forward.

(e)

To resize a window

Move the mouse pointer to the corner of the
window whose size you want to change. The pointer
will change shape from an arrow to an L-shape
matching that corner. Then:

Rahul Publications

40 J

1. Hold down the left mouse button.

2. Drag the outline of the window to the desired
size.

3. Release the button.
To move a window to another workspace

Move the mouse pointer over the title bar, or
any other part of the frame surrounding the window,
and press the right mouse button. The Window
Menu will appear. Click on Occupy Workspace...
to see a window of workspace names, then click
the left mouse button on the desired workspace,
followed by OK.

1.2.12 Help

Q36. What is the use of Help Menu in Ms
Word?

Ans
Using the Microsoft Word Help Menu

Much like searching the research database for
answers to your questions, you can use the help
menu which searches a database for answers to your
Word questions. To access the help menu, go to the
Menu Bar and select Help > Microsoft Word
Help. Access to Word’s Help Resources will open
on the right. Enter the keywords or phrase of the
skill or information you are researching in
the Search For: box. See diagram below.

p
Microsoft Office .
Word Help a?:ggw?r.
s enter keywords
Bout Mcroselt Offce Werd

Press the green arrow “next” button. The
Word help database will provide you with a number
of options. Select the one that best describes the
answer you seek. Double-click on the blue title to
access the information. See diagram below.
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Navigation
Tools

(previous, 30 results from Office Online 3

next, home)
[ ———————————— _ |
& aApply italic Formatting

Help > Formatting Characters

& Automatic Formatting results
Help > AutoFormat

Search
Results

Help > Styles and Reusing
Formatting

@ aApply a different style
Help > Styles and Reusing
Formatting

@ aApply atheme
Help > Themes

@& Edit or format an index entry
Help > Index

) Letter to candidates who
apply too late

Templates > Responding to
Applicants

more results

Microsoft Office Online
apply italic > |
& Can't find it?

pulldown
menu

If you do not find what you need, either select the green “back” arrow from the navigation buttons
at the top, enter new words in the search box at the bottom of the help window, or click on “Can’t find it?”
to get some tips on searching more effectively.

1.2.13Creating Shortcuts

Q37. How to create a Windows shortcut

AnNs:

Shortcuts are a great way to quickly access programs, files, folders, and even web pages. They can
be conveniently placed on your desktop or in certain directories or folders. There are a few methods used
to achieve these results.

Create a shortcut using Microsoft’s wizard

This method allows users to create shortcuts on the Windows desktop or in a folder.

1. Right-click a blank space on the Windows desktop, a folder, or in a directory.

2. Move your mouse cursor over New in the drop-down menu that appears.
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View
Sort by
Refresh

NN

Paste

Paste shortcut

Undo Delete Ctri+Z
Q FileLocator Lite...

B NVIDIA Control Panel

_New

Display settings
& Personalize

3. Then select Shortcut.

' | Folder

| |# Shortcut I

@3 Contact
Rich Text Document
Text Document

4.  On the Create Shortcut- window, click the = Browse...  button.

5. Locate the program for which you’d like to create a shortcut (A), and then click OK (B).

Browse for Files or Folders X

Select the target of the shortcut below:

cef_license.txt ~

curl_license.txt

[ d3dcompiler_47.d1l

[ dbghelp.dn

« Destiny 2 Launcher.exe

A Y destiny2.exe .

&8 miniTicketDbg.exe

msvcp140.dil

@ NVAPI_SDK_License_Agreeme

opus_license.txt

pcre2_license.txt v
< I >

[Mskenewroder | B[ oc ][ cancel

]
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6. Click the button.

7. Type in a name for the shortcut, then click the Finish button.

Create a shortcut from a folder
1. Open the Windows File Explorer by pressing the Windows key and E at the same time.
2. Browse to the folder that contains the program for which you’d like to create a shortcut.

3. Right-click on the program and select Create Shortcut from the drop-down menu that
appears.

Oppeamn

o Run as administrator
Troubleshoot compatibility
Pin to Start

EE Scan with Windows Defender...

1= Share
Pin to taskbar

9P Scan with Mahwarebytes
Restore previous versions

Send to >

Cut

Copy

Create shhortcut l
Delete

Rename

Properties

4, Doing so creates a shortcut named “<selected program’s name> - Shortcut” in the current directory.

5.  After completing the above steps, you can right-click the shortcut to copy or cut it, and
then paste it to another location.

1.2.14 Basics of Operating Set up

Q38. Explain the steps for basics of operating system set up.
Ans :

The steps for installing an operating system, like Linux or Microsoft Windows, depends on the
operating system version you are installing. Each version has different steps and options that are unique
to that operating system.

Following are the general steps and guidelines for installing an operating system on your computer.
Step 1: Purchase the operating system

First, you need to purchase the operating system that you want to install on the computer. The best
place to purchase the operating system from is a retail store, like Best Buy, or through an online store, like
Amazon or Newegg. The operating system may come on multiple CD or DVD discs, or it may even
come on a USB flash drive.

{ 43}
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It is not recommended that you obtain the
operating system by downloading it, unless it is
downloaded from the operating system publisher,
like Microsoft, or from a reputable online store.
Downloading it from another source may result in
an unusable or illegal copy of the software.

Step 2: Install the operating system

To install the operating system on the
computer, if the operating system software came
on a CD or DVD, you need to configure your
computer to boot to the CD/DVD drive. You can
change the boot sequence by accessing the
computer BIOS and setting the CD/DVD drive to
be the first boot device. Some computers may also
allow you to access the boot sequence directly at
computer start up, without entering the BIOS, by
pressing a specific key on the keyboard. The key to
press differs for each computer, but is often either
the Delete key or one of the function keys at the
top.

If the operating system_software came on a
USB flash drive, you need to configure the computer
to boot to a USB.device as the first boot device.

Once the computer is configured to boot to
the proper device, the computer should load the
operating system installation program and guide
you through the install process. You will be asked
questions along the way for configuration of basic
settings, like date and time, user account name, and
if you want to enable automatic operating system
updates. Go through the installation steps, answering
questions and selecting the preferred options.

Step 3: Running the operating system

After the operating system has been installed,
the computer should load into the operating system.
You may then proceed with installing software
programs that you want on the computer and
updating any settings you want.
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1.2.15 Common Utilities
Q39. What is utility software?
Ans :

Utility programs, commonly referred to as just
“utilities,” are software programs that add
functionality to your computer or help your
computer perform better. These include antivirus,
backup, disk repair, file management, security, and
networking programs. Utilities can also be
applications such as screensavers, font and icon
tools, and desktop enhancements. Some utility
programs help keep your computer free from
unwanted software such as virusesor spyware, while
others add functionality thatallows youto customize
your desktop and-user interface. In general,
programs that help make your computer better are
considered utilities.”/And unlike water and electric
bills, computer utilities don't send you a bill every
month!

These software analyse and maintain a
computer. These software are focused on how OS
works on that basis it perform task to enable smooth
functioning of computer. These software may come
along with OS like windows defender, windows disk
cleanup tool.

Antivirus, backup software, file manager, disk
compression tool all are utility software.

Some of popular utility software are described
below

Antivirus

Itis used to protect a computer from the virus.
It detects a virus and notify the user and take action
to secure the computer. The virus are kept in
different location called vault where it has different
file system due to which virus effect it. User can itself
instruct antivirus to delete malicious program, put it
in vault or even ignore it. These days most come in
GUI form.
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The first antivirus program appeared in 1987
with the introduction of an antivirus program from
G Data Software for the Atari ST. Later in the same
year, VirusScan was introduced by John McAfee,
which later became the McAfee antivirus program.

Examples

Windows Defender, AVG, AVAST, MCAFEE
etc.

File Management Tool

The software is used to manage files stored in
a file system. It can be used to create, group file.
Like Windows File Explorer is a file management
tool.

File system (like FAT32, NTFS) should not
be confused with File management tool former is a
data structure used to store file in a OS while later is
used to perform task on file stored in the file System.

Some example of File management Tool are:
File Manager in Windows.
macOS Finder.
Directory Opus.
Dolphin in"KDE.
Compression Tool

These tool are used to reduce the size of a file
based on the selected algorithm.

Most operating systems include tools for
compressing and uncompressing files.Linux has tools
for both .tar.gz and .zip. Other compressed files,
like .7z and .rar, require a third-party compression
utility to be installed.

Some Examples are:

WinAce

winZip

WinRAR

7-Zip

PKZIP

DISK MANAGEMENT TOOL

Disk Management is utility first introduced in
Window XP as a replacement of the fdisk
command.lt enables us to view or managed the disk
drives installed in their computer and the partition
associated with those drives.

Disk Management is used to managed the
drives installed in a computer- like hard disk drives,
and flash drives.It can be used to partition drives,
assign drive letters and much more.

Some Disk Management tools are:-
Mini Tool Partition Wizard

Paragon Partition Manager

EaseUS Partitin Master

SMART Monitering Tools

V.V ¥V V V

AOMEI Partition Assistant
DISK CLEANUP TOOL

It is computer utility maintenance which is
included in Microsoft Windows. It allows user to
remove files that are no longer needed or that can
be safely deleted. Removing unneccessary files,
including temporary files, can help to improve the
functioning and increase the free space of the
computer. Running Disk Cleanup at least once a
month is an excellent maintenance task.

Disk Cleanup tool can delete temporary
internet files, old check disk files, compress old
filesand offline webpages. Disk cleanup also allows
you to empty the Recycle Bin, delete temporary
files, and delete Thumbnails.

Some Disk Cleanup software are :
lolo System mechanic

IObit Advanced systemCare
Piriform CCleaner

Razer Cortex

E]
o1
YV V V V
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Disk Defragmenter

It is a utility in Microsoft Windows designed
to increase access speed by rearranging file stored
on a disk to ocuppy contiguous storage locations, a
technique is called
Defragmentation

Defragmenting a disk minimizes head travel,
which reduces the time it takes to read files from
and write files to the disk.

The defragmenter will search your harddrive
partition and move data from one location to other
location, so that the files stored there are one
contiguous piece, istead of being throughout
multiple locations on the harddrives partition.

Some Disk Defragmenter are:
»  Auslogics Disk Defrag

»  MyDefrag

> Perfect disk

»  Deflaggler

I 1.3 UNDERSTANDING WORD PROCESSING

1.3.1 Basics of word processing

Q40. Define word processing. What are the
use of word processing ?

AnS :

Word processing software is used to
manipulate a text document, such as a resume or a
report. You typically enter text by typing, and the
software provides tools for copying, deleting and
various types of formatting. Some of the functions
of word processing software include:

> Creating, editing, saving and printing
documents.

> Copying, pasting, moving and deleting text
within a document.

> Formatting text, such as font type, bolding,
underlining or italicizing.

> Creating and editing tables.

> Inserting elements from other software, such
as illustrations or photographs.

> Correcting spelling and grammar.
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Word processing includes a number of tools
to format your pages. For example, you can
organize your text into columns, add page numbers,
insert illustrations, etc. However, word processing
does not give you complete control over the look
and feel of your document. When design becomes
important, you may need to use desktop publishing
software to give you more control over the layout
of your pages.

Word processing software typically also
contains features to make it easier for you to perform
repetitive tasks. For example, let’s say you need to
send a letter to all your customers regarding a new
policy. The letter is the same for all customers except
for the name and address at the top of the letter. A
mail merge function allows you to produce all the
letters using one template document and a table
with customer names and addresses in the database.

Text editors shouldn’'t be confused with word
processing software. While they do also allow you
to create, edit and save text documents, they only
work.-on plain text. Text editors don’t use any
formatting, such as underlined text or different fonts.
Text editors serve a very different purpose from word
processing software. They are used to work with
files in plain text format, such as source code of
computer programs or configuration files of an
operating system. An example of a text editor would
be Notepad on the Windows platform.

QA41. List and explain standard features of
word processing?

AnS :

Microsoft Word is a popular word proces-
sing software. It helps in arranging written text in a
proper format and giving it a systematic look. This
formatted look facilitates easier reading. It provides
spell-check options, formatting functions like cut-
copy-paste, and spots grammatical errors on a real-
time basis. It also helps in saving and storing
documents.

It's also used to add images, preview the
complete text before printing it; organize the data
into lists and then summarize, compare and present
the data graphically. It allows the header and footer
to display descriptive information, and to produce
personalized letters through mail. This software is
used to create, format and edit any document. It
allows us to share the resources such as clip arts,
drawing tools, etc. available to all office programs.
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Standard Features of Word Processors

Word processors vary considerably, but all
word processors, whether cloud-based or installed
on a system, support the following basic features:

i) Insert text

Allows you to insert text anywhere in the
document.

ii) Delete text

Allows you to erase characters, words, lines,
or pages.
iii) Cut and paste

Allows you to remove (cut) a section of text
from one place in a document and insert (paste) it
somewhere else.
iv) Copy

Allows you to duplicate a section of text.
V) Page size and margins

Allows you to define various page sizes and
margins, and the word processor will automatically
readjust the text so that it fits.

vi)  Search and replace

Allows you to direct the word processor to
search for a particular word or phrase. You can also
direct the word processor to replace one group of
characters with-another everywhere that the first
group appears.

vii)  Word Wrap

Automatically moves to the next line when
you have filled one line with text, and it will readjust
text if you change the margins.

viii) Print

Allows you to send a document to a printer
to get hard copy.
ix) File management

Provides file management capabilities that
allow you to create, delete, move, and search for
files.

X)  Font specifications

Allows you to change fonts within a document.
For example, you can specify bold, italics, and
underlining. Most word processors also let you
change the font size and even the typeface.

xi)  Windows

Allows you to edit two or more documents at the
same time. Each document appears in a separate
window. This is particularly valuable when working
on a large project that consists of several different
files.

xii) Spell checking

Identifies words that don’t appear in a
standard dictionary.

Q42. Explain the Features of Word Processing.
Ans :

The advanced word processors are called full-
featured word processors. These word processor
provide additional features to format documents in
more sophisticated ways. Following are some
important features of an advanced word processor.

i) File management

An advanced word-processor contains file
management capabilities. It can be used to create,
delete, move and search files.

ii)  Font Specification

The appearance of text in the document is
called font or typeface. Full-featured word processor
can change the font of all or selected text to improve
readability. Fonts are used to create the text of
different styles and sizes. The user can specify bold,
italic and underline.

iili) Graphics

Full-featured word processor is used to insert
images and graphs in a document. Some word
processors also provide the facility to create images.

Some word processors only provide the facility to
insert images created in different programs.

iv) Header, Footer and Page Numbering

Full-featured word processor provides header
and footer feature. Header is the text that is added
to the top of every page. It may include document
title or page number. Footer is the text that is added
at the bottom of the every page.

v)  Spell checker

Spell checker features in full-featured word
processor help the user to correct any spelling in
the document. The misspelled words are highlighted.

a7)
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vi) Layout

Full-featured word processor provides the
facility to specify different margins within a single
document. Is also specifies different methods for
indenting paragraphs.

vii) Table of contents and indexes

Full-featured word processor can also
generate a table of contents and index. It is based
on special code inserted in the document. It is very

helpful in writing books.
viii) Merges

Itis used merge text from one file into another
file. It is useful to generate many files that has same
format but different data. Generating mailing labels
is an example of merges.

ixX) Thesaurus

Thesaurus feature provides the appropriate
word or alternate words.

x)  Auto Correct

Word processor automatically corrects many
commonly misspelled words and punctuation marks
with the autocorrect feature.

xi)  Document Window

Full-featured word processor can be used to
edit two or more documents at the same time. Each
document appears in a separate window. It is very
useful if a user is'working on a large project that
consists of several files.

xii) Footnotes and cross-reference

Full-featured word processor can generate
footnotes at the bottom of the page. Footnotes are
used to cross-reference other section of the
document easily.

xiii) WYSIWYG

It stands for what you see is what you get. It
means that the printed copy of the document will
be similar as appears in the word processor.

xiv) Macros

A macro is a character or word that represents
a series of keystrokes. The keystrokes may represent
text or commands. The macros are defined to save
a lot of time for repeating the same task.

Rahul Publications
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Q43. Explain about office button.
Ans :

Microsoft Office Button

Microsoft Office Button is located on the top
left corner of the window.It is a new user interface
feature that replaced the traditional “File” menu.
You can also see this button in Outlook while creating
a new message, task, contact, etc.

See the image
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When you click the button it offers a list of
commands to perform different tasks which are New,
Open, Save, Save As, Print, Prepare, Send, Publish
and Close. These commands are described below
the following image.

See the image
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New

This command enables you create a new file,
i.e. Word document.

Open

This command allows you to open an existing
file on the computer.

Save

This command is used to save a file after
completing the work. You can also save the changes
made to the currently open file.

Save As

This command helps you save a new file with
a desired file name to a desired location on the hard
drive.

Print

This command is used to print a hard copy
of the currently open document.

Prepare

This command allows you to prepare the
document for distribution, i.e. you can view and
edit the document properties and inspect the hidden
metadata.

Send

This command allows you share the
document with other users, i.e. you can send a
document through e-mail or by posting to a blog.

Publish

This command allows you distribute the
document to other people, i.e. you can create a
blog with the content of the document.

Close

This command is used to close the currently
open file.

Q44. What is the use of quick access tool bar?
Ans :

Quick Access Toolbar

Quick Access Toolbar lies next to the Microsoft
Office Button. Itis a customizable toolbar that comes
with a set of independent commands. It gives you
quick access to commonly used commands such as
Save, Undo, Redo, etc.

See the image
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When you click the drop-down arrow next
to toolbar it offers more commands. With a left click
you can add any of these commands to Quick Access
Toolbar. You can also remove the commands added
to the tool bar. The indent, spacing values, individual
styles and other features that appear on the ribbon
cannot be added to quick access toolbar. The
following image is showing the menu of quick access
toolbar.

See the image
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Minimize the Ribbon

Q45. What is the use of Title bar and ruler?

Ans :
Title Bar

It lies next to the Quick Access Toolbar. It
displays the title of the currently open document or
application. It is present on almost all windows
displayed on your computer. So, if there are several
windows across the screen, you can identify each
window by looking at the title bar. In many graphical
user interfaces, you can also move a window by
dragging the title bar.
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See the image
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Ruler

The Ruler is located below the Ribbon around the edge of the document. It is used to change the format
of the document, i.e. it helps you align the text, tables, graphics and other elements of your document. It
uses inches or centimeters as the measurements unit and gives you an idea about the size of the document.

See the image
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Q46. Give a basic lookup about Ribbon and tabs of word.

AnS :

Ribbon and Tabs

The Ribbon is a user interface element which was introduced by Microsoft in Microsoft Office 2007.
It is located below the Quick Access Toolbar and the Title Bar. It comprises seven tabs; Home, Insert, Page
layout, References, Mailing, Review and View. Each tab has specific groups of related commands. It gives
you quick access to the commonly used commands that you need to complete a task.

See the image
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The Home tab is the default tab in Microsoft Word. It has five groups of related commands; Clipboard,
Font, Paragraph, Styles and Editing. It helps you change document settings like font size, adding bullets,
adjusting styles and many other common features. It also helps you to return to the home section of the
document.

See the image
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Insert tab

Insert Tab is the second tab in the Ribbon. As the name suggests, it is used to insert or add extra
features in your document. It is commonly used to add tables, pictures, clip art, shapes, page number, etc.
The Insert tab has seven groups of related commands; Pages, Tables, lllustrations, Links, Header & Footer,
Text and Symbols.

See the image

[#) Cover Page ~ D l_j BJal P shapes~ 8, Hyperiink ] Header - ‘_l 4 QuickParts ~ (&~ T Equation ~

e T smatart | @ Bookmark o Footer ~

WordArt ~ Symbol ~
Toble Picture Clip ‘ “ R B

L) Blank Page

(n) Cross-reference | =) P

v “,. AS Drop Cap -

Page Layout tab

It is the third tab in the Ribbon. This tab allows you to control the look and feel of your document,
i.e. you can change the page size, margins, line spacing, indentation, documentation orientation, etc. The
Page Layout tab has five groups of related commands; Themes, Page Setup, Page Background, Paragraph
and Arrange.

See the image
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References tab

It is the fourth-tab in the Ribbon. It allows you to enter document sources, citations, bibliography
commands, etc. It also offers commands to create a table of contents, an index, table of contents and
table of authorities. The References tab has six groups of related commands; Table of Contents, Footnotes,
Citations & Bibliography, Captions, Index and Table of Authorities.

See the image
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It is the fifth tab in the ribbon. It is the least-often used tab of all the tabs available in the Ribbon. It
allows you merge emails, writing and inserting different fields, preview results and convert a file into a PDF
format. The Mailings tab has five groups of related commands; Create, Start Mail Merge, Write & Insert
Fields, Preview Results and Finish.
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See the image
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Review tab

It is the sixth tab in the Ribbon. This tab offers you some important commands to modify your
document. It helps you proofread your content, to add or remove comments, track changes, etc. The
Review tab has six groups of related commands; Proofing, Comments, Tracking, Changes, Compare and
Protect.

See the image
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The View tab is located next to the Review tab. This tab allows you to switch between Single Page
and Two Page views. It also enables you to control various layout tools like boundaries, guides, rulers. Its
primary purpose is-to offers you different ways to view your document. The View tab has five groups of
related commands; Document Views, Show/Hide, Zoom, Window and Macros.

See the image
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1.3.2 Opening Closing of Documents
QA47. Explain the steps to create, open, close and save documents in word.

AnS :

To create a new document use following steps
(2) To create a new blank document:
> Click the Microsoft Office button.
> Select New. The New Document dialog box appears.

> Select Blank document under the Blank and recent section. It will be highlighted by default.
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A €« > ISearch Microsoft Office Online for a[-)J

Templates

Installed Templates Blank and recent

My templates...

New from existing...
Microsoft Office Online
Featured

[ —E— Y

Agendas

Award certificates
Brochures
Budgets

Business cards

Calendars

Contracts

Newsletter wizard Equity Resume

Diagrams

Envelopes

Expense reports & ' _*B ' :.B ~

> Click Create. A new blank document appears.in the Word window.
(b) Open a Saved Document (File) in Microsoft Word

While you are creating a document, it is often important to save it for future use. The saved document
now becomes a file. Afile is a complete, named collection of information, such as a user-created document.
It is the basic unit of storage that enables a computer to distinguish one set of information from another.
It is acollection of data that a user can retrieve, change, delete, save, or send to an output device, such as
a printer-or e-mail program.

From the foregoing explanation, you realize that a saved document can be retrieved, viewed and
reused. Here are the steps involved in opening/retrieving a saved document/file in Word environment.

1 On the Menu bar, click File, and then click Open. The Open dialog box appears.
2 In the Look in list, click the drive or folder that contains the file you want to open.
3. Click the file.
4 You'll see a preview of the selected file in the Preview box.
5 Click Open.
(c) Save a Document in Microsoft Word

As you create a document, you will need to store it for future reference or use.

In Word, you to save your documents in various ways. You can save all open documents at the
same time. You can also save a copy of the active document with a different name or in a different
location. If you share documents with people who use previous versions of Word, and you want to be
sure the documents look the same when they’re opened in the earlier versions, you can turn off features
that are not part of that version.
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(d)

5.
(€)

To save a document
Open the File menu and click Save. The Save As dialog box appears.
In the File name box, enter a desired name for the document.

To save the document in a folder or a drive other than the default, click the drop-down arrow in
the Save in box, and then choose the desired folder or drive.

To save the document in a new folder within the current drive, click the Create New
Folder button on the toolbar within the Save As dialogbox, directly below the title bar of the Save
As dialog box.

Click Save.
Close a Document
When you are through working in a document, you need to close it. This will help prevent unintended

changes from being made to it, and also to free the computer working memory [Random Access Memory
(RAM)] some space.

Note, however, that closing a document means simply closing the active document (using

the Close command or alternatives), without actually quitting the entire Word window.

>
>
>

There are several ways of closing a document in Word. These methods use:
The File menu

The Close Window button on the menu bar

Shortcut keys

1.3.3 Text Creation and Manuplation
Q48. Explain the Text basics using word.

Ans :
How to Insert Text in MS Word

YV V V V VY

The basic steps to insert text or to create a new document in Word are listed below;
Go to the start menu and look for Microsoft Word icon

Click the icon to open the Microsoft Word

You will see a blinking cursor or insertion point in the text area below the ribbon
Now, as you start typing, the words will appear on the screen in the text area

To change the location of insertion point press spacebar, Enter or Tab keys
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Delete Text in MS Word
You can easily delete the text in Word including characters, paragraphs or all of the content of your
document. Word offers you different methods to delete the text; some of the commonly used methods
are given below;
Place the cursor next to the text then press Backspace key
Place the cursor to the left of the text then press Delete key
Select the text and press the Backspace or Delete key
Select the text and type over it the new text.

VVVYVY

Home | Insert | Page Layo | Reference | Mailings | Review | View | &
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-———— Text is selected

Select Text in MS Word
Place the cursor next to the text then left click the mouse and holding it down move it over the text

then release it. The text will be selected.
Some shortcuts for selecting text are:

> To select a single word double click within the word

> To select the entire paragraph triple click within the paragraph

> To select entire document, in Home tab, in Editing group click Select then choose Select All option
or press CTRL+A

> Shift + Arrow; hold down the shift key then press the arrow key, the word will select the text in the
direction of the arrow key. There are three arrow keys, so you can select the text in three different
directions.

Text is selected
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How to Copy and Paste Text in MS Word

Word offers different methods to copy and paste text. Some of the popular methods are given
below;

Method 1

> Select the text you want to copy

> Select the Home tab and click the Copy command
> Place the cursor where you want to paste the text
> Click the Paste command in Home tab

Method 2

> Select the text

Place the cursor over the text and right click the mouse

> A menu will appear; with a left click select the “Copy” option
> Now, move the cursor to a desired location and right click the mouse
> A menu will appear; with a left click select the ‘Paste” option.
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1.3.4 Formatting of Text
Q49. How to Change Font Size ,style, colour in MS Word

AnS :

You can easily change the font size of your text in the document. The basic steps to change the Font
size are listed below;
> Select the text that you want to modify
> In Home tab locate the Font group
> In Font group click the drop-down arrow next to font size box
> Font size menu appears
> Select the desired font size with a left click
>

Select the text and click the increase or decrease font size buttons
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Change Font Style in MS Word

The basic steps to change the font of a text in a document are given below;

Select the text you want to modify

Select the Home tab and locate the Font group

Click the drop-down arrow next to font style box

YV V V V

Font style menu appears
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> With a left click select the desired font style
> If you want to change the font to bold or italic, click the ‘B’ or ‘I’ icons on the format bar.
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Format Font Color in MS Word

MS Word allows you to change the Font color of your text. If you want to emphasize a particular
word or phrase, you can change its font color. The basic steps to change the Font color are given below;

Select the text you want to modify

In Home tab locate the Font group

Click the drop-down arrow next to Font color button
Font color menu appears

Select the desired font color with a left click

Word will change the Font color of the selected text.
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Q50. How to Change Text Case in MS Word
Ans :

You can easily change the text case in your document by following the steps given below;

Select the text you want to change

» In Home tab locate the Font group
»  Click the drop-down arrow in ‘Change Case’ button
»  Itdisplays text case menu

Select the desired case with a left click
The case menu offers four options;
Sentence case: It capitalizes the first letter of each sentence.
Lowercase: It changes the text from uppercase to lowercase.
Uppercase: It capitalizes all the all letters of your text.

Capitalize Each Word: It capitalizes the first letter of each word.

Toggle Case: It allows you to shift between two case views, e.g. to shift between Capitalize Each
Word and cAPITALIZE eACH wORD .
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Q51. How to Change Text Alignment in MS Word ?
Ans :

You can change the text alignment in your document to make it more presentable and readable.
The basic steps to change the text alignment are given below;

> Select the content you want to modify
> In Home tab locate the Paragraph group
> It has four alignment options ;
Align Text Left: Aligns the text towards left margin
Center: Brings the text at centre
Align Text Right: Aligns the text towards right margin
Justify: Aligns the text to both left and right margins
> Select the desired alignment option with a left click
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Bold, Italic and Underline Commands in MS Word
These commands are given in the Font group in the Home tab. Their functions are given below;
> Bold: It allows you to Bold the text of your document
> Italic: It allows you to Italicize the text of your document
> Underline: It allows you to underline the text of your document
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1.3.5 Table Handling

Q52. Explain the procedure to insert a table
in word document.

Ans :
Insert Table in MS Word

Table is a versatile tool of MS Word. It allows
you to organize your information, i.e. you can align
text, present numerical data and create forms and
calendar. The steps to insert table are given below;

A\

Place the cursor where you want to insert the
table

Select the Insert tab
In Tables group click the Table command

It displays different options to insert the table

YV V V V

Select the desired option to insert the table

Insert
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Add Row in Table

If you want to increase or add a new row in
your table, you can follow the steps given below;

©

> Place the cursor in a row above or below
which you want to add row

Add Column in Table

If you want to increase or add a new column
in your table, you can follow these steps;

> Place the cursor in the column adjacent to
which you want to add the column

Right click the mouse
It displays a menu
Place the arrow over Insert option

It shows a list of commands

vV V V V V

As required select ‘Insert Columns to the
Right’ or ‘Insert Columns to the Left’

See the image
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Delete Column or Row in Table

The table command also allows you to delete
a column or row in your table. You can delete the

> Right click the mouse unwanted columns or rows by following these steps;
> A menu appears > Select the column or row of the table
> Place the arrow over Insert option > Right click the mouse
> It will display a menu > A menu appears
> "A‘S required select’ Insert Rows Above’ or »  Asrequired select ‘Delete Columns’ or ‘Delete
Insert Rows Below )
Rows
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Calibri (Boc ~ (14~ A

[Detete Columns ]
B3 Merge Cells

Modify Table

Word allows you to customize tables as per your requirement. You can modify your table.in different
ways, i.e. you can choose a table style, table design, draw borders. The steps to modify a table are given
below;

> Select the table
> Two new tabs Design and Layout appear on the Ribbon

> On Design tab you will see three groups of commands to modify table; Table Style Options, Table
Styles and Draw Borders;

Home

V. HeaderRow V' First Column

__________ . & shading ~ — Z f—
Total Row V! Last Column i R | T ¥ pt = _.j

Draw Eraser

¥ Banded Rows = Banded Columns ~ &2 Pen Color ~ Table
ITable Style Options I I Table Styles I I Draw Bordusl =

> Layout tab has six groups of commands to format table;

Home lInset  Pagelayost  References  Mailings  Review  View  Design ((loyout)

i3 Select ~ 2 4 # Insert Betow | 4 Merge Cenis | 3] 027" = aﬂ ™M A= ] Al <3 Repeat Header Rows

14l View Gridunes : 1 Hinsert Lent 38 spmt Cenis 51 186° tH e — = Z =% Convert to Text
Delete | Insert 3 = Text Cell Sort

3 Properties v Above U InsertRight | 3 SpWtTable || [ AutoFit ~ = =l = pwection Margins Se Formuta

1.3.6 Spell Check
Q53. What is spell check in MS Word?

Ans :

Spell check is a software program that corrects spelling errorsin word processing, email and
online discussions. Spell check identifies and corrects misspelled words. ...In Microsoft Word, spell
check options, like spelling and grammar may be found under the ‘review’ tab and ‘proofing’ window.

{62 )
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Run the spelling and grammar checker
manually

To start a check of the spelling and grammar
in your file just press F7 or follow these steps:

1. Open most Office programs, click
the Review tab on the ribbon. In Access or
InfoPath you can skip this step. In Project
you’ll go to the Project tab.

2.  Click Spelling or Spelling & Grammar.

ABC
Thesaurus
Spelling &
Grammar [% Word Count
E Proofing
3. If the program finds spelling mistakes, a dialog

box appears with the first misspelled word
found by the spelling checker.

4.  After you decide how to resolve the
misspelling (ignoring it, adding it to the
program’s dictionary, or changing it), the
program moves to the next misspelled word.

1.3.7 Language settings and Thesaurus

Q54. How to change the Language settings.
Ans :
Changing the Default language

If you would like to check the spelling and
grammar of your file in a language other than
English, follow these steps:

1. Login to one of the workstations with your
UTORId and password.

2. Under the Start menu, scroll up to Micro-
soft Office icon and click on Microsoft
Word.

The program will now open on the desktop.

Click on the Review tab.

5. Under Language, click on Set Proofing

Language.
ABC
« Thesaurus
Spelling &
Grammar Word Count
Proofing

6. A window will appear on the screen
labelled Language. Highlight your preferred
language by clicking on it, as shown below.

Language

Mark selected text as:

Filipino -
Finnish

French (Belgium) D
French (Cameroon)

French (Congo (DRC))
French (Cote d'Ivoire)
French (France) -

The speller and other proofing tools automatically use
dictionaries of the selected language, if available.

[] Do not check spelling or grammar
[¥] Detect language automatically

[setpspetait] [ o

7. Click OK.
1.3.8 Printing of a Documents
Q55. Explain the steps to print a document.

AnS :

How to print a document

To print a document, your computer needs
to be connected to a printer. Being able to print is
not necessary in order to use Word, but if you want
to send a letter in the post or print out a poster,
you’ll need to have access to a printer.

You’ll need

J [ conce

» A computer with Microsoft Word installed

> A printer set up and connected to your
computer (wireless or connected by cable)

'| 63 I|
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Follow these step-by-step instructions to print a document from Microsoft Office 365.
Step 1

Open an existing Microsoft Word document or start a new document, if you have Windows 10 you
can use Cortana to search for it. Before you print, type your text in the blank document or insert an
image.
Step 2

When you are ready, click on File in the top left-hand corner of your document. Then, click on
Print.

Alternatively, some older versions of Word may have an Office button instead of a ‘File’ button —it’s
a round Office icon in the top left-hand corner of the screen, click on this if you have one.

: \9 - Damfﬁ\) s Document2

Home Insert Page Layout References
@ % || calibri Boay) -[u S
Paste

B I U-aex x |2 [ EES

NZ-A-afan] | (@&

Clipboard = Font ] Paragr:

Step 3
For Office 365, click on File then Print in the menu, this will bring up the ‘Print’ dialogue box.

Choose how many copies of your document you need and click on the printer you wish to use. You
will have to have your printer already installed on your computer.

[ 64 }
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Print

1

Copies: 1
Print

Printer
Foxit PhantomPDF Printer

a Ready

Printer Properties

Settings
Print All Pages
The whole thing
Pages:
Print One Sided
Only print on one side of the page
Collated
L B B L R b &

Portrait Onentation ~

LSl
21 cmx 29.7 cm
Normal Margins

Left 254cm Right 254 cm

1 Page Per Sheet -

[ V.

Step 5

Depending on your printer options, you can choose other printing features such as whether you
want to printall pages or only certain pages. You can also change the orientation of the print from portrait
to landscape and tell your computer and printer whether you’re printing on a certain size of paper. You’ll
also see, on the right, a preview of your printed document will look like.

Step 6

When you’re happy with your settings, click Print. The document will now start printing on your
printer.

Print
é Copies: 1

O

Print

g
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Advanced options

Print
[g] Copies: B

Print
Printer E
Foxit PhantomPDF Printer .
a Ready
Printer P i

To print in black and white, select Printer Properties in the Print menu, then click on the drop down
and select Black & White.

Default Settings: [Standard v]  Edt..

Color: Color s

Gray
Color

If you want to print your document on one side of the page, make sure you select this in the Print
menu.

Image Resolution:

Settings

Print All Pages .
The whole thing

Pages: ®

Manually Print on Both Sides

Reload paper when prompted to print the second side

|
|
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‘ Short Question and Answers I

1. Define computer.

AnS :

Introduction

The word compute is derived from the
Latin word ‘computare’, was meaning “arithmetic,
accounting”.

The Computer meaning is the digital device
that stores information in memory using input
devices and manipulate information to produce
output according to given instructions.

The actual machinery, the physical parts of a
computer system refer to as Computer hardware;
the instruction (a program) that tells the computer
what to do or how to do, that is called Computer
software (often called just software).

Definition

According to Professor Charles
Babbage’s analytical engine considered as
“fundamental framework of computer” is a
mechanical general-purpose programmable
computing engine. It was a successor to the
Difference Engine.

Computer that we use today is absolutely
different from the first generation computer.
Evolution in technology from 19" century to present
day modified computer totally.

COMPUTER stands for Common
Operating Machine Particularly Used For Trade
Education And Research.

C - Common

O - Operating
M - Machine
P - Particularly
U - Used For
T - Trade
E - Education
R - Research.
2. Define CPU.

AnS :

CPU (Central Processing Unit)

CPU is considered as the brain of the
computer. CPU performs all types of data processing

operations. It stores data, intermediate results, and
instructions (program). It controls the operation of
all parts of the computer.

CPU itself has the following three components:
»  ALU (Arithmetic Logic Unit)
»  Memory Unit
»  Control Unit
3. Explain about VDU.

AnS :

A video display unit (VDU) is a computer
peripheral device, like a TV set, that the computer
sends information to. The VDU displays this
information inthe form of text or graphics (pictures)
on a cathode ray tube.

A VDU operates like a normal TV set except
the information is sent directly through a cable from
the computer. There are many different kinds of
VDUs and the choice of a VDU is determined by
selecting:

> whether it’s monochrome or colour
> the resolution

> the type of drive signal from the computer

4.  What is wireless keyboard ?

> Wireless keyboards are also available today,
but at a higher price than wired keyboard.

> These keyboards do not have any wire
attached to them.

> Wireless keyboard interacts with the
computer through Bluetooth or Infrared
technology.

> Wireless keyboards transfer typing data to the
computer via infrared beams. A beam of
information is sent from the keyboard, as you
type, to a receiver, which is plugged into the
computer.

(67 )
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> Wireless keyboard operates on battery power
rather than using electricity from the user’s
computer.

> The main advantage of using a wireless
keyboard rather than a regular keyboard is
that it offers much more mobility. A wireless
keyboard can be used on a lap, in a bed, or
just used while on-the-go for laptop users.

> It can maintain required distance between the
screen and the seating and also do not need
to keep it placed on the working table always
saving a lot of space when not using the
system.

> One of the disadvantages of using a wireless
keyboard is that it has to be installed and
configured before it can be used. Regular
keyboards, on the other hand, run on Plug
and Play software and work immediately after
they are plugged in.

5.  Write any two charecteristics of impact
printers.

AnS :

Impact Printers

Impact printers print the characters by striking
them on the ribbon, which is then pressed on the

paper.

Characteristics of Impact Printers are the
following:

> Very low consumable costs

»  Very noisy

> Useful for bulk printing due to low cost
>

There is physical contact with the paper to
produce an image

These printers are of two types:
> Character printers

> Line printers

6. Write any two charecteristics of Non-
impact printers.

AnS :

Non-impact Printers

Non-impact printers print the characters
without using the ribbon. These printers print a

Rahul Publications

|l 68 ',

complete page at a time, thus they are also called
as Page Printers.

These printers are of two types:
(a) Laser Printers
(b) Inkjet Printers
Characteristics of Non-impact Printers
> Faster than impact printers
> They are not noisy
> High quality
> Supports many fonts and different character
size
7. What is the use of cache?

AnS :

Cache Memory

Cache memory is.a very high speed
semiconductor memory which can speed up the
CPU. It acts as a buffer between the CPU and the
main memory. It is used to hold those parts of data

| and program which are most frequently used by

the CPU. The parts of data and programs are
transferred from the disk to cache memory by the
operating system, from where the CPU can access
them.

Fig.: Cache Memory

Advantages

The advantages of cache memory are as
follows:

> Cache memory is faster than main memory.
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> It consumes less access time as compared to
main memory.

> It stores the program that can be executed
within a short period of time.

> It stores data for temporary use.
Disadvantages

The disadvantages of cache memory are as
follows:

»  Cache memory has limited capacity.
» ltisvery expensive.

8. Discuss about RAM.

Ans :

RAM (Random Access Memory) is the internal
memory of the CPU for storing data, program, and
program result. It is a read/write memory which
stores data until the machine is working. As soon as
the machine is switched off, data is erased.

Access time in RAM is independent of the
address, that is, each storage location inside the
memory is as easy to reach as other locations and
takes the same amount of time. Data in the RAM
can be accessed randomly but it is very expensive.

RAM is volatile, i.e. data stored in it is lost
when we switch off the computer or if there is a
power failure. Hence, a backup Uninterruptible
Power System (UPS) is often used with computers.
RAM is small, both in terms of its physical size and
in the amount of data it can hold.

RAM is of two types:
i)  Static RAM (SRAM)
ii) Dynamic RAM (DRAM)

9. Define EEP ROM.
AnS :

EEPROM (Electrically Erasable and Program-
mable Read Only Memory)

EEPROM is programmed and erased
electrically. It can be erased and reprogrammed
about ten thousand times. Both erasing and
programming take about 4 to 10 ms (millisecond).
In EEPROM, any location can be selectively erased
and programmed. EEPROMs can be erased one
byte at a time, rather than erasing the entire chip.
Hence, the process of reprogramming is flexible but
slow.

10. What are the advantages of ROM?
Ans :
Advantages of ROM

The advantages of ROM are as follows:
Non-volatile in nature

Cannot be accidentally changed
Cheaper than RAMs

Easy to test

More reliable than RAMs

Static and do not require refreshing

YV V. V V Y.V V

Contents are always known and can be
verified

11. What is data? How it is differ from
information ?

AnS :

Data can be defined as a representation of
facts, concepts, or instructions in a formalized
manner, which should be suitable for communi-
cation, interpretation, or processing by human or
electronic machine.

Data is represented with the help of characters
such as alphabets (A-Z, a-z), digits (0-9) or special
characters (+,-,/,*,<,>,= etc.)

Information is organized or classified data,
which has some meaningful values for the receiver.
Information is the processed data on which decisions
and actions are based.
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12. Discuss the major applications of IECT.
Ans :

IECT stands for Information Electronics and
Communication Technology. The applications of
IECT are as follows:

»  E-governance

»  Multimedia and Entertainment
1. E-governance

Electronic governance is application of
Information Electronics and Communication
Technology in running an effective governance
system for people. Communication refers to sharing
of information between parties like common
people, government, business, etc. Almost every
government sector has changed to IECT like rail
reservation system, gas subsidy disbursal, etc.

The primary delivery modals of e-
Government can be divided into:

(@ Government-to-Business/ Consumer

(G20C)

G2C model applies the strategy of customer
Relationship Management (CRM) with business
concept. By managing their relationship with citizen,
government can provide the needed products and
services fulfill the needs from customer/citizen.

(b) Government-to-Business

(G2B) is the online non-commercial
interaction between Government and people to
provide business information and also advice about
e-business.

(c) Government-to-Government

(G2G) is the online non-commercial
interaction between Government Departments /
Authorities and other Government / Departments.
(d) Government-to-Employees (G2E)

This is the best and effective way of online
interactions between government and employees.
2. Multimedia and Entertainment

Multimedia refers to combination of text,
audio, video, graphics, animation, etc. It is one of
applications of IECT. Multimedia is used to improve
quality of presentation by incorporating information
sharing, usage of graphics and animation, motion
capture, etc.
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13. Whatis Operating System? What are the
functions of OS ?
Ans :

Personal computer has advanced a lot in a
short period of time, and much of the advancement
is due to ongoing progresses in operating systems.
Evolution of operating systems had made PCs easier
to use and understand, flexible and reliable. This
chapter is the study of primary operating systems
currently used in personal computers and network
servers, and their basic features.

Operating System

Operating system is a software that controls
system’s hardware and interacts with user and
application software.

In short, an operating system is-computer’s
chief control program.

Functions of Operating System

The operating system performs the following
functions:
> It offers a-user interface.
> Loads program into computer’s memory.
> Coordinates how program works with

hardware and other software.
> Manages how information is stored and
retrieved from the disk.

Saves contents of file on to disk.

Reads contents of file from disk to memory.

Sends document to the printer and activates

the printer.

> Provides resources that copy or move data
from one document to another, or from one
program to another.

> Allocates RAM among the running programs.

> Recognizes keystrokes or mouse clicks and
displayes characters or graphics on the screen.

14. What is user interface?

AnS :

A user interface, also called a “Ul” or simply
an “interface,” is the means in which a person
controls a software application or hardware
device. A good user interface provides a “user-
friendly” experience, allowing the user to interact
with the software or hardware in a natural and
intuitive way.

Nearly all software programs have a graphical
user interface, or GUI. This means the program
includes graphical controls, which the user can select
using a mouse or keyboard. A typical GUI of a

YV VV
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software program includes a menu bar, toolbar, windows, buttons, and other controls. The Macintosh
and Windows operating systems have different user interfaces, but they share many of the same elements,
such as a desktop, windows, icons, etc. These common elements make it possible for people to use
either operating system without having to completely relearn the interface. Similarly, programs like word
processors and Web browsers all have rather similar interfaces, providing a consistent user experience
across multiple programs.

15. Define Desktop?
Ans :

The desktop is the primary user interface of a computer. When you boot up your computer, the
desktop is displayed once the startup process is complete. It includes the desktop background (or wallpaper)
and icons of files and folders you may have saved to the desktop. In Windows, the desktop includes
a task bar, which is located at the bottom of the screen by default. In Mac OS X, the desktop includes
a menu bar at the top of the screen and the Dock at the bottom.

The desktop is visible on both Windows and Macintosh computers as long as
an application or window is not filling up the entire screen. You can drag items to and from the desktop,
just like a folder. Since the desktop is always present, items on the desktop can be accessed quickly, rather
than requiring you to navigate through several directories. Therefore, it may be helpful to store commonly
used files, folders, and application shortcuts on your desktop.

16. Write the steps for renaming a file (or) folder.
Ans :

Rename a File or Folder

> In the desktop, click or tapthe ‘File Explorer button on the taskbar.
> Select the file or folder you want to rename.
> Click or tap the Rename button on the Home tab.

Library Tools
re View Manage ~ @

‘% D éz:y E k ‘. x @ 'L:ll.ll [ New item ~ :on::nv BH select an

£ Easy access ~ 55 Select none
Copy Paste Move Copy Delete Rename Properties ,
[2] Paste fhortcut tor to~ - Tolder - (& History 55 Invert selection

Clipboard Organize eu Open Select

®© ~ 1 [3 »|Libraries » Documents » v| & | | Search Documen ts o

X Favorites

[3) pocuments _ Home Sense [New folder]
& Music

[&5) Pictures
B videos

«& Homegroup
& Computer

€ Network

3 items 1 item selected Library includes: 2 locations

g
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> With the name selected, type a new name,
or click or tap to position the insertion point,
and then edit the name.

> Press Enter or tap in a blank area.

17. What are the uses of word processing?
Ans :

Word processing software is used to
manipulate a text document, such as a resume or a
report. You typically enter text by typing, and the
software provides tools for copying, deleting and
various types of formatting. Some of the functions
of word processing software include:
> Creating, editing, saving and printing

documents.

> Copying, pasting, moving and deleting text
within a document.

> Formatting text, such as font type, bolding,
underlining or italicizing.

> Creating and editing tables.

> Inserting elements from other software, such
as illustrations or photographs.

> Correcting spelling and grammar.

18. Write steps to save adocument.
Ans :
To save a document

1. Open the File menu and click Save. The
Save As dialog box appears.

2. In the File name box, enter a desired
name for the document.

3. To save the document in a folder or a drive
other than the default, click the drop-down
arrow in the Save in box, and then choose
the desired folder or drive.

4, To save the documentina new folder within
the current drive, click the Create New
Folder button on the toolbar within
the Save As dialog box, directly below the
title bar of the Save As dialog box.

5. Click Save.
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19. How to Copy and Paste Text in MS Word

Word offers different methods to copy and
paste text. Some of the popular methods are given
below;

Method 1
> Select the text you want to copy

> Select the Home tab and click the Copy
command

> Place the cursor where you want to paste the
text

> Click the Paste command in Home tab
Method 2
> Select the text

> Place the cursor over the text and right click
the mouse

» © Amenu will appear; with a left click select the
“Copy” option

| > Now, move the cursor to a desired location

and right click the mouse

» A menu will appear; with a left click select the
‘Paste” option.
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‘ Choose the Currect Answers I

1.  Which of the following are components of Central Processing Unit (CPU) ? [b]
(&) Arithmetic logic unit, Mouse
(b) Arithmetic logic unit, Control unit
(c) Arithmetic logic unit, Integrated Circuits
(d) Control Unit, Monitor

2. Where is RAM located ? [c]
(2) Expansion Board (b) External Drive
(c) Mother Board (d) All of above

3. If a computer has more than one processor then it is known as ? [b]
(a) Uniprocess (b) Multiprocessor
(c) Multithreaded (d) Multiprogramming

4. The —__________ penisasmallinput device used to select and display objects on a screen. [c ]
(@) Ink (b) Magnetic
(c) Light (d) None of the above

5. Which device of computer operation dispenses with the use of the keyboard? [c]
(a) Joystick (b) Light pen
(c) Mouse (d) Touch

6. In computer, GUI stands for [a]
(&) Graphical user interface (b) General user interrupt
(c) Graphs, utilities, icons (d) Grayed user interface

7.  Work area on which computer windows, icons, menus and dialog box appear is called [b]
(&) Screen (b) Desktop
(c) Working area (d) Frame

8. Element which contains computer administrative tools is called [a]
() Control panel (b) Start button
(c) Internet explorer (d) Recycle bin
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9. Computer menu is a collection of [a]
() Commands (b) Orders
(c) Instructions (d) Icons

10. Computer files can exist in folders but folders cannot exist in a [b]
(&) Paths (b) Files
(c) Folders (d) Documents
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‘ Fill in the blanks I

1. Tocreatealetter —__________ option is used after clicking on create button.
2. Pictures can be inserted using —_______ control in Access
3. Superscript and subscript facility is available in __________ tab of Format cells
4. Paper size facility is available in page setup optionin ____menu
5. Page setup can be done using in menu
6. and are the two orientations that can be fixed in page set up
7.  Afile created using Word issaved —_________ facility in file menu
8. Is known as a main memory.
9. memory is faster than main memory.
10. Picture and sound together is an example for
ANSWERS

1. Form letters

2. Image

3. Font

4. File

5. Page setup, file

6. Portrait, Landscape

7. Save

8. RAM

9. Cache memory

10. Output device

()
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I 2.1 USING SPREAD SHEET

2.1.1 Basics of Spreadsheet

Q1. Define spread sheet and list out the
features of spreadsheet?

AnS :

A spreadsheet is a large sheet having data and
information arranged in rows and columns. As you
know, Excel is one of the most widely used
spreadsheet applications. It is a part_of Microsoft
Office suite. Spreadsheet is quite useful in entering,
editing, analysing and storing data. Arithmatic
operations with numerical-data such as addition,
subtraction, multiplication and division can be done
using Excel. You can sort numbers/ characters
according to some given criteria (like ascending,
descending etc.) and use simple financial,
mathematical and statistical formulas.

Features of Spreadsheets

There are a number of features that are
available in Excel to make your task easier. Some
of the main features are:

1. AutoSum: Helps you to add the contents of
a cluster of adjacent cells.

2. List AutoFill: Automatically extends cell
formatting when a new item is added to the
end of a list.

3.  AutoFill: Allows you to quickly fill cells with
repetitive or sequential data such as
chronological dates or numbers, and
repeated text. AutoFill can also be used to
copy functions. You can also alter text and
numbers with this feature.
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4.  AutoShapes: Toolbar will allow you to draw
a number of geometrical shapes, arrows,
flowchart elements, stars.and more. With
these shapes you can draw your own graphs.
5.  Wizard: Guidesyou to work effectively while

you work-by displaying various helpful tips

and techniques based on what you are doing.

6. Drag and Drop: It will help you to reposition
the data and text by simply dragging the data
with the help of mouse.

7.  Charts: It will help you in presenting a
graphical representation of your data in the
form of Pie, Bar, Line charts and more.

8.  PivotTable: It flips and sums data in seconds
and allows you to perform data analysis and
generating reports like periodic financial
statements, statistical reports, etc. You can also
analyse complex data relationships
graphically.

9.  Shortcut Menus: The commands that are

appropriate to the task that you are doing

will appear by clicking the right mouse button

What are the Features of Microsoft

Excel.

Ans :

Features of Microsoft Excel

1. Add Header and Footer
MS Excel allows us to keep the header and
footer in our spreadsheet document.

2. Find and Replace Command
MS Excel allows us to find the needed data
(text and numbers) in the workbook and also
replace the existing data with a new one.

Q2.
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Password Protection

It allows the user to protect their workbooks
by using a password from unauthorized
access to their information.

Data Filtering

Filtering is a quick and easy way to find and
work with a subset of data in a range. A filtered
range displays only the rows that meet the
criteria you specify for a column. MS Excel
provides two commands for filtering ranges:

»  AutoFilter, which includes filter by
selection, for simple criteria

» Advanced Filter, for more complex
criteria

Data Sorting

Data sorting is the process of arranging data
in some logical order. MS Excel allows us to
sort data either in ascending or descending
order.

Built-in formulae

MS Excel has got many built-in formulae for
sum, average, minimum, etc. We can use
those formulae as per our needs.

Create different charts (Pivot Table
Report)

MS Excel allows us to create different charts
such as bar graph, pie- charts, line graphs,
etc. This helps us to analyze and compare
data very easily.

Automatically edits the result

MS Excel automatically edits the result if any
changes are made in any of the cells.

Formula Auditing

Using formula auditing we can graphically
display or trace the relationships between cells
and formulas with blue arrows. We can trace
the precedents (the cells that provide data to
a specific cell) or the dependents (the cells
that depend on the value in a specific cell).

Q3. Explain the Basics of Excel ?
Ans :

Following are the Basic Elements of Excel

1.

10.

Ribbon

The tabs on the ribbon are: File, Home, Insert,
Page layout, Formulas, Data, Review and
View. Excel selects the ribbon’s Home tab
when you open a workbook.

Workbook

A workbook is another word for your Excel
file. When you start Excel, click Blank
workbook to create an Excel workbook from
scratch.

Worksheets

A worksheet is a collection of cells where you
keep and manipulate the data. Each Excel
workbook can contain. multiple worksheets.
Format Cells

When we format cells in Excel, we change
the appearance of a number without
changing the number itself.

Find & Select

Learn how to use Excel’s Find, Replace and
Go To Special feature.

Templates

Instead of creating an Excel workbook from
scratch, you can create a workbook based
on a template. There are many free templates
available, waiting to be used.

Data Validation

Use data validation in Excel to make sure that
users enter certain values into a cell.
Keyboard Shortcuts

Keyboard shortcuts allow you to do things
with your keyboard instead of your mouse
to increase your speed.

Print

This chapter teaches you how to print a
worksheet and how to change some
important print settings in Excel.

Share

Learn how to share Excel data with Word
documents and other files.

Protect

Encrypt an Excel file with a password so that
it requires a password to open it.

(77 )

Rahul Publications



B.Com.

| YEAR 1l SEMESTER

Q4. How can we create, Rename, Delete, move a worksheet ?

Ans :

A worksheet is a collection of cells where you keep and manipulate the data. Each Excel workbook

can contain multiple worksheets.

a) Creating New Worksheet

Three new blank sheets always open when you start Microsoft Excel. Below steps explain you how
to create a new worksheet if you want to start another new worksheet while you are working on a
worksheet, or you closed an already opened worksheet and want to start a new worksheet.

Step 1: Right Click the Sheet Name and select Insert option.

-
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! Hom nse

B& Cairi T v oyl Genem - A mtﬁ-
= a B Z U- A EFEWE- $-% Sutes | Cots @8- A~
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Clipboard Alignme nt fv | Number 1 Editing
Al - (= Se v
TP o s TR W SN0 - 1 S N [V 700 N il () ~
1
2
3
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"
6
7 n
.‘
9 |
w‘
1
12
“6‘" Right Click on Sheet Name
14 Click on Insert option to add new
5 =1
a2l - L | A
RO .,.k i _Chaat? 93 T« ] (A0
PP O] [—— Insert... T T
UH Relete
Rename
Move or Copy...
@ View Code
&)y Protect Sheet...
Iab Color ’
Hide
Unhide
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Step 2
Now you’ll see the Insert dialog with select Worksheet option as selected from the general tab.
Click the Ok button.
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You can use a short cut to create a blank sheet anytime. Try using the Shift+F11 keys and you
will see a new blank sheet similar to the above sheet is opened.
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b. Select a Worksheet

When you open an Excel workbook, Excel automatically selects Sheetl for you. The name of
the worksheet appears on its sheet tab at the bottom of the document window.

Ready 83 | B M - ] + 100%

C. Insert a Worksheet

You can insert as many worksheets as you want. To quickly insert a new worksheet, click the plus
sign at the bottom of the document window.

38
39
40
« Sheet1 %
Ready
Result

d. Rename a Worksheet
To give a worksheet a more specific name, execute the following steps.
1. Right click on the sheet tab of Sheet1.
2. Choose Rename.

{80 |
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Insert...

2

i * X Delete
33 . Move or Copy... |

34 Q] View Code

35 |7 Protect Sheet...
%:— Tab Color >
38 Hide

E Unhide... ‘
40

Select All Sheets
< > Sheetl | sneew | (")

3. For example, type Sales 2016.

3|
40

« Sales 2016 | Sheet2 | (@

e. Move a Worksheet

To move a worksheet, click on the sheet tab of the worksheet you want to move and drag it into the
new paosition.

1. For example, click on the sheet tab of Sheet2 and drag it before Sales 2016.

sl
=
40 v N

« | sales 236 | Sheet2 ®

Result

2

24

40

« Sheet2 | sSales2016 | @

(a1 )
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f. Delete a Worksheet
To delete a worksheet, right click on a sheet tab and choose Delete.

1. For example, delete Sheet2.

Unhide...

29 | Insert...
30
31 _
32 Bename
33 Move or Copy...
=zl &1 View Code
% [H7l Protect Sheet...
‘37 Jab Color »
38 Hide
39
e

Select All Sheets

“« > I Sh 1 |

Result

INEE

« Sales 2016 ®

g. Copy a Worksheet

Imagine, you have got the sales for 2016 ready and want to create the exact same sheet for 2017,
but with different data. You can recreate the worksheet, but this is time-consuming. It’s a lot easier to copy
the entire worksheet and only change the numbers.

1. Right click on the sheet tab of Sales 2016.
2. Choose Move or Copy.

= ER Delete
— Rename

e

ER Protect Sheet...
= Tab Color »
1.‘ Hide
Unhide...

0 Select All Sheets
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The ‘Move or Copy’ dialog box appears.

3. Select (move to end) and check Create a copy.

Move or Copy X
Move selected sheets
To book:
Book1 v
Before sheet:
Sales 2016 A
move to end
v
@f;}'&?&“ﬁ@
oK Cancel
4, Click OK
Result
38
39
40
« Sales 2016 | Sales 2016 (2) ®
Note

You can even copy a worksheet to another Excel workbook by selecting the specific workbook

from the drop-down list (see the dialog box shown earlier).

2.1.2 Manipulation of Cells

Q5. How can we manipulate Rows, Columns, and cells in a work sheet ?

AnS :

a. Manipulating rows and columns

There are many things you can do to manipulate a row or column; but before you can do to, you

must select it.

To select a single row or column, click the label of that row or column at the left or top of the screen:

'| 83 I|
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H - rows-columns-and-cells - Excel ) X
File Home | Insert | Page Layout | Formulas Sign in Q_‘%'mrf
B i B v pgl B 8  [FDataAnaysis
Lii] ”T% =
Get External New Refresh ~~ Sort& Data Forecast Outline
Data ~ Query ~ (& All* o Filter~ Tools~  ~ -
Get & Transform Connections Analysis -~
C1 v b v
4 A | B HEEEEN DO | E O G| R [ 5] + |
leL 1
lic3! |
3 1
I3 |
s !
6 {
4l
e | ~
| g | & i e
Sheet! | Sheet2 | Sheet3 | @ (<] ]
Ready B M -—F + 100%

To select multiple rows or columns, click the label of one row or column and keep the mouse button

held down, then drag over to select multiple:

nsert | Page Layout | Formulas

DEEN Review | View

B | o8

B (A5 T2l
cr—, £ ol :
GetExternal New —  Refresh E Sort& Data Forecast Outline
Data~ | Query~L®  Al- [ Filters Tools~  ~ .
Get & Transform Connections Analysis -~
| Cl Vy
A 6 | H |
4 » ] E]L
'Ready -+ 100%
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To select all rows and all columns in a worksheet, click the small box that appears at the intersection

of row 1 and column A:

H

Get & Transform ' Connections

Ty @ ([v]|[n]| (=] || a]|Boes

!& i
Get External New @ Refresh Sort& Data Forecast Outline
Data> | Query=[® = A+ [ Filters Tools~ = -

Sign in

lysis

Analysis

Sheet2 | Sheet3 |

®

i [d]

“--[ﬁl -+ 100%

Once you have rows or columns selected, right click their labels to bring up the row / column

manipulation menu, which appears in the screenshot below.

2] | 5|3 |Lv] )=«
Get External New Refresh Sort& Data Forecast Outli
Dota~ | Query~[®  An~ [ Filter~ Tooks~ - -
Get & Transform ' Connections Analysis A
H.v.i_'.—l_ S L,lL

]

Clear Contents !
[ Eormat Cells... 1
Row Height... ’
Hide -
Unhide Sheet2 | sheets | @ : [¢] O
Ready - m -+ 100%
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This menu has a variety of functions, and will allow you to do any of the following:

Cut /copy / paste rows or columns: Use this if you would like to duplicate rows or columns, or if
you would like to rearrange their order.

Insert new rows or columns: This will insert new rows above - or new columns to the left of - the
row or column you have selected.

Delete rows or columns: This will delete the rows or columns in question entirely and collapse
the remainder of the sheet in to take the place of the removed row or column.

Format rows or columns: Use this option to apply formatting to each cell within a row or column.
Potential formatting options include text colors, background colors, and borders.

Hide and unhide rows or columns: Use this option to temporarily hide or unhide rows or
columns. This makes it easier to manage large spreadsheets by hiding non-critical data.

You can also resize a row or column by hovering your mouse over the divider between two rows or

two columns, then clicking and dragging to expand or contract it.

Manipulating cells

Cells can be manipulated just like rows and columns. To do so, select a.cell orrange, then-right click.

The cell manipulation menu will appear.

% Cut
B Copy
File iome | Insert | Page Lay« e ’ '.[3 Paste
o) |3 2 e
Get External ~ New Refresh Paste Special...
Data*  Quey-(®  an- & Fir -
Get & Transform  Connections e nalysis P
Delete... i
09 v [Ns 2 . & | Clear Coptents | b
4 A | 8 | ¢ |E 2 H I [«]
1] Filter »
2 | Sort »
3
r 2 Insert Comment
5— ] Eormat Cells...
6 | Pick From Drop-down List...
7~ Define Name...
2 & Hyperink
9] (==
10
": Calibri -]H AA S % B
12 BIEZO-A-B-48¢
13 . : . : |
4 | |
15|
16
17 -
« » Sheet! | Sheet2 | Sheet3 .. @ : [¢] o
Ready ‘B m - i + 100%

(86 )

Rahul Publications —



UNIT - 1l BASIC COMPUTER SKILLS

This menu allows you to:
> Cut / copy / paste cells: Use this to duplicate cells from one place in your worksheet to another.

> Insert new cells. Note that when you insert a cell, you’ll have to tell Excel how to do it (you must
either shift rows or columns in the existing sheet to accomodate the new cell).

> Delete cells. Like insertion, deletion also causes a shift in your sheet. Excel will ask you where you
want cells to shift when you delete a cell.

> Format cells. Use this option to apply formatting to each cell. Potential formatting options include
text colors, background colors, and borders.

2.1.3 Formulas and Functions

Q6. What is the need of Formula in work sheet ?
Ans :

Formulas in MS Excel

Formulas are the Bread and butter of worksheet. Without formula, worksheet will be just simple
tabular representation of data. A formula consists of special code, which is entered into a cell. It performs
some calculations and returns a result, which is displayed in the cell.

Formulas use a variety of operators and worksheet functions-to work with values and text. The
values and text used in formulas can be located in other cells, which makes changing data easy and gives
worksheets their dynamic nature. For example, you can quickly change the data in a worksheet and
formulas works.

Elements of Formulas
A formula can consist of any of these elements:
> Mathematical operators, such as +(for addition) and *(for multiplication)
Example
P = A1+A2 Adds the values in cells A1 and A2.
> Values or text
Example

P = 200*0.5 Multiplies 200 times 0.15. This formula uses only values, and it always returns
the same result as 100.

> Cell references (including named cells and ranges)
Example

P = A1=C12 Compares cell A1 with cell C12. If the cells are identical, the formula returns
TRUE; otherwise, it returns FALSE.

> Worksheet functions (such as SUMor AVERAGE)
Example
P = SUM(A1:A12) Adds the values in the range A1:A12.
Creating Formula

For creating a formula you need to type in the Formula Bar. Formula begins with ‘=" sign. When
building formulas manually, you can either type in the cell addresses or you can point to them in the
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worksheet. Using the Pointing method to supply the cell addresses for formulas is often easier and
more powerful method of formula building. When you are using built-in functions, you click the cell or
drag through the cell range that you want to use when defining the function’s arguments in the Function
Arguments dialog box. See the below screen shot.

o=e et Page Layout Formutyy Dats Review View Developer

-'j A Condr 11+ W iS5 Geen - FlCenstorsiFomutting* vt K- 9r ﬁ
'.;“ D B I 0 Ax EERG $-% » Bromatsstade~ J* Oetete + 3 Sk ps

> B 194 EE »- Y ¥~ | J-'cusmu Blromats Q- faer Seleat-
Chpboard ', fort Angrument . Poumber Styles Cein taeng

€ - (= I- s v

4] A 3 » I ) ‘j
1

- Sehery Cotowieter Formula Bar to write formula

3 No. Name Salary Amount Tax
4| 1 Mare 2000
s 2 Stave $0000 20%
3

7
s
“ Result cell where formulais written 4
10
1
12
13
"
15
16
17
18
” -
M40 M| Sheet] Shastd Said % 4 30
M,Q| .Jng_.g 100% (=) L (*

As soon as you complete a formula entry, Excel calculates the result, which is then displayed inside
the cell within the worksheet (the contents of the formula, however, continue to be visible on the Formula
bar anytime the cell is active). If you make an error in the formula that prevents Excel from being able to
calculate the formula at all, Excel displays an Alert dialog box suggesting how to fix the problem.

Copying Formulas in MS Excel

Copying formulas is one of the most common tasks that you do in a typical spreadsheet that relies
primarily on formulas. When a formula uses cell references rather than constant values, Excel makes the
task of copying an original formula to every place that requires a similar formula.

Relative Cell Addresses

MS Excel does it automatically adjusting the cell references in the original formula to suit the position
of the copies that you make. It does this through a system known as relative cell addresses, where
by the column references in the cell address in the formula change to suit their new column position and
the row references change to suit their new row position.

Let us see this with the help of example. Suppose we want the sum of all the rows at last, then we
will write a formula for first column i.e. B. We want sum of the rows from 3 to 8 in the 9" row.
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After writing formula in the 9" row, we can drag it to remaining columns
copied. After dragging we can see the formula in the remaining columns as below.

> column C : =SUM(C3:C8)
> column D : =SUM(D3:D8)
> column E : =SUM(E3:ES)
> column F : =SUM(F3:F8)
> column G : =SUM(G3:G8)

and the formula gets

- wemple workbookudux + Mscrosoht Dacel
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Q7. What is cell reference ? Explain the types of cell references ?

AnS :

Cell References in Formulas

Most formulas you create include references to cells or ranges. These references enable your formulas
to work dynamically with the data contained in those cells or ranges. For example, if your formula refers
to cell C2 and you change the value contained in C2, the formula result reflects new value automatically.
If you didn’'t use references in your formulas, you would need to edit the formulas themselves in order to
change the values used in the formulas.

When you use a cell (or range) reference in a formula, you can use three types of references -
relative, absolute, and mixed references.

a. Relative Cell References

The row and column references can change when you copy the formula to another cell because
the references are actually offsets from the current row and column. By default, Excel creates relative cell
references in formulas.

I LD T tample workDook 1t + W rosof Lacel = e |
resme et Page Layout formudan [ Peview Yiew Cevelopes =) o o @0
A Coan it c W oy B Cenean - o s Lo
La B2 U AL EBRE- 8% » “?ﬂ 5 Octete + 3+ 2‘4{"?‘&‘
y BH- 8-A- rE . a2 *  Eltesmstc 2 pmers setea
Chpbowa . Fort o ALgrment A NumDat » Cemn (otng
(3] - S sSUM(BLES) v
- — r v
1 ) K ﬁj
1
[ 2
3
4
3
6
7
8
?
Ko
11
12 Formula using relative references
13
11
15 Resultcell
H
17
18
19
20 .
4 N Sheat!  Sheet? Sheet: 9 B : 32
Resoy | 2D | el s (- L )

b. Absolute Cell References

The row and column references do not change when you copy the formula because the reference
is to an actual cell address. An absolute reference uses two dollar signs in its address: one for the column
letter and one for the row number (for example, $A$5).
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o

C. Mixed Cell References

Both the row or column reference is relative and the other is absolute. Only one of the address
parts is absolute (for example, $A5 or A$5).

D9 - sample workbookaxlsx - Microsoft Excel [E=mey—=
Home Insert Page Layout Formulas Dsta Review View Devetoper o @@=
‘3 & Calibri 11 v W gy e 5S¢ Genenst i | A S lnsent - E - 9' lﬁ
Poste | Bade s B L S Styles 2:0""'. a- Sor & Find &
e & HB-i-A- iEie 2 - I | = [Bdromatc 2 Fimer+ Setea+
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Formula with mixed reference (relative to columns
and absolute references to row 3)

16
17

18
| 19 7
| 20 -
M 4> M Sheetl Sheet2 | Sheetd %3 e ' » [
M|21 .|xm1r.lﬂ_l 100% (=) L) om

Q8. Explain about Built in functions in MS Excel.

Ans :

Functions in Formula

Many formulas you create use available worksheet functions. These functions enable you to greatly
enhance the power of your formulas and perform calculations that are difficult if you use only the operators.
For example, you can use the LOG or SIN function to calculate the Logarithm or Sin ratio. You can’t do
this complicated calculation by using the mathematical operators alone.
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Using Functions

When you type = sign and then type any alphabet you will see the searched functions as below.

= ‘
3 Typing M will show number of functions starting withMm
15
16 |
17 .
18 |
”) -
20 -
4 4 » W] Sheetl _ Sheet? | Sheet3 - %3 Bl = S0 [
-t .53 ). ] P=———r——0

Suppose you need to determine the largest value ina range. A formula can't tell you the answer
without using a function. We will use formula that uses the MAX function to return the largest value in the
range B3:B8 as =MAX(A1:D100).
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Another example of functions. Suppose you want to find if the cell of month is greater than 1900
then we can give Bonus to Sales representative. The we can achieve it with writing formula with IF
functionsas =IF(B9>1900,”Yes”,”N0”).

[ o = 0 0 samplewokbookads - Microsotbxcdl

n Home Insert Page Layout Formulas Data Review View Developer o 0 o &
= % Cambi -1 - -[: 5S¢ Genensl A g@insents X -~ é'r lﬁ
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ste i . < ont ind
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Chpboard Fomt Alignment Number Cells Ednting
B12 v (@ S| =IF(B9>1900,"Yes","No") i
A o s IS D E F G H I ) =
5 :
2 PartNo. Jan-13  Feb-13 Mar-13  Apr-1: 1: Sale
3 Part100 204 200 180 170 230 1229
4 Part101 248 300 280 220 210
5 ;mm 674 600 450 400 450
6 Part103 656 195 300 350 320
7 ;uﬂu 180 300 295 270 315
8 Part105 400 410
9 Total sale 2162° 1995 1915 1845 1926 1880
10 Maximum Sold Part 674 600 450 435 450 400 W
vt r r r r r
11 Minimum Sold Part ~ 180 195 180 170 210 200
Good/Bad es Yes No Yes No
m
3 |
[[ 4 « » ¥ Sheetl ~ Sheet2  Sheet3 72 [l = u |
[ B I (R ) 100% (=) 0 +

Function Arguments

In the above examples, you may have noticed that all the functions used parentheses. The information
inside the parentheses is the list of arguments.

Functions vary in how they use arguments. Depending on what it has to do, a function may use.
No arguments: Examples “ Now(), Date(), etc.

One argument: UPPER(), LOWER(), etc.

A fixed number of arguments: IF(), MAX(), MIN(), AVERGAGE(), etc.

Infinite number of arguments:

vV V V V V

Optional arguments:
Built In Functions

MS Excel has many built in functions, which we can use in our formula. To see all the functions by
category, choose Formulas Tab - Insert Function. Then Insert function Dialog appears from which
we can choose the function.
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Functions by Categories

Let us see some of the built in functions in MS Excel.

Text Functions

LOWER: Converts all characters in a supplied text string to lower case

UPPER: Converts all characters in a supplied text string to upper case

TRIM: Removes duplicate spaces, and spaces at the start and end of a text string
CONCATENATE: Joins together two or more text strings.

LEFT: Returns a specified number of characters from the start of a supplied text string.
MID: Returns a specified number of characters from the middle of a supplied text string
RIGHT: Returns a specified number of characters from the end of a supplied text string.
LEN: Returns the length of a supplied text string

FIND: Returns the position of a supplied character or text string from within a supplied text string
(case-sensitive).

Date & Time
DATE: Returns a date, from a user-supplied year, month and day.

TIME: Returns a time, from a user-supplied hour, minute and second.

l 94 ',
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iii)

DATEVALUE: Converts a text string showing
a date, to an integer that represents the date
in Excel’s date-time code.

TIMEVALUE: Converts a text string showing
a time, to a decimal that represents the time
in Excel.

NOW: Returns the current date & time.
TODAY: Returns today’s date.
Statistical

MAX: Returns the largest value from a list of
supplied numbers.

MIN: Returns the smallest value from a list
of supplied numbers.

AVERAGE: Returns the Average of a list of
supplied numbers.

COUNT: Returns the number of numerical
values in a supplied set of cells or values.

COUNTIF: Returns the number of cells (of
asupplied range), that satisfies a given criteria.

SUM: Returns the sum of a supplied list of
numbers

Logical
AND: Tests a number of user-defined
conditions and returns TRUE if ALL of the

conditions evaluate to TRUE, or FALSE
otherwise

OR: Tests'a number of user-defined conditions
and returns TRUE if ANY of the conditions
evaluate to TRUE, or FALSE otherwise.

NOT: Returns a logical value that is the
opposite of a user supplied logical value or
expression i.e. returns FALSE if the supplied
argument is TRUE and returns TRUE if the
supplied argument is FAL

Math & Trig

ABS: Returns the absolute value (i.e. the
modulus) of a supplied number.

SIGN: Returns the sign (+1, -1 or 0) of a
supplied number.

SQRT: Returns the positive square root of a
given number.

MOD: Returns the remainder from a division
between two supplied numbers.

2.1.4 Editing of Spread Sheet

Q9. How Can we edit an existing spread
sheet?

Ans :
Editing a Spreadsheet
The two ways to edit a spreadsheet are:

Edit the data itself, such as the labels, numbers,
and formulas that make up a spreadsheet.

Edit the physical layout of the spreadsheet,
such as adding or deleting rows and columns, or
widening or shrinking the width or heights of rows
and columns.

Editing Data in a Cell
To edit data in a single cell, follow these steps:

1. Double-click the cell that contains the data
you want to edit. Excel displays.a cursor in
your selected cell.

2. Edit your-data by using the Backspace or
Delete key, or by typing new data.

3. If you clicka cell, Excel displays the contents
of that cell in the Formula bar. You can click
and edit data directly in the Formula bar,
which can be more convenient for editing
large amounts of data.

Changing the size of rows and columns with
the mouse Using the mouse can be a quick way to
modify the sizes of rows and columns. To change
the height of a row or the width of a column, follow
these steps:

1. Move the mouse pointer over the bottom line
of a row heading, such as the 2 or 18
heading. (Or move the mouse pointer over
the right line of the column heading, such as
A or D.) The mouse pointer turns into a two-
way pointing arrow.

2. Hold down the left mouse button and drag
(move) the mouse. Excel resizes your row or
column.

3. Release the left mouse button when you are
happy with the size of your row or column.

Typing the size of rows and columns

If you need to resize a row or column to a
precise value, it is easier to type a specific value into
the Row Height or Column Width dialog box
instead. To type a value into a Row Height or
Column Width dialog box, follow these steps:

195 I
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1. Click the Home tab and then click the row or column heading that you want to resize. Excel
highlights your entire row or column.

2. Click the Format icon that appears in the Cells group. A pull-down menu appears and then click
Height (if you selected a row) or Width (if you selected a column). The Row Height or Column
Width dialog box appears.

ow Height TR

Row height: |20

oK cancel |

Enter a height for the row.
3. Type a value and then click OK. Excel resizes your row or column.

Excel measures column width in characters. (A cell defined as 1 character width-can display a
single letter or number.) Excel measures row height by points where 1 point equals /., inch.

We can also add and delete the rows and columns.

We can add, Rename, Rearrange, and deleting sheets.

2.1.5 Printing of spread sheet
Q10. Explain the steps to print a work sheet

Ans :
Print a Worksheet

To print a worksheet in Excel, execute the following steps.
1. On the File tab, click Print.

2. Topreview the other pages that will be printed, click ‘Next Page’ or ‘Previous Page’ at the bottom
of the window.

Print
’ —

Print

Copies: [ 1 = =]

Printer
HP Photosmart C309a series |

=

Printer Properties

Settings

[ I [[] Print Active Sheets
Only print the active sheets

Pages: | ] w | =
”—] T Print One Sided
Only print on one side of th...
i) Collated
1,23 123 123

s |
| [5) Portrait Orientation = |

[
B.27" % 11.69
@ Normal Margins
Left: 0.7° Right: 0.7"
I Br‘, Neo Scaling

100 Print sheets at their actual size

Page Setup

e B

8
:
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3. To print the worksheet, click the big Print button.

=
Pt [y

2.2 Basics oF PRESENTATION SOFTWARE I

2.2.1 Creating/Preparing Presentation and preparation of slides.

Q11. Explain the procedure of creating a new presentation and also explain how new slides
added ?

Ans :

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools are organized
logically into various ribbons in PowerPoint. The table below describes the various commands you can
access from the different menus.

Menu Categories Ribbon Commands

A E-EPile- It (@] (8
B J U 8 aXN- EE B -
Ak AN S EETR B
Font Paragraph |
= - — T
Click to add title
....... Clickto add sui;iﬁi; i
i
Click to add notes :
- +

§
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Menu Category Ribbon Commands

Home Clipboard functions, manipulating slides, fonts, paragraph settings, drawing
objects and editing functions.

Insert Insert tables, pictures, images, shapes, charts, special texts, multimedia and
symbols.

Design Slide setup, slide orientation, presentation themes and background.

Transitions Commands related to slide transitions.

Animations Commands related to animation within the individual slides.

Slide Show Commands related to slideshow set up and previews.

Review Proofing content, language selection, comments and comparing presentations.

View Commands related to presentation views, Master slides, color settings and
window arrangements.

Besides these depending on the objects selected in the slide, there are other menu tabs that get
enabled.

We will understand how to add new slides in an existing presentation. Here are the steps that allow
you to insert a new slide in the deck -

Step 1

Right-click in the Navigation Pane under any existing slide and click on the New Slide option.

Navigation Pane

b @
L
% »

Drawing Editing

Presentation3 - Microsoft PowerPoint

Home Insert Design Transitions Animations Slide Show Review

8- - |28
88 B 7 U S i
Side & | A-Aa- A X | Y
Font

~— - A
o= i

%

i g

5 =

Paragraph

4@ Copy
[ Paste Options:

B

' | ew Slide
plicyte Shide
elete Slide

dd Section

(1)

heck for Updates
ayout

eset Shde

'ormat Background...

ide Slide

o hiCamady) ||[BIR @ T a% 00—

Click to add title

Click to add subtitle

-
J

New Slide Option
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Step 2
The new slide is inserted. You can now change the layout of this slide to suit your design requirements.

New Slide Inserted

Click to add title

* Clicktoadd text

gl b

'] i .
bal B8 &3

Step 3

To change the slide layout, right-click on the newly inserted slide and go to the Layout option
where you can choose from the existing layout styles available to you.

Layout Menu Option

Slide Layout Styles
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You can follow the same steps to insert a new slide in between existing slides or at the end on the
slide list.

When we insert a new slide, it inherits the layout of its previous slide with one exception. If you are
inserting a new slide after the first slide (Title slide), the subsequent slide will have the Title and
Content layout.

You will also notice that if you right-click in the first step without selecting any slide the menu options
you get are different, although you can insert a new slide from this menu too.

Click to add title

~ Clickto add subtitle

Q12. Explain the steps to create an effective presentation using MS Powerpoint.
Ans :
Creating a PowerPoint Slide
Step 1
Open Microsoft PowerPoint.
Step 2

Go to File at the top of the screen and click New. A box that says “New Presentation” should appear
on the right side of your screen.

Step 3

In the “New Presentation” dialog box, click on “From Design Template.” You may then scan through
design templates and choose one that you like.

Step 4

Slide Design Select a design template by clicking on the template you like. You may choose a
different color for your template by clicking on “Color Schemes” in the “New Presentation” dialog box. 1

{100 }
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Step 5

Slide Layout Change the Slide Layout. You may change the slide layout (how information is presented
in the slide) by going to the top of the screen and clicking on “Format” — “Slide Layout.” A box will appear
on the right side of your screen (where “New Presentation” appeared) labeled “Slide Layout.” You may
select a design by clicking on it.

Step 6

Adding Text Enter your text by clicking and then typing in the box titled “Click to Add Text” or
“Click to Add Title.”

Step 7

Adding Pictures You may add pictures by clicking on the box that says “Click to add content.” Inside
that box, there will be a smaller box with six icons. Click on the icon that looks like a photograph of a
mountain. A new window will open, allowing you to browse for a picture on your computer or a CD.
Once you find your picture, click on it and then click “Insert.” 2
Step 8

Resizing Pictures You may change the size of your picture by clicking on the picture. The picture will
then have black lines around it with small bubbles or boxes in the corners. Place your mouse over the
bubbles or boxes and click. Holding the mouse pointer down, drag the picture to the size you want.

Step 9
You’re Done! Now you can do it again to make more.

Q13. Write about types of views in power point presentation?

AnS :

PowerPoint supports multiple views to allow users to gain the maximum from the features available
in the program. Each view supports a different set of functions and is designed accordingly.

PowerPoint views can be accessed from two locations.
Views can-be accessed quickly from the bottom bar just to the left of the zoom settings.

.
Wome  Inset  Deugn  Wamtons  Ammations  Side Show
il shoesoner 2 Sh0e Master 3 muter
B Mot & rendout Master [T Gdlnes
e st |- Zoom Fate
‘Window

B Reading View ] Notes Master [ Gades
Presentaton Views Master Views

Title Slide

Click to add subtitle

Quick Access to Presentation Views
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> Views can also be accessed from the Presentation Views section in the View ribbon

Presentation Views View Ribbon

Here is a short description of the various views and their features.
a. Normal View

This is the default view in PowerPoint and this is primarily used to create and edit slides. You can
create/ delete/ edit/ rearrange slides, add/ remove/ modify content and manipulate sections-from this

| Home | Inset Design  Tanstions  Animations  Sideshow  Reiew View & @

Ea Da- TE-E- &0 (@]
B 7 U S &l EEH 5"0~:m

‘ ’ sue-cB A-Aa | AN " E==E= N . .
Font 1

Sl

Click to add title

¢ Click to add text

=l b
| ﬁ" %

Normal View icon

{102 }
Rahul Publications —J




UNIT - 11 BASIC COMPUTER SKILLS

b. Slide Sorter View

This view is primarily used to sort slides and rearrange them. This view is also ideal to add or remove
sections as it presents the slides in a more compact manner making it easier to rearrange them.

vi32 » :_:_!E :g. lm 6 “

B 7 U 8 - IEiE EH- H

A A AN S EFEIR B
Font Is Paragrap

Drawing Editing

Slide Sorter View icon

C. Reading View

This view is new to PowerPoint 2010 and it was created mainly to review the slideshow without
losing access to rest of the Windows applications. Typically, when you run the slideshow, the presentation
takes up the entire screen so other applications cannot be accessed from the taskbar. In the reading view
the taskbar is still available while viewing the slideshow which is convenient. You cannot make any
modifications when on this view.

{103}
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3] Side Show - ~ Microsoft e ) |

Slide#2

¢ Sample Text 2
* Only text box content

W@[?d] /‘Nﬁt Sample Text

in a shape

PowerPoint
bottom bar visible

Windows Taskbar visible

d. SlidesShow

This is the traditional slideshow view available in all the earlier versions of PowerPoint. This view is
used to run the slideshow during presentation.

Slide#2

- Sample Text 2
- Only text box content

2.2.2 Slide show
Q14. What is the use of slide show in powerpoint? How it useful ?

AnS :

A slide show is a presentation of a series of still images on a projection screen or
electronic display device, typically in a prearranged sequence. The changes may be automatic and at
regular intervals or they may be manually controlled by a presenter or the viewer.

To start a slide show

> Click the Start From Beginning command on the Quick Access toolbar, or press the F5 key at
the top of your keyboard. The presentation will appear in full-screen mode.

@ H SO lﬁg
HOME | RT C
% |:I Layout ~
D ER “*] Reset
Paste
. Sllde - [ Section~

Clipboard Slides
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You can also click the Play Slide Show command at the bottom of the PowerPoint window to
begin a presentation from the current slide.

-
2

¥

L e ——=,

Click the Slide Show tab on the Ribbon to access even more options. From here, you can start
the presentation from the current slide and access advanced presentation options.

HOME INSERT DESIGN TRANSITIONS ANIMATIONS SLIDE SHOW REVIEW

Lﬁ@t} I’IJ ll@ Eg E@ A] F\d_) ./5 V] Play Narrations

[v] Use Timings

From From Present CustomSlide  SetUp Hide Rehearse Record Slide j
Beginning Current Slide Online~  Show~  SlideShow Slide Timings Show~ ' Show Media Controls
Start Slide Show Set Up

To advance and reverse slides

> You can advance to the next slide by clicking your mouse or pressing the spacebar on your
keyboard. Alternatively, you can use or arrow keys on your keyboard to move forward or
backward through the presentation.

You can also hover your mouse over the bottom-left and click the arrows to move forward or
backward.

To stop a slide show

> You can exit presentation mode by clicking the Esc key on your keyboard. Alternatively, you can
click the Slide Show Options button in the bottom-left and select End Show.

Last Viewed

Custom Show L4

Show Presenter View
Screen 4
Display Settings "

Arrow Options 4

Help

Pause
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The presentation will also end after the last slide. You can click the mouse or press the spacebar
to return to Normal view.

2.2.3 Taking Printout from Presentation

Q15. How can we take printouts from a presentation ?

AnS :

It is sometimes necessary that you share your slides with your audience in printed format before
you begin presenting them so they can take notes. There are other times when you want to give your
audience handouts with additional notes.

To print slides, you must go to the Backstage view under the File tab and click on
the Print menu.

File Tab Print Option
] Title Skde2.pptx - Microsoft PowerPoint T = e
Home Insert shgn Transitions Animations Slide Show Review View o
u - . Print -
Save As ‘
a @ Copies: 1 -
7 Open

Print

Printer

) Microsoft XPS Document ...

d Ready i

?ﬂmm_

Settings

B Print Al Sides v Text to il lustrate
& N Print entire presentation
Shides:
Help ] Full Page Shides .
. Print 1 slide per page
2] Options
s Collsted
= -
X — 0% 179
& :
£t Header & Footer

€7 ofld» 5% (=-0 O |

g
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The following table describes the various printing options available in PowerPoint.

Main Settings

Options

Description

Printing Slides

Print Layout

Collation

Printing Color

Print All Slides
Print Selection
Print Current Slide
Custom Range
Slides

Full Page Slides
Notes Page

Outline

Handouts

Collating Options

Color

Prints all the slides in the presentation.
Prints just the selected objects.

Prints just the selected slide.

Defines the slides you want printed.
This is same as the Custom Range.
One slide per page.

Slide and notes for every slide printed one below
another - one slide per page.

Print Slide outline.

Prints 1 or 2 or 3 or 4 or 6 or 9 slides per page -
aligned vertically or horizontally. When you print
handouts with 3 slides, you get the slide-and the
notes printed next to each other.

Prints slides in sequence or prints multiple copies of
each slide one after another.

Selects color, greyscale or black & white printing
options. Although you can select any color settings,
the.output will depend on the kind of printer you
use. A non-color printer cannot print color slides.

I 2.3 INTRODUCING TO INTERNET I

2.3.1 Basics of computer networks
Q16. What is Network?

AnS :

Computer Network

It is the interconnection of multiple devices, generally termed as Hosts connected using multiple

paths for the purpose of sending/receiving data or media.

There are also multiple devices or mediums which helps in the communication between two different

devices which are known as Network devices. Ex: Router, Switch, Hub, Bridge.

&

Router

=

Q.
|

Hub Bridge

S—l
= N

Wireless Switch Wireless
Router Bridge
{107}
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The layout pattern using which devices are
interconnected is called as network topology. Such
as Bus, Star, Mesh, Ring, Daisy chain.

> X

star Mesh };
=
D —— o Y
Point-to-Point g
n
O °
Tree

Ring

Q17. Explain the Types of Networks.
Ans :

The Network allows computers to connect
and communicate with different computers via
any medium. LAN, MAN and WAN are the three
major types of the network designed to operate over
the area they cover. There are some similarities and
dissimilarities between them. One of the major
differences is the geographical area they cover,
i.,e. LAN covers the smallest area; MAN. covers
an area larger than LAN and WAN comprises the
largest of all.

There are other types of Computer Networks
also, like :

> PAN (Personal Area Network)
> SAN (Storage Area Network)
> EPN (Enterprise Private Network)
» VPN (Virtual Private Network)
Local Area Network (LAN)

LAN or Local Area Network connects network
devices in such a way that personal computer and
workstations can share data, tools and programs.
The group of computers and devices are connected
together by a switch, or stack of switches, using a
private addressing scheme as defined by the TCP/
IP protocol. Private addresses are unique in relation
to other computers on the local network. Routers
are found at the boundary of a LAN, connecting
them to the larger WAN.

a)

Data transmits at a very fast rate as the
number of computers linked are limited. By
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definition, the connections must be high speed and
relatively inexpensive hardware (Such as hubs,
network adapters and Ethernet cables). LANs cover
smaller geographical area (Size is limited to a few
kilometers) and are privately owned. One can use
it for an office building, home, hospital, schools,
etc. LAN is easy to design and maintain. A
Communication medium used for LAN has twisted
pair cables and coaxial cables. It covers a short
distance, and so the error and noise are minimized.

Early LAN’s had data rates in the 4 to 16
Mbps range. Today, speeds are normally 100 or
1000 Mbps. Propagation delay is very short in a
LAN. The smallest LAN may only use two
computers, while larger LANs can accommodate
thousands of computers. A LAN typically relies
mostly on wired connections for-increased speed
and security, but wireless connections can also be
part of a LAN. The fault tolerance of a LAN is more
and there is less. congestion-in this network. For
example :-A bunch of students playing Counter
Strike in the same room (without internet).

b) ' Metropolitan Area Network (MAN)

MAN or Metropolitan area Network covers a
larger area than that of a LAN and smaller area as
compared to WAN. It connects two or more
computers that are apart but resides in the same or
different cities. It covers a large geographical area
and may serve as an ISP (Internet Service Provider).
MAN is designed for customers who need a high-
speed connectivity. Speeds of MAN ranges in terms
of Mbps. It’s hard to design and maintain a
Metropolitan Area Network.

The fault tolerance of a MAN is less and also
there is more congestion in the network. It is costly
and may or may not be owned by a single
organization. The data transfer rate and the
propagation delay of MAN is moderate. Devices
used for transmission of data through MAN are:
Modem and Wire/Cable. Examples of a MAN are
the part of the telephone company network that
can provide a high-speed DSL line to the customer
or the cable TV network in a city.

c) Wide Area Network (WAN)

WAN or Wide Area Network is a computer
network that extends over a large geographical area,
although it might be confined within the bounds of
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a state or country. A WAN could be a connection of
LAN connecting to other LAN’s via telephone lines
and radio waves and may be limited to an enterprise
(a corporation or an organization) or accessible to
the public. The technology is high speed and
relatively expensive.

There are two types of WAN: Switched WAN
and Point-to-Point WAN. WAN is difficult to design
and maintain. Similar to a MAN, the fault tolerance
of a WAN is less and there is more congestion in the
network. A Communication medium used for WAN
is PSTN or Satellite Link. Due to long distance
transmission, the noise and error tend to be more
in WAN.

WAN'’s data rate is slow about a 10th LAN’s
speed, since it involves increased distance and
increased number of servers and terminals etc.
Speeds of WAN ranges from few kilobits per second
(Kbps) to megabits per second (Mbps). Propagation
delay is one of the biggest problems faced here.
Devices used for transmission of data through WAN
are: Optic wires, Microwaves and Satellites. Example
of a Switched WAN is the asynchronous transfer
mode (ATM) network and Point-to-Point WAN is
dial-up line that connects a home computer to the
Internet.

2.3.2 Concept of Internet

Q18. Describe the overview of an Internet.

AnS :

Internet

Internet is defined as an Information super
Highway, to access information over the web.
However, It can be defined in many ways as follows:

> Internet is a world-wide global system of
interconnected computer networks.

> Internet uses the standard Internet Protocol
(TCP/IP).

> Every computer in internet is identified by a
unique IP address.

> IP Address is a unique set of numbers (such
as 110.22.33.114) which identifies a
computer location.

» A special computer DNS (Domain Name
Server) is used to give name to the IP Address
so that user can locate a computer by a
name.

> For example, a DNS server will resolve a
name http://www.tutorialspoint.com toa
particular IP address to uniquely identify the
computer on which this website is hosted.

> Internet is accessible to every user all over
the world.

Evolution

The concept of Internet was originated in
1969 and has undergone several technological &
Infrastructural changes as discussed below:

> The origin of Internet devised from the
concept of Advanced Research Project
Agency Network (ARPANET).

> ARPANET was developed by United States
Department of Defense.

> Basic purpose of ARPANET was to provide
communication among the various bodies of
government.

> Initially, there were only four nodes, formally
called Hosts.

> In 1972, the ARPANET spread over the
globe with 23 nodes located at different
countries and thus became known
as Internet.

> By the time, with invention of new technolo-
gies such as TCP/IP protocols, DNS, WWW,
browsers, scripting languages etc.,Internet
provided a medium to publish and access
information over the web.
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Advantages

Internet covers almost every aspect of life, one
can think of. Here, we will discuss some of the

advantages of Internet:

Internet }
‘- Advantages //

> Internet allows us to communicate with the
people sitting at remote locations. There are
various apps available on the wed that uses
Internet as a medium for communication.
One can find various social networking sites
such as:

Facebook
Twitter
Yahoo
Google+
Flickr

® Orkut

> One can surf for any kind of information over
the internet. Information regarding various
topics such as Technology, Health & Science,
Social Studies, Geographical Information,
Information Technology, Products etc can be
surfed with help of a search engine.

> Apart from communication and source of
information, internet also serves a medium

> Internet allows us to use many services like:
® Internet Banking
Matrimonial Services
® Online Shopping
® Online Ticket Booking
® Online Bill Payment
® Data Sharing
® E-malil
> Internet provides concept of electronic

commerce, that allows the business deals
to be conducted on electronic systems

Disadvantages

However, Internet has prooved to be a
powerful source of information in almostevery field,
yet there exists many disadvanatges discussed below:

A

There are always chances to loose personal
information such as name, address, credit
card number. Therefore, one should be very
careful while sharing such information. One
should use credit cards only through
authenticated sites.

Internet
Dlsadvantages

i

for entertainment. Following are the various | »  Another disadvantage is the Spamming.
modes for entertainment over internet. Spamming corresponds to the unwanted e-
»  Online Television mails in bulk. These e-mails serve no purpose
. and lead to obstruction of entire system.
®  Online Games y
e Songs > Virus can easily be spread to the computers
connected to internet. Such virus attacks may
®  Videos cause your system to crash or your important
®  Social Networking Apps data may get deleted.
(110 )
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»  Also a biggest threat on internet is porno-
graphy. There are many pornographic sites
that can be found, letting your children to
use internet which indirectly affects the
children healthy mental life.

> There are various websites that do not provide
the authenticated information. This leads to
misconception among many people.

Q19. What are the Features of Internet.
Ans :

Features of Internet

Let us now discuss the features of Internet.
The features are described below:

i. Accessibility

An Internet is a global service and accessible
to all. Today, people located in a remote part of an
island or interior of Africa can also use Internet.

il. Easy to Use

The software, which is used to access the
Internet (web browser), is designed very simple;
therefore, it can be easily learned and used. It:is
easy to develop.

iii. Interaction with Other Media

Internet service has a high degree of
interaction with other-media. For example, News
and other magazine, publishing houses have
extended their business with the help of Internet
services.

iv. Low Cost

The development and maintenance cost of
Internet service are comparatively low.

V. Extension of Existing IT Technology

This facilitates the sharing of IT technology
by multiple users in organizations and even facilitates
other trading partners to use.

vi. Flexibility of Communication

Communication through Internet is flexible
enough. It facilitates communication through text,
voice, and video too. These services can be availed
at both organizational and individual levels.

Security

Last but not the least, Internet facility has to a
certain extent helped the security system both at

the individual and national level with components
such as CCTV camera, etc.

2.3.3 Applications of Internet

Q20. List out the basic applications of
Internet.

AnS :

The internet is treated as one of the biggest
invention. It has a large number of applications.

1. Communication

2. Job searches

3. Finding books and study material

4. Health and medicine

5. Travel

6. Entertainment

7. Shopping

8. Stock market updates

9. Research

10. Business use of internet: different ways by
which intenet can be used for business are:

> Information about the product can be
provided can be provided online to the the
customer.

> Provide market information to the business

> It help business to recruit talented people

> Help in locating suppliers of the product .

> Fast information regarding customers view
about companies product

> Eliminate middle men and have a direct

contact with contact with customer .

> Providing information to the investor by
providing companies back ground and
financial information on web site.

2.3.4 Connecting to internet, ISPS
Q21. Explain about Internet connectivity.
(On)
Classify the different types of ISPS.
Ans :

Following are the essential elements required
to connect with the internet.
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»  Internet service providers,
»  Software and hardware requirements,
»  Configuring internet connection etc.
Internet Service Providers (ISP)
Internet Service Provider (ISP) is a company offering access to internet. They offer various services:
»  Internet Access
» Domain name registration
»  Dial-up access
»  Leased line access
ISP Types

ISPs can broadly be classified into six categories as shown in the following diagram:

Access providers
They provide access to internet through telephone lines, cable wi-fi or fiber optics.
Mailbox Provider

Such providers offer mailbox hosting services.
Hosting ISPs

Hosting ISPs offers e-mail, and other web hosting services such as virtual machines, clouds etc.
Virtual ISPs

Such ISPs offer internet access via other ISP services.
Free ISPs

Free ISPs do not charge for internet services.

Connection Types

There exist several ways to connect to the internet. Following are these connection types available:
1. Dial-up Connection

ISDN
DSL

g
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P oo o a

Cable TV Internet connections
Satellite Internet connections
Wireless Internet Connections
Dial-up Connection

Dial-up connection uses telephone line to connect PC to the internet. It requires a modem to setup

dial-up connection. This modem works as an interface between PC and the telephone line.

There is also a communication program that instructs the modem to make a call to specific number

provided by an ISP,

2.

Dial-up connection uses either of the following protocols:
Serial Line Internet Protocol (SLIP)
Point to Point Protocol (PPP)

The following diagram shows the accessing internet using modem:

Internet

] N

\
Digital A §
Signal D /,/
R
Modem

N = Digital
\\ r ,/,
N

Computer Computer

ISDN

ISDN is acronym of Integrated Services Digital Network. It establishes the connection using

the phone lines which carry digital signals instead of analog signals.

There are two techniques to deliver ISDN services:
1. Basic Rate Interface (BRI)

2. Primary Rate Interface (PRI)

Key points

>

>

The BRI ISDN consists of three distinct channels on a single ISDN line: tlo 64kbps B (Bearer)
channel and one 16kbps D (Delta or Data) channels.

The PRI ISDN consists of 23 B channels and one D channels with both have operating capacity of
64kbps individually making a total transmission rate of 1.54Mbps.
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3.

The following diagram shows accessing internet using ISDN connection:

\ Internet "o
$

20 D N
/ e
|[?igit al local telephone

Digital signal travels
over digital local
telephone line

ISON Adapter

ISDN Adapter

Computer Computer

DSL

DSL is acronym of Digital Subscriber Line. It is a form of broadband connection as it provides

connection over ordinary telephone lines.

Following are the several versions of DSL technigue available today:
Asymmetric DSL (ADSL)

Symmetric DSL (SDSL)

High bit-rate DSL (HDSL)

Rate adaptive DSL (RDSL)

Very high bit-rate DSL (VDSL)

6. ISDN DSL (IDSL)

I e

All'of the above mentioned technologies differ in their upload and download speed, bit transfer

rate and level of service.

The following diagram shows that how we can connect to internet using DSL technology:

\ Internet

NN~

]

Internet Access Using DSL Modem

DSL Modem

Router
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4. Cable TV Internet Connection

Cable TV Internet connection is provided through Cable TV lines. It uses coaxial cable which is
capable of transferring data at much higher speed than common telephone line.

Key Points
> A cable modem is used to access this service, provided by the cable operator.

> The Cable modem comprises of two connections: one for internet service and other for Cable TV
signals.

> Since Cable TV internet connections share a set amount of bandwidth with a group of customers,
therefore, data transfer rate also depends on number of customers using the internet at the same
time.

The following diagram shows that how internet is accessed using Cable TV connection:

/// \\\

;4 N
A "
e N
From|SP £ .Y
\4 A m Cable Modem
/D\!
g
> Internet $p|i(ler\\
- o

e L}
N ’

CableTV
Converter

5. Satellite Internet Connection

Satellite Internet connection offers high speed connection to the internet. There are two types of
satellite internet connection: one way connection or two way connection.

In one way connection, we can only download data but if we want to upload, we need a dialup
access through ISP over telephone line.

In two way connection, we can download and upload the data by the satellite. It does not require
any dialup connection.

The following diagram shows how internet is accessed using satellite internet connection:

Setellite

NM%W%

Satellite Dish

Network’s
operation
center

Modem

Computer Web Server
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6. Wireless Internet Connection

Wireless Internet Connection makes use of radio frequency bands to connect to the internet and
offers a very high speed. The wireless internet connection can be obtained by either WiFi or Bluetooth.

Key Points

» Wi Fi wireless technology is based on IEEE 802.11 standards which allow the electronic device to
connect to the internet.

> Bluetooth wireless technology makes use of short-wavelength radio waves and helps to create
personal area network (PAN).

2.3.5 Basics of internet connectivity related troubleshooting
Q22. Define troubleshooting? Explain along with Internet Connectivity

AnS :

Troubleshoot is the process of solving a problem or determining a problem to an issue.
Troubleshooting often involves the process of elimination, where a technician follows a set of steps to
determine the problem or resolve the problem.

If you can't view web pages or send and receive email, your Internet connection is probably to
blame. Sometimes it’s not your equipment’s fault that the Internet isn’t working. Service providers can
have their own problems that result in temporary outages, ranging from a few seconds to a few hours.

Here are some things to try when troubleshooting, in the approximate order to try them:
Restart your computer.

Power-cycle the ' modem (and router, if they are separate units). That means to turn the device off
or unplug it for 30 seconds, and then turn it back on again. Some modems take several minutes to
fully come back up after a power cycle; this is normal.

If you are using a wired connection, check to make sure the cables are plugged in snugly.

If you are using a wireless connection, check to make sure that your computer’s wireless networking
feature is turned on. On some notebooks, there’s a button somewhere near the keyboard that
toggles the wireless networking on/off.

If you accidentally press that button, your wireless turns off. If you look for the wireless icon in the

notification area and it has a red X on it, that’s a pretty good clue that the wireless networking is turned off
on the device.

23 PM

5/18/2014

> Right-click the networking icon in the notification area and choose Troubleshoot Problems. Then
follow the prompts to walk through a Windows Network Diagnostics utility, which will ask you
questions about your problem and try various fixes.
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What type of networking problems are you having?

Windows tested your Internet connection and verified that you are able to access some websites.
Are you locking for help with a different issue?

2 I'mtrying to reach a specific website or folder on a network

2 I'm having a different problem
Show me other network troubleshooting options.

| Cancel |

I 2.4 WorLp Wipe Wes (WWW)

Q23. Give an overview of WWW.

(or)
Draw and explain the LAQ architecture of WWW.

Ans :
Overview

WWW stands for World Wide Web. A technical definition of the World Wide Web is : all the
resources and users on the Internet that are using the Hypertext Transfer Protocol (HTTP).

A broader definition comes from the organization that Web inventor Tim Berners-Lee helped
found, the World Wide Web Consortium (W3C).

The World Wide Web is the universe of network-accessible information, an embodiment of human
knowledge.

In simple terms, The World Wide Web is a way of exchanging information between computers on
the Internet, tying them together into a vast collection of interactive multimedia resources.
Internet and Web is not the same thing: Web uses internet to pass over the information.

org

mtghouse

g
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Evolution

World Wide Web was created by Timothy Berners Lee in 1989at CERN in Geneva. World
Wide Web came into existence as a proposal by him, to allow researchers to work together effectively and
efficiently at CERN. Eventually it became World Wide Web.

The following diagram briefly defines evolution of World Wide Web:

Web 2.0

*Social Media
*Keyword search
*Rich user experience
*Tagging

WWW Architecture
WWW architecture is divided into several layers as shown in the following diagram:

Userinterface and applications

AydesgoydAid

Identifiers: URI Character Set: UNICODE
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Identifiers and Character Set

Uniform Resource Identifier (URI) s used
to uniquely identify resources on the web
and UNICODE makes it possible to built web
pages that can be read and write in human
languages.

Syntax
XML (Extensible Markup

Language) helps to define common syntax in
semantic web.

Data Interchange

Resource Description Framework
(RDF) framework helps in defining core
representation of data for web. RDF represents data
about resource in graph form.

Taxonomies

RDF Schema (RDFS) allows more
standardized description of taxonomies and other
ontological constructs.

Ontologies

Web Ontology Language (OWL) offers
more constructs over RDFS. It comes in-following
three versions:

> OWL Lite for taxonomies and simple
constraints.

> OWL DL for full description logic support.
> OWL for more syntactic freedom of RDF
Rules

RIF and SWRL offers rules beyond the
constructs that are available from RDFs and OWL.
Simple Protocol and RDF Query Language
(SPARQL) is SQL like language used for querying
RDF data and OWL Ontologies.

Proof

All semantic and rules that are executed at
layers below Proof and their result will be used to
prove deductions.

Cryptography

Cryptography means such as digital signature

for verification of the origin of sources is used.

User Interface and Applications

On the top of layer User interface and
Applications layer is built for user interaction.

WWW Operation

WWW works on client- server approach.
Following steps explains how the web works:

1. User enters the URL (say, http://www.
tutorialspoint.com) of the web page in the
address bar of web browser.

2. Then browser requests the Domain Name
Server for the IP address corresponding to
www.tutorialspoint.com.

3. After receiving IP address, browser sends the
request for web page to the web server using
HTTP protocol which specifies the way the
browser and web server communicates.

4.  Thenweb server receives requestusing HTTP
protocol and checks its search for the
requested web page. If found it returns it back
to the web browser and close the HTTP
connection.

5. Now the web browser receives the web page,
Itinterprets it and display the contents of web
page in web browser’s window.

Request for web page s
§ % N

{
internet
« C P “
AR e < Webpage
HTML file HTML file

Web browser
(Client)

Request for web page
>

Web Server

Future

There had been a rapid development in field
of web. It has its impact in almost every area such
as education, research, technology, commerce,
marketing etc. So the future of web is almost
unpredictable.

Apart from huge development in field of
WWW, there are also some technical issues that W3
consortium has to cope up with.

User Interface

Work on higher quality presentation of 3-D
information is under deveopment. The W3
Consortium is also looking forward to enhance the
web to full fill requirements of global communities
which would include all regional languages and
writing systems.
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Technology

Work on privacy and security is under way. This would include hiding information, accounting,
access control, integrity and risk management.

Architecture

There has been huge growth in field of web which may lead to overload the internet and degrade
its performance. Hence more better protocol are required to be developed.

Q24. What is web browsing ?
Ans :

One of the most common problems all Internet users face is the fact that it can be quite difficult to
find what you want on the Internet. There is no central “main menu” that users can access to navigate
through the Internet. Although there might not be an official menu, there are several resources available
- both on-line and off-line — that can make “surfing the net” easier. The Internet is a terrific resource. It
contains hundreds of web sites dedicated to thousands of topics. There are some web sites, which are
used to search information on the web. This searching on the web, moving from page to page, website to
website in search of information is known as web browsing. There is one main software/application which
is mainly used for the web browsing, called web browser . There are different types of web browser.

Search services on the Internet come in two main flavours:
‘search engine’ that index words or terms in Internet documents; and

2. ‘directories’ that classify Web documents or locations into an arbitrary subject classification scheme
or taxonomy.

Most search engines take one or more words entered by the user, search the contents of every Web
page stored in their databases and display the result. Search engines tend to “index™ (record by word) all
of the terms on a given Web document. Internet directories are on-line Web sites that place Web page into
one or more categories. Web pages are usually listed with a brief description and their URL.Directories
operate on a different principle. They require people to view the individual Web site and determine its
placementinto a subject classification scheme or taxonomy. Once done, certain keywords associated with
those sites can be used for searching the directory’s data banks to find Web sites of interest some popular
search engineers are:-

Google - http://www.google.com

>
> Infoseek http://guide.infoseek.com

»  AltaVista - http://www.altavista.digital.com
> Lycos - http://lwww.lycos.com

> Yahoo! - http://www.yahoo.com

2.4.1 Search Engine
Q25. Draw and explain the architecture of search engine.

AnS :

Search Engine refers to a huge database of internet resources such as web pages, newsgroups,
programs, images etc. It helps to locate information on World Wide Web.

User can search for any information by passing query in form of keywords or phrase. It then
searches for relevant information in its database and return to the user.
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Search Engine Components
Generally there are three basic components of a search engine as listed below:
1. Web Crawler
2. Database
3. Search Interfaces
Web crawler

It is also known as spider or bots. It is a software component that traverses the web to gather
information.

Database
All the information on the web is stored in database. It consists of huge web resources.
Search Interfaces

This component is an interface between user and the database. It helps the user to search through
the database.
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Search Engine Working

Web crawler, database and the search interface are the major component of a search engine that
actually makes search engine to work. Search engines make use of Boolean expression AND, OR, NOT to
restrict and widen the results of a search. Following are the steps that are performed by the search engine:

> The search engine looks for the keyword in the index for predefined database instead of going
directly to the web to search for the keyword.

> It then uses software to search for the information in the database. This software component is
known as web crawler.

> Once web crawler finds the pages, the search engine then shows the relevant web pages as a resullt.
These retrieved web pages generally include title of page, size of text portion, first several sentences
etc.

These search criteria may vary from one search engine to the other. The retrieved information is
ranked according to various factors such as frequency of keywords, relevancy of information, links etc.

> User can click on any of the search results to open it.
Architecture
The search engine architecture comprises of the three basic layers listed below:
»  Content collection and refinement.
»  Search core
»  User and application interfaces

Content collection & refinement Search Core User & Application Interfaces

aar

N

Content refinement

System

Web Services

/ ‘-l
End user

-

Search Application

Administrator
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Q27. List out some search engines.
Ans :

Following are the several search engines available today:

Search Engine Description

Google It was originally called BackRub. Itis the most popular search engine
globally.

Bing It was launched in 2009 by Microsoft. It is the latest web-based

search engine that also delivers Yahoo's results.

Ask It was launched in 1996 and was originally known as Ask Jeeves. It
includes support for match, dictionary, and conversation question.

AltaVista It was launched by Digital Equipment Corporation in 1995. Since
2003, it is powered by Yahoo technology.

AOL.Search It is powered by Google.

LYCOS It is top 5 internet portal and 13th largest online property according to
Media Matrix.

Alexa It is subsidiary of Amazon and used for providing website traffic
information.

2.4.2 Understanding URL
Q26. Discribe briefly about URL.
Ans :

Every document on the Web has a unique address. This address is known as Uniform Resource
Locator (URL).

Several HTML/XHTML tags include a URL attribute value, including hyperlinks, inline images, and
forms. All of them use the same syntax to specify the location of a web resource, regardless of the type or
content of that resource. That’s why it is known a Uniform Resource Locator.

URL Elements

A URL is made of up several parts, each of which offers information to the web browser to help find
the page. It is easier to learn the parts of a URL, if you look at the example URL given below, there are
three key parts: the scheme, the host address, and the file path. The following section will discuss each of
them:

http://www.osmania.com/index.htm
The Scheme

The scheme identifies the type of protocol and URL you are linking to and therefore, how the

resource should be retrieved. For example, most web browsers use Hypertext Transfer Protocol (HTTP)
to pass information to communicate with the web servers and this is the reason a URL starts with http://.
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There are other schemes available and you can use either of them based on your requirement:

Sr. No. Scheme & Description

1. http://Hypertext Transfer Protocol (HTTP) is used to request pages from Web servers
and send them back from Web servers to browsers.

2. https://Secure Hypertext Transfer Protocol (HTTPS) encrypts the data sent between
the browser and the Web server using a digital certificate.

3. ftp://File Transfer Protocol is another method for transferring files on the Web. While
HTTP is a lot more popular for viewing Web sites because of its integration with browsers,
FTP is still commonly used protocol to transfer large files across the Web and to upload
source files to your Web server.

4. file://Used to indicate that a file is on the local hard disk or a shared directory on a
LAN.

The Host Address

The host address is where a website can be found, either the IP address (four sets of numbers
between 0 and 255, for example 68.178.157.132 ) or more commonly the domain name for a site such
as www.tutorialspoint.com. Note that “www” is not actually part of the domain name although it is often
used in the host address.

The File Path

The filepath always begins with a forward slash character, and may consist of one or more directory
or folder names. Each directory name is separated by forward slash characters and the filepath may end
with a filename at the end. Here index.htm is the filename which is available in html directory:

https://www.osmania.com/html/index.htm
Q27. Explain the types of URL
Ans :

Uniform Resource Locator (URL) refers to a web address which uniquely identifies a document
over the internet.

This document can be a web page, image, audio, video or anything else present on the web.

For example, www.tutorialspoint.com/internet_technology/index.html is an URL to the
index.html which is stored on tutorialspoint web server under internet_technology directory.

URL Types
There are two forms of URL as listed below:
a) Absolute URL
b) Relative URL

a) Absolute URL

Absolute URL is a complete address of a resource on the web. This completed address comprises of
protocol used, server name, path name and file name.

For example http:// www.tutorialspoint.com / internet_technology /index.htm. where:
> http is the protocol.
> tutorialspoint.com is the server name.
> index.htm is the file name.
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The protocol part tells the web browser how to handle the file. Similarly we have some other
protocols also that can be used to create URL are:

» FIP

»  https

»  Gopher
» mailto
>  news

b) Relative URL

Relative URL is a partial address of a webpage. Unlike absolute URL, the protocol and server part
are omitted from relative URL.

Relative URLSs are used for internal links i.e. to create links to file that are part of same website as the
WebPages on which you are placing the link.

For example, to link an image on tutorialspoint.com/internet_technology/internet_referemce_models,
we can use the relative URL which can take the form like-/internet_technologies/internet-
osi_model.jpg.

Difference between Absolute and Relative URL

Absolute URL Relative URL
Used to link web pages on different websites Used to link web pages within the same website.
Difficult to manage- Easy to Manage
Changes when the server name or directory Remains same even of we change the server
name changes name or directory name.
Take time to access Comparatively faster to access.

2.4.3 Domain name

Q28. Explain Domain name System (DNS) Architecture
Ans :

Domain Name System Architecture

The domain name system comprises of Domain Names, Domain Name Space, Name
Server that have been described below:

Domain Names

Domain Name is a symbolic string associated with an IP address. There are several domain names
available; some of them are generic such as com, edu, gov, net etc, while some country level domain
names such as au, in, za, us etc.
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The following table shows the Generic Top-Level Domain names:

Domain Name Meaning
Com Commercial business
Edu Education
Gov U.S. government agency
Int International entity
Mil U.S. military
Net Networking organization
Org Non profit organization

Domain Name Space

The domain name space refers a hierarchy in the internet naming structure. This hierarchy has
multiple levels (from 0 to 127), with a root at the top. The following diagram shows the domain name
space hierarchy:

org

colorado
mtghouse

In the above diagram each subtree represents a domain. Each domain can be partitioned into sub
domains and these can be further partitioned and so on.

Name Server

Name server contains the DNS database. This database comprises of various names and their
corresponding IP addresses. Since it is not possible for a single server to maintain entire DNS database,
therefore, the information is distributed among many DNS servers.

»  Hierarchy of server is same as hierarchy of names.
»  The entire name space is divided into the zones
DNS Working

DNS translates the domain name into IP address automatically. Following steps will take you through
the steps included in domain resolution process:
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> When we type www. Osmania University.
com into the browser, it asks the local DNS
Server for its IP address.

Here the local DNS is at ISP end.

> When the local DNS does not find the IP
address of requested domain name, it
forwards the request to the root DNS server
and again enquires about IP address of it.

> The root DNS server replies with delegation
that I do not know the IP address of
www.tutorialspoint.com but know the IP
address of DNS Server.

> The local DNS server then asks the com DNS
Server the same question.

> The com DNS Server replies the same that
it does not know the IP address of
www.tutorialspont.com but knows the
address of tutorialspoint.com.

> Then the local DNS asks the tutorialspoint.com
DNS server the same question.

> Then tutorialspoint.com DNS server replies
with IP address of www.tutorialspoint.com.

> Now, the local DNS sends the IP address of
www.tutorialspoint.com to the computer that
sends the request.

2.4.4 IP_ Address
Q29. What is the use of IP Address
Ans :

IP Address

IP address is a unique logical address assigned
to a machine over the network. An IP address
exhibits the following properties:

> IP address is the unique address assigned to
each host present on Internet.

> IP address is 32 bits (4 bytes) long.

> IP address consists of two components:
network component and host compo-
nent.

> Each of the 4 bytes is represented by a
number from 0 to 255, separated with dots.
For example 137.170.4.124.

2.4.5 E- Governance

Q30. What is E- Governance? list the types of
E —-Governance.

AnS :

E-Governance is the implementation of ICT.
The ICT stands for Information and Communication
Technology in the government department.
Likewise, the central E-Governance is to make
government services efficient, accessible and
convenient. The use of E-governance is to overcome
the boundaries. That is of a traditional paper-based
system. It is the enhancement of current
government. And it also helps to provide better
government services to the citizen. Hence, E-
governance delivers SMART government.

E-Governance is of 4 types depending on the
specific types of services.

1. Government-to-Citizen(G2C)

The Government-to-citizen refers to the
government services that are accessed by the familiar
people. And Most of the government services fall
under G2C. Likewise, the primary goal of
Government-to-citizen is to provide facilities to the
citizen. It helps the ordinary people to reduce the
time and cost to conduct a transaction. A citizen
can have access to the services anytime from
anywhere.

Furthermore, Many services like license
renewals, and paying tax are essential in G2C.
Likewise, spending the administrative fee online is
also possible due to G2C. The facility of
Government-to-Citizen enables the ordinary citizen
to overcome time limitation. It also focuses on
geographic land barriers.

2.  Government-to-business (G2B)

The Government to business is the exchange
of services between Government and Business
organizations. It is efficient for both government and
business organizations. G2B provides access to
relevant forms needed to comply. The G2B also
consists of many services exchanged between
business sectors and government.

Similarly, the Government to business
provides Timely business information. And A
business organization can have easy and convenient
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online access to government agencies. G2B plays a
crucial role in business development. It enhances
the efficiency and quality of communication and
transparency of government projects.

3. Government-to-Government (G2G)

The Government-to-Government refers to
the interaction between different government
department, organizations, and agencies. This
increases the efficiency of government processes.
In G2G, government agencies can share the same
database using online communication. The
government departments can work together. This
service can increase international diplomacy and
relations.

In conclusion, G2G services can be at the
local level or the international level. It can
communicate with global government and local
government as well. Likewise, it provides safe and
secure inter-relationship between domestic or
foreign government. G2G constructs a universal
database for all member states to enhance service.

4.  Government-to-Employee (G2E)

The Government-to-Employee is the internal
part of G2G sector. Furthermore, G2E aims to bring
employees together and improvise knowledge
sharing.

Similarly, G2E provides online facilities to the
employees. Likewise, applying for leave, reviewing
salary payment record. And checking the balance
of holiday. The G2E sector provides human
resource training and development. So, G2E is also
the relationship between employees, government
institutions, and their management.

I 2.5 WEeB BrRowsING

2.5.1 Software
Q31. Define software.

AnS :

Software is a set of programs, which is
designed to perform a well-defined function. A
program is a sequence of instructions written to solve
a particular problem.
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There are two types of software:
»  System Software
»  Application Software

1. System Software

The system software is a collection of
programs designed to operate, control, and extend
the processing capabilities of the computer itself.
System software is generally prepared by the
computer manufacturers. These software products
comprise of programs written in low-level languages,
which interact with the hardware at a very basic
level. System software serves as the interface
between the hardware and the end users

2.  Application Software

Application software products are designed
to satisfy a particular need of a particular
environment. All software applications prepared in
the computer lab can come under the category of
Application software.

Application software may consist of a single
program, such as‘Microsoft’s notepad for writing
and editing a simple text. It may also consist of a
collection of programs, often called a software
package, which work together to accomplish a task,
such as a spreadsheet package.

2.5.2 Communications and collaborations,
Basics of E-maiil

Q32. What is communication ? how email
helps for communication.

(On)
Explain about Email.

AnS :

Communication refers to exchange of
information between persons through internet.
Internet provides a basis for communication and
collaboration which can be done using mail, chat,
skype, etc. When dealing with official matters,
electronic mail helps in the exchange of messages
text documents, web pages, audio, video, etc.

In this topic, we are going to discuss in detail
about basics of email, email addressing, configuring
email client, using emails, opening email client,
mailbox, creating and sending a new email, replying
to an email message, forwarding an email message,
sorting and searching emails, advance email
features, sending documents by email, activating
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spell check, using address book, sending softcopy as attachment, handling spam, instant messaging and
collaboration, using emoticons and some of the internet etiquettes.

Basics of E-mail

Electronic mail is an application that supports interchange of information between two or more
persons. Usually text messages are transmitted through email. Audio and video transfer through email
depends on the browser in use. This provides a faster way of communication in an affordable cost.

Advantages of E-mail

Functionalities like attachment of documents, data files, program files, etc., can be enabled. This is
a faster way of communication at an affordable cost.

Disadvantages of E-mail

If the connection to the ISP is lost, then you can’t access email. Once you send an mail to a recipient,
you have to wait until she/he reads and replies to your mail.

Email Addressing

Email address is a unique address given to the user that helps to identify the user while sending
and receiving messages or mails.

Username: Name that identifies any user’s mailbox
Domain name: Represents the Internet Service Provider (ISP).
@ Symbol: Helps to concatenate username and domain name.
For example:  user_name@domain_name
Username: user, Domain name .d gmail.com
Sr. No. Communication and Collaboration Concepts and Description
1. Configuring Email Client

Configuring email client is setting up a client which includes the various steps.
2. Using E-mails

The main purpose of using email is to exchange information between persons. The process
starts with opening of client email and ends with sending and verifying mail to recipients.

3. Mailbox: Inbox and Outbox

Inbox is an area where you can see all the received mails. Outbox is an area where the
outgoing messages or messages which are in process of sending or which are failed to
send are stored.

4, Advance Email Features:

Email provides many advanced features which includes sending attachments like
documents, videos, images, audio, etc.

5. Instant Messaging and Collaboration

Instant messaging is real time mutual communication between persons via internet. This is
a private chat. Once the recipient is online, you can start sending messages to him/her.

6. Internet etiquettes

Internet etiquettes are also called as “Netiquette”.Netiquettes are basic rules or techniques
which are accepted worldwide.
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2.5.3 Getting an email account, sending, Receiving, accessing email

Q33. Explain the process of creating an email.
(OR)
Explain the basic operations of email.

AnS :

a) Creating Email Account

There are various email service provider available such as Gmail, hotmail, ymail, rediff mail etc.

Here we will learn how to create an account using Gmail.

> Open gmail.com and click create an account.

> Now a form will appear. Fill your details here and click Next Step.

¢« 9> C ¥ @ accountsgoogle.com/Signlp

- Google

Create your Google Account
Name
Rahu! Kalotra

Choose your username
rahulkalotra20 @gmail com

e F
=gn m

> This step allows you to add your picture. If you don't want to upload now, you can do it later.

Click Next Step.

> Now a welcome window appears. Click Continue to Gmail.

{130 }
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> Wow!! You are done with creating your email account with Gmail. It’s that easy. Isn't it?
> Now you will see your Gmail account as shown in the following image:
@ mail.google.com/mail/
X A e @
Mors © 1-30f3 ) Q-
5 Socal KL ¥ Promotions K
Stay more organized wi 11:02 pm
The best of Gmail, whet 11:02 pm
Three tips to get the mo 11:02 pm
Key Points
> Gmail manages the mail into three categories namely Primary, Social and Promotions.
> Compose option is given at the right to compose an email message.
> Inbox, Starred, Sent mail, Drafts options are available on the left pane which allows you to
keep track of your emails.
b) Composing and Sending Email

Before sending an email, we need to compose a message. When we are composing an email

message, we specify the following things:

vV V V V V VY

Sender’s address in To field

Cc (if required)

Bcc (if required)

Subject of email message

Text

Signature

You should specify the correct email address; otherwise it will send an error back to the sender.

Once you have specified all the above parameters, It’s time to send the email. The mailer program

provides a Send button to send email, when you click Send, it is sent to the mail server and a message mail
sent successfully is shown at the above.
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c) Reading Email

Every email program offers you an interface
to access email messages. Like in Gmail, emails are
stored under different tabs such as primary, social,
and promotion. When you click one of tab, it displays
a list of emails under that tab.

In order to read an email, you just have to
click on that email. Once you click a particular email,
it gets opened.

The opened email may have some file
attached with it. The attachments are shown at the
bottom of the opened email with an option
called download attachment.

d) Replying Email

After reading an email, you may have to reply
that email. To reply an email, click Reply option
shown at the bottom of the opened email.

Once you click on Reply, it will automatically
copy the sender’s address in to the To field. Below
the To field, there is a text box where you can type
the message.

Once you are done with ‘entering-message,
click Send button. It’s that easy. Your email is sent.

e) Forwarding Email

It is also possible to send a copy of the
message that you have received along with your
own comments if you want. This can be done
using forward button available in mail client
software.

The difference between replying and
forwarding an email is that when you reply a
message to a person who has send the mail but
while forwarding you can send it to anyone.

When you receive a forwarded message, the
message is marked with a > character in front of
each line and Subject: field is prefixed with Fw.

f) Deleting Email

If you don’t want to keep email into your
inbox, you can delete it by simply selecting the
message from the message list and clicking delete
or pressing the appropriate command.
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Some mail clients offers the deleted mails to
be stored in a folder called deleted items or trash
from where you can recover a deleted email.

Q34. Explain the structure of Email Message?

AnS :

E-mail Message Components

E-mail message comprises of different
components: E-mail Header, Greeting, Text, and
Signature. These components are described in the
following diagram:

From : Alex Diaz aiex@tutorialspoint com Wed Jun 22 11:00 EDT 2013
E:mail Date : Wed, 22 Jun 2013 11:00:46 EDT 20130400 (EDT)

To shiller@tutgrial
hi r
ade Subject - bean dip
Cec

wong@tutorialspgint com

point cor

Greeting I Hi Guys.

Someone accidently finished off the black bean dip last night. Can one
of you pick up another case of it on your way home? | think Luke is on his bike
today so you might have to, Tak
Text
--Alex

Body

Alex T Diaz

332 Toast Lane

East Providence.
Rhode Island 05893

| office: (401)347 - 2345
| fax  (401)347-0013

Signature

E-mail Header

The first five lines of an E-mail message is called
E-mail header. The header part comprises of
following fields:

»  From
Date
To
Subject
CcC
BCC

VV V VY V

From

The From field indicates the sender’s address
i.e. who sent the e-mail.

Date

The Date field indicates the date when the
e-mail was sent.

To

The To field indicates the recipient’s address
i.e. to whom the e-mail is sent.
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Subject

The Subject field indicates the purpose of
e-mail. It should be precise and to the point.

CcC

CC stands for Carbon copy. It includes those
recipient addresses whom we want to keep
informed but not exactly the intended recipient.

BCC

BCC stands for Black Carbon Copy. Itis used
when we do not want one or more of the recipients
to know that someone else was copied on the
message.

Greeting

Greeting is the opening of the actual message.
Eg. Hi Sir or Hi Guys etc.

Text

It represents the actual content of the
message.

Signature

This is the final part of an e-mail message. It
includes Name of Sender, Address, and Contact
Number.

Q35. List and explain the advantages and
disadvantages of E-mail?

Ans :
Advantages

E-mail has prooved to be powerful and
reliable medium of commmunication. Here are the
benefits of E-mail:

> Reliable
Convenience
Speed
Inexpensive
Printable
Global
Generality
Reliable

Many of the mail systems notify the sender if
e-mail message was undeliverable.

YV V V V VYV V

Convenience

There is no requirement of stationary and
stamps. One does not have to go to post office. But
all these things are not required for sending or
receiving an mail.

Speed

E-mail is very fast. However, the speed also
depends upon the underlying network.

Inexpensive
The cost of sending e-mail is very low.
Printable

It is easy to obtain a hardcopy of an e-mail.
Also an electronic copy of an e-mail-can also be
saved for records.

Global

E-mail can be sent and received by a person
sitting across the globe.

Generality

It is also possible to send graphics, programs
and sounds with an e-mail.

Disadvantages

Apart from several benefits of E-mail, there
also exists some disadvantages as discussed below:

Forgery
Overload
Misdirection
Junk

No response

vV V V V V

Forgery

E-mail doesn’t prevent from forgery, that is,
someone impersonating the sender, since sender is
usually not authenticated in any way.

Overload

Convenience of E-mail may result in a flood
of mail.

Misdirection

It is possible that you may send e-mail to an
unintended recipient.
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Junk

Junk emails are undesirable and inappro-priate emails. Junk emails are sometimes referred to as
spam.

No Response

It may be frustrating when the recipient does not read the e-mail and respond on a regular basis.

2.5.4 Document Collaboration

Q36. How can we attach files with email ?
Ans :

Now a day, the mail client comes with enhanced features such as attachment, address book, and
MIME support. Here in this chapter we will discuss all of these features which will give you a better
understanding of added feature of a mail client program.

Attachment

Ability to attach file(s) along with the message is one of the most useful features of email. The
attachment may be a word document, PowerPoint presentation, audio/video files, or images.

> In order to attach file(s) to an email, click the attach button. As a result, a dialog box appears asking
for specifying the name and location of the file you want to attach.

> Once you have selected the appropriate file, it is attached to the mail.

A\

Usually a paper clip icon appears in the email which indicates that it has an attachment.

»  When adding an attachment it is-better to compress the attached files so as to reduce the file size
and save transmission time as sending and downloading large files consumes a lot of space and
time.

Address Book

Address book feature of a mail program allows the users to store information about the people
whom they communicate regularly by sending emails. Here are some of the key features of an Address
book:

> Address book includes the nick names, email addresses, phone number etc. of the people.

> Using address book allows us not to memorize email of address of a person, you just have to select
recipient name from the list.

> When you select a particular name from the list, the corresponding email address link automatically
get inserted in to the To: field.

> Address book also allows creating a group so that you can send a email to very member of the
group at once instead of giving each person email address one by one.

MIME Types

MIME is acronym of Multipurpose Inter-net Mail Extensions. MIME compliant mailer allows
us to send files other than simple text i.e. It allows us to send audio, video, images, document, and pdf files
as an attachment to an email.

Suppose if you want to send a word processor document that has a group of tabular columns with
complex formatting. If we transfer the file as text, all the formatting may be lost. MIME compliant mailer
takes care of messy details and the message arrives as desired.

'134 |
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The following table describes commonly used MIME Types:

1. Type Subtype Description File
extension(s)

2. | Application postscript Printable postscript document .eps, .ps
tex TEX document .tex
troff Printable troff document ., .tr, roff

3. | Audio aiff Apple sound .aif, .aiff,.aifc
au Sun Microsystems sound .au, .snd
midi Musical Instrument Digital Interface | .midi, .mid
real audio Progressive Network sound .ra, .ram

4. image gif Graphics Interchange Format .gif
ipeg Joint Photographic Experts Group | .jped, .jpgd, .jpe
png Portable Network Graphics .png
triff Tagged Image Modeling Language | .tiff, .tif

5. Model vrml Virual reality Modelling Language wrl

6. |Text html Hyper Text Markup Language .html, .htm

plain Unformatted text xt
sgml Standard Generalized Markup .sgml
language

7. | Video avi Microsoft Audio Video Interleaved | .avi
mpeg Moving Pictures Expert Group .mpeg, .mpg
quicktime Apple QuickTime movie .qgt, .mov
sgi-movie silicon graphic movie .movie

2.5.5 Instant messaging
Q37. Write the steps to do instant messaging via email.

AnS :

Your Gmail screen displays information for your contacts at the bottom of the left pane. Here’s how

to send instant messages from Gmail using this contact list.

1.
2.

Log onto your Gmail account and open Hangouts.

In the contact list, hover over the name of the person you want to message. A box appears, with
four icons: Send email, Schedule event, Send message, and Start video call.

Select Send message.

A chat box with the person’s name at the top appears. If you’ve chatted with them before you’ll see
your previous conversations.

In the Send a message text box, enter a message.

When the other person types a message in return, you’ll see an ellipsis icon next to their name.
When they send a return message, you’ll see it in the chat box.

Message back and forth as you would with any other messaging application.

When you’re done, in the upper-right corner of the chat box, select X.
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2.5.6 E-mail Etiquettes

Q38. What are the rules to be followed while using E-mail?

AnS :

The term etiquette refers to conventional rules of personal behavior. But while communicating

via email, we cannot know about the body language and tone of voice etc. Therefore a set of guidelines
for acceptable behavior on email that have been evolved is known as Email Netiquette.

vV V. V V V VYV V

A\

Here are set of guidelines that should be followed while working with email:

Try to make your message as short as possible. It will make your message easy to read and understood.
Be careful about spelling and grammar while typing a message.

Use emoticons, smiles when required.

Email address entered must be correct.

The subject heading of a message should be clear and descriptive.

Follow the same rules as if you are writing a letter or a memo.

Sending a message that has already been forwarded or replied many times may contain many
angled brackets. It is better to remove the angled brackets from the message.

While sending mails to multiple persons, specify their email addresses in the BCC: field so that the
spammers cannot come to know about addresses of other recipients to whom you have sent a

copy.
Keep size of attachment as small as-possible.
Always add your signature at the end of email.

Before you send, make it sure everything is fine because you cannot call back a sent mail.
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‘ Short Question and Answers I

1.  What are the features of spreadsheets?

AnS :

There are a number of features that are
available in Excel to make your task easier. Some
of the main features are:

1. AutoSum: Helps you to add the contents of
a cluster of adjacent cells.

2. List AutoFill: Automatically extends cell
formatting when a new item is added to the
end of a list.

3.  AutoFill: Allows you to quickly fill cells with
repetitive or sequential data such as
chronological dates or numbers, and
repeated text. AutoFill can also be used to
copy functions. You can also alter text and
numbers with this feature.

4.  AutoShapes: Toolbar will allow you to draw
a number of geometrical shapes, arrows,
flowchart elements, stars and more. With
these shapes you can draw your own graphs.

5.  Wizard: Guides you to work effectively while
you work by displaying various helpful tips
and techniques based on what you are doing.

6. Dragand Drop: It will help you to reposition
the data and text by simply dragging the data
with the help of mouse.

7. Charts: It will help you in presenting a
graphical representation of your data in the
form of Pie, Bar, Line charts and more..

8. PivotTable: It flips and sums data in seconds
and allows you to perform data analysis and
generating reports like periodic financial
statements, statistical reports, etc. You can also
analyse complex data relationships
graphically.

9.  Shortcut Menus: The commands that are
appropriate to the task that you are doing
will appear by clicking the right mouse button.

2. Discuss the operations with Rows,
Columns in excel sheet.

AnS :

Following are the operations with Rows and

Columns

> Cut /copy / paste rows or columns: Use
this if you would like to duplicate rows or
columns, or if you would like to rearrange
their order.

> Insert new rows or columns: This will
insert new rows above - or new-columns to
the left of - the row or column you have
selected.

> Delete rows-or columns: This will delete
the rows-or columns in question entirely and
collapse the remainder of the sheet in to take
the place of the removed row or column.

> Format rows or columns: Use this option
to apply formatting to each cell within a row
or column. Potential formatting options
include text colors, background colors, and
borders.

> Hide and unhide rows or columns: Use
this option to temporarily hide or unhide rows
or columns. This makes it easier to manage
large spreadsheets by hiding non-critical data.

3. Define cell reference.
Ans :

Most formulas you create include references
to cells or ranges. These references enable your
formulas to work dynamically with the data
contained in those cells or ranges. For example, if
your formula refers to cell C2 and you change the
value contained in C2, the formula result reflects
new value automatically. If you didn’t use references
in your formulas, you would need to edit the
formulas themselves in order to change the values
used in the formulas.

When you use a cell (or range) reference in a
formula, you can use three types of references -
relative, absolute, and mixed references.
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4. List out various text functions in excel.

AnS :

Text Functions

LOWER: Converts all characters in a supplied text string to lower case
UPPER: Converts all characters in a supplied text string to upper case

TRIM: Removes duplicate spaces, and spaces at the start and end of a text string

CONCATENATE: Joins together two or more text strings.

LEFT: Returns a specified number of characters from the start of a supplied text string.

MID: Returns a specified number of characters from the middle of a supplied text string
RIGHT: Returns a specified number of characters from the end of a supplied text string.
LEN: Returns the length of a supplied text string

FIND: Returns the position of a supplied character or text string from within a supplied text string
(case-sensitive).

5. Explain the steps to print a work sheet

AnS :

Print a Worksheet

To print a worksheet in Excel, execute the following steps.

1. On the File tab, click Print.

2. Topreview the other pages that will be printed, click ‘Next Page’ or ‘Previous Page’ at the bottom of
the window.

Print
’ =

Print

Printer

HP Photosmart C309a series -
=& reaay

Printer Properties
Settings
‘ l LI I] Print Active Sheets - I

Only print the active sheets

Pages: [ = ] to | =
[m Print One Sided

Only print on one side of th..
[ ]| Collated

1.2.3  1.2.3 123

|
-]
d
| [B] portrait Orientation = I
- |
|
- |

I ] A
827" x 11.69"
@ Normal Margins
Lefu: O.7% Righu 0.7¢
H[ ™ No Scaling

1w Print sheets at their actual size

Page Setup

3. To print the worksheet, click the big Print button.

1=
Print %
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6. Explain the steps to create an effective
presentation using MS Powerpoint.

AnS :

Creating a PowerPoint Slide
Step 1

Open Microsoft PowerPoint.
Step 2

Go to File at the top of the screen and click
New. A box that says “New Presentation” should
appear on the right side of your screen.

Step 3

In the “New Presentation” dialog box, click
on “From Design Template.” You may then scan
through design templates and choose one that you
like.

Step 4

Slide Design Select a design template by
clicking on the template you like. You may choose
a different color for your template by clicking on
“Color Schemes” in the “New Presentation” dialog
box. 1

Step 5

Slide Layout Change the Slide Layout. You
may change the slide layout (how information is
presented in the slide) by going to the top of the
screen and clicking on “Format” — “Slide Layout.”
A box will appear on the right side of your screen
(where “New Presentation” appeared) labeled “Slide
Layout.” You may select a design by clicking on it.

Step 6

Adding Text Enter your text by clicking and
then typing in the box titled “Click to Add Text” or
“Click to Add Title.”

Step 7

Adding Pictures You may add pictures by
clicking on the box that says “Click to add content.”
Inside that box, there will be a smaller box with six
icons. Click on the icon that looks like a photograph
of a mountain. A new window will open, allowing
you to browse for a picture on your computer or a
CD. Once you find your picture, click on it and then
click “Insert.” 2

Step 8

Resizing Pictures You may change the size of
your picture by clicking on the picture. The picture
will then have black lines around it with small
bubbles or boxes in the corners. Place your mouse
over the bubbles or boxes and click. Holding the
mouse pointer down, drag the picture to the size
you want.

Step 9
You’re Done! Now you can do it again to
make more.
7.  What is Network?
Ans :

Computer Network

It is the interconnection of multiple devices,
generally termed as Hosts connected using multiple
paths for the purpose of sending/receiving data or
media.

There are also multiple devices or mediums
which helps-in the communication between two
| different devices which are known as Network
devices. Ex: Router, Switch, Hub, Bridge.

i:-:d’ | i'

Router Hub Bridge
o ]
S = B
Wireless Switch Wireless
Router Bridge

The layout pattern using which devices are
interconnected is called as network topology. Such
as Bus, Star, Mesh, Ring, Daisy chain.

> X

B
star Mesh =
-~
~———— o o P
Point-to-Point 5
Q °
Tree

Ring
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8. What are the Features of Internet.
Ans :

Features of Internet

Let us now discuss the features of Internet.
The features are described below:

i. Accessibility

An Internet is a global service and accessible
to all. Today, people located in a remote part of an
island or interior of Africa can also use Internet.

il. Easy to Use

The software, which is used to access the
Internet (web browser), is designed very simple;
therefore, it can be easily learned and used. It is
easy to develop.

iii. Interaction with Other Media

Internet service has a high degree of
interaction with other media. For example, News
and other magazine, publishing houses have
extended their business with the help of Internet
services.

iv. Low Cost

The development and maintenance cost of
Internet service are comparatively low.

V. Extension of Existing IT Technology

This facilitates the sharing of IT technology
by multiple users in organizations and even facilitates
other trading partners to use.

vi. Flexibility of Communication

Communication through Internet is flexible
enough. It facilitates communication through text,
voice, and video too. These services can be availed
at both organizational and individual levels.

Security

Last but not the least, Internet facility has to a
certain extent helped the security system both at
the individual and national level with components
such as CCTV camera, etc.

9. List out the basic applications of
Internet.

AnS :

The internet is treated as one of the biggest
invention. It has a large number of applications.
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1. Communication

2. Jobsearches

3. Finding books and study material

4. Health and medicine

5. Travel

6. Entertainment

7. Shopping

8. Stock market updates

9. Research

10. Business use of internet: different ways by
which intenet can be used for business are:

> Information about the product can be
provided can be provided online to the the
customer.

> Provide market information to the business

> It help business to recruit talented people

> Help in locating suppliers of the product .

> Fast information regarding customers view
about companies product

> Eliminate middle men and have a direct

contact with contact with customer .

> Providing information to the investor by
providing companies back ground and
financial information on web site.

10. Discuss WWW?

AnS :

WWW stands for World Wide Web. A
technical definition of the World Wide Web is : all
the resources and users on the Internet that are using
the Hypertext Transfer Protocol (HTTP).

A broader definition comes from the
organization that Web inventor Tim Berners-
Lee helped found, the World Wide Web
Consortium (W3C).

The World Wide Web is the universe of
network-accessible information, an embodiment of
human knowledge.

In simple terms, The World Wide Web is a
way of exchanging information between computers
on the Internet, tying them together into a vast
collection of interactive multimedia resources.
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Internet and Web is not the same thing: Web uses internet to pass over the information.

org

colorado
mtghouse

11. What is web browsing ?
Ans :

One of the most common problems all Internet users face is the fact that it can be quite difficult to
find what you want on the Internet. There is no central “main menu” that users can access to navigate
through the Internet. Although there might not be an official menu, there are several resources available
- both on-line and off-line — that can make “surfing the net” easier. The Internet is a terrific resource. It
contains hundreds of web sites dedicated to thousands of topics. There are some web sites, which are
used to search information on the web. This searching on the web, moving from page to page, website to
website in search of information is known as web browsing. There is one main software/application which
is mainly used for the web browsing, called web browser . There are different types of web browser.

Search services on the Internet come in two main flavours:

1. ‘search engine’ that index words or terms in Internet documents; and

2. ‘directories’ that classify Web documents or locations into an arbitrary subject classification scheme
or taxonomy.

12. Define URL.
AnS :

Every document on the Web has a unique address. This address is known as Uniform Resource
Locator (URL).

Several HTML/XHTML tags include a URL attribute value, including hyperlinks, inline images, and
forms. All of them use the same syntax to specify the location of a web resource, regardless of the type or
content of that resource. That’s why it is known a Uniform Resource Locator.

13. Difference between Absolute and Relative URL.

Ans :
Absolute URL Relative URL
Used to link web pages on different websites Used to link web pages within the same website.
Difficult to manage. Easy to Manage
Changes when the server name or directory Remains same even of we change the server
name changes name or directory name.
Take time to access Comparatively faster to access.
(141)
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14. IP Address.
Ans :

IP address is a unique logical address assigned
to a machine over the network. An IP address
exhibits the following properties:

> IP address is the unique address assigned to
each host present on Internet.

> IP address is 32 bits (4 bytes) long.

> IP address consists of two components:
network component and host compo-
nent.

> Each of the 4 bytes is represented by a
number from 0 to 255, separated with dots.
For example 137.170.4.124.

15. Define software.
Ans :

Software is a set of programs, which is
designed to perform a well-defined function. A
program is a sequence of instructions written to solve
a particular problem.

There are two types of software:
»  System Software
»  Application Software
16. Explain about Email.

AnS :

Communication refers to exchange of
information between persons through internet.
Internet provides a basis for communication and
collaboration which can be done using mail, chat,
skype, etc. When dealing with official matters,
electronic mail helps in the exchange of messages
text documents, web pages, audio, video, etc.

In this topic, we are going to discuss in detail
about basics of email, email addressing, configuring
email client, using emails, opening email client,
mailbox, creating and sending a new email, replying
to an email message, forwarding an email message,
sorting and searching emails, advance email
features, sending documents by email, activating
spell check, using address book, sending softcopy
as attachment, handling spam, instant messaging
and collaboration, using emoticons and some of the
internet etiquettes.
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Basics of E-mail

Electronic mail is an application that supports
interchange of information between two or more
persons. Usually text messages are transmitted
through email. Audio and video transfer through
email depends on the browser in use. This provides
a faster way of communication in an affordable cost.

Advantages of E-mail

Functionalities like attachment of documents,
data files, program files, etc., can be enabled. This
is a faster way of communication at an affordable
cost.

Disadvantages of E-mail

If the connection to the ISP is lost, then you
can’t access email. Once you send an-mail to a
recipient, you have to wait until she/he reads and
replies to your mail.

17. List and explain the advantages and
disadvantages of E-mail?

Ans :
Advantages

E-mail has prooved to be powerful and
reliable medium of commmunication. Here are the
benefits of E-mail:

Reliable
Convenience
Speed
Inexpensive
Printable
Global

VvV V. V VYV V VY V

Generality
Reliable

Many of the mail systems notify the sender if
e-mail message was undeliverable.

Convenience

There is no requirement of stationary and
stamps. One does not have to go to post office. But
all these things are not required for sending or
receiving an mail.
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Speed

E-mail is very fast. However, the speed also
depends upon the underlying network.

Inexpensive
The cost of sending e-mail is very low.
Printable

It is easy to obtain a hardcopy of an e-mail.
Also an electronic copy of an e-mail can also be
saved for records.

Global

E-mail can be sent and received by a person
sitting across the globe.

Generality

It is also possible to send graphics, programs
and sounds with an e-mail.

Disadvantages

Apart from several benefits of E-mail, there
also exists some disadvantages as discussed below:

Forgery
Overload
Misdirection
Junk

YV V V V V

No response
Forgery

E-mail doesn’t prevent from forgery, that is,
someone impersonating the sender, since sender is
usually not authenticated in any way.

Overload

Convenience of E-mail may result in a flood
of mail.

Misdirection

It is possible that you may send e-mail to an
unintended recipient.

Junk

Junk emails are undesirable and inappro-
priate emails. Junk emails are sometimes referred
to as spam.

No Response

It may be frustrating when the recipient does
not read the e-mail and respond on a regular basis.

18. Write the steps to do instant messaging
via email.

AnS :

Your Gmail screen displays information for
your contacts at the bottom of the left pane. Here’s
how to send instant messages from Gmail using this
contact list.

1. Log onto your Gmail account and open
Hangouts.

2. In the contact list, hover over the name of
the person you want to message. A box
appears, with / four icons: Send
email, Schedule event, Send message,
and_Start video call.

Select Send message.

4. ' Achat box with the person’s name at the top
appears. If you’ve chatted with them before
you’ll see your previous conversations.

5. In the Send a message text box, enter a
message.

6.  When the other person types a message in
return, you’ll see an ellipsis icon next to
their name. When they send a return
message, you’ll see it in the chat box.

7. Message back and forth as you would with
any other messaging application.

8.  When you’re done, in the upper-right corner
of the chat box, select X.

19. What are the rules to be followed while
using E-mail?

AnS :

The term etiquette refers to conventional
rules of personal behavior. But while
communicating via email, we cannot know about
the body language and tone of voice etc. Therefore
a set of guidelines for acceptable behavior on email
that have been evolved is known as Email
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Netiquette.
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Here are set of guidelines that should be followed while working with email:

Try to make your message as short as possible. It will make your message easy to read and understood.
Be careful about spelling and grammar while typing a message.

Use emoticons, smiles when required.

Email address entered must be correct.

The subject heading of a message should be clear and descriptive.

Follow the same rules as if you are writing a letter or a memo.

Sending a message that has already been forwarded or replied many times may contain many
angled brackets. It is better to remove the angled brackets from the message.

While sending mails to multiple persons, specify their email addresses in the BCC: field so that the
spammers cannot come to know about addresses of other recipients to/whom you have sent a

copy.
Keep size of attachment as small as possible.
Always add your signature at the end of email.

Before you send, make it sure everything is fine because you cannot call back a sent mail.
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‘ Choose the Currect Answers I

1. To join the internet, the computer has to be connected to a [c]
(&) Internet architecture board (b) Internet society
(c) Internet service provider (d) None of the mentioned

2. Whatis a web browser? [d]
() A program that can display a web page
(b) A program used to view html documents
(c) It enables user to access the resources of internet
(d) All of the mentioned

3. Which of these is the easiest way of communication? [a]
(@) E-mail (b) Telephone
(c) Fax (d) Letter

4, Search engines are used to [d]
() Search video (b) Search documents
(c) Download softwares (d) All-of these

5. Search engines maintain heavy database of [d]
() Keywords (b) URLs
(c) Web pages (d) All of these

6.  Anunauthorized access to computer systems of another person is called [a]
(a)Hacking (b) Burglary
(c) ~Fraud (d) Arson

7. How to Open a presentation in PowerPoint? [b]
(@) Ctrl+K (b) Ctrl +0O
(c) Ctrl+ A (d) None of these

8. How to create a new presentation in PowerPoint? [a]
(@) Ctrl+N (b) Ctrl + M
(c) Ctrl+S (d) None of these

9.  What type of chart is useful for comparing values over categories ? [b]
(a) Pie Chart (b) Column Chart
(d) Line Chart (d) Dot Graph

10.  Which functionin Excel tells how many numeric entries are there ? [b]
(@) NuUM (d) COUNT
(c) SUM (d) CHKNUM
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‘ Fill in the blanks I

1.  The intersection of rows and columns are called
2. All formulas in ms excel startwith _________ symblol.
3. In Power point short cut key is insert new slide is
4. is a program that helps to create slide presentations quickly
5. Ctrl+S is the shortcut key for
6. The_________ features helps you to avoid making typing mistakes and speed up your typing.
7. ISP denotes
8. A network of networks is known as
9.  The site which stores web pages is called
10. A__________isacomputer that performs actions for another computer.
ANSWERS
1. Cell
2. =
3. Ctrl+M
4. Power Point
5. Save
6. Spelling and grammar
7. Internet service provider
8. Internet
9. Websites
10. Server

g
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Sales Management / Foreign Trade / Tax Procedure & Honours Courses)

Model Paper - |
BASIC COMPUTER SKILLS

Time: 11/, Hours Max. Marks : 40

PART - A (2 x5 =10 Marks)
[Short Answer Type]
Note: Answer any two of the following questions.

ANSWERS
1 What is data? How is differ from information. (Unit -1, SQA. 11)
2. What is user interface? (Unit- 1, SQA. 14)
3. List and explain Advantages & Disadvantages of E-mail (Unit- 11, SQA. 17)
4. Explain the steps to print a worksheet (Unit-11, SQA. 5)
PART - B (2 x 15 = 30 Marks)
[Essay Answer Type]
Note: Answer all the questions in not exceeding 4 pages each.

5. () Explain the features of workd processing (Unit-1,Q.No. 42)

(OR)
(b) Define memory and explain the types of memory. (Unit-1,Q.No. 12)

6. (a) Explain the procedure of creating a new presentation and also

explain how new slides added (Unit - 11, Q.No. 11)

(OR)
(b) Give anoverview of __ draw and explain the architecture (Unit - 11, Q.No. 23)
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B.Com. | Year Il Semester Examination
(Common for General / Computer Applications / Advertising &
Sales Management / Foreign Trade / Tax Procedure & Honours Courses)

Model Paper - I
BASIC COMPUTER SKILLS

Time: 11/, Hours Max. Marks : 40

PART - A (2 x5 =10 Marks)
[Short Answer Type]
Note: Answer any two of the following questions.

ANSWERS
1 Define computer? (Unit -1, SQA.1)
2 Discuss about RAM? (Unit-1, SQA. 8)
3. What is Network? (Unit-1I, SQA. 7)
4 List out various applications of Internet (Unit- 11, SQA. 9)
PART - B (2 x 15 = 30 Marks)
[Essay Answer Type]
Note: Answer all the questions in not exceeding 4 pages each.
5. (a) Define operating system and discuss about types of
operating system (Unit-1,Q.No.21, 24)
(OR)
(b) List and explain various types of input and output devices of a
computer system. (Unit-1, Q.No.6,11)
6. (a) How e-mail helps for communication? Explain basic operations
of E-mail. (Unit -1, Q.No.32, 33)
(OR)
(b) How can we create, Rename, dlete and more a worksheet (Unit-11,Q.No.4)
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BASIC COMPUTER SKILLS
Paper Code - AECC -1

Time: 2 Hours] [Max. Marks : 40

PART - A (2 x5 =10 Marks)
[Short Answer Type]
Note: Answer any two of the following questions.

1. Application of IECT (Unit - 1, SQA. 12)
2. LAN and WAN (Unit - 1,Q.No0.17)
3. e-Malil (Unit - 1I, SQA. 16)
4, Desktop (Unit - 1, SQA. 15)
PART - B (2 x 15 = 30 Marks)
[Essay Answer Type]
Note: Answer all the questions in not exceeding 4 pages each.
5. () Explain about the components of a computer and its application. (Unit - 1,Q.No. 2,3)
(OR)
(b) Write about word processing features. (Unit - 1, Q.No. 42)
6. (&) Write about types of views in Power Point presentation. (Unit - 1II, Q.No. 13)
(OR)
(b) What is web browsing? Write about World Wide Web. (Unit - 1, Q.No. 23,24)
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